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IBM System Storage Productivity Center
documentation

Welcome to the IBM System Storage Productivity Center information center. This information center contains
information that you need to install, configure, maintain, and use the IBM System Storage Productivity Center.

In this information...

What's new

IBM System Storage Productivity Center 1.4

What is the IBM System Storage Productivity Center?

Printable PDFs

Getting started

ibm.com and related resources

Support and assistance

Support for System Storage Productivity Center 
Support for Tivoli Storage Productivity Center 
Support for Tivoli Storage Productivity Center for Replication 
Support for System Storage DS8100 
Support for System Storage DS8300 
Support for System Storage DS3200 
Support for System Storage DS3300 
Support for System Storage DS3400 
Support for System Storage DS4000 
Support for System Storage DS5000 
Support for System Storage SAN Volume Controller 
Support for DS CIM Agent 

Other information centers

IBM Tivoli Storage Productivity Center Information Center
IBM System Storage DS8000 Information Center
IBM System Storage SAN Volume Controller Information Center

Redbooks

Redbooks pertaining to IBM System Storage Productivity Center

Legal

Terms of use
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Using the information center

About the information center
Prerequisite software
Accessibility and keyboard shortcuts
Navigating
Searching
Setting bookmarks and printing
Viewing information in different languages

Navigating the information center by keyboard

Use the following key combinations to navigate the help system by keyboard:

To go to the next link, button or topic node from inside a pane in the help browser, press Tab.
To expand and collapse a node in the tree, press the Right and Left arrows.
To move to the next topic node, press the Down arrow or Tab.
To move to the previous topic node, press the Up arrow or Shift+Tab.
To scroll all the way up or down, press Home or End.
To go back, press Alt+Left arrow; to go forward press Alt+Right arrow.
To go to the next pane, press Ctrl+Tab.
To move to previous pane, press Shift+Ctrl+Tab.
To print the the active pane, press Ctrl+P.

Terms of use | Feedback

(C) Copyright IBM Corporation 2007, 2009.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

New for IBM System Storage Productivity Center Version 1.4
Use this information to learn about the new features and enhancements that are included in IBM® System
Storage™ Productivity Center Version 1.4.

System Storage Productivity Center 1.4 adds the following new features, functions, and enhancements:

New 2805-MC4
System Storage Productivity Center 2805-MC4 includes a hard drive that is 10 GB larger than the
previous model. System Storage Productivity Center 2805-MC2 and 2805-MC3 are no longer available
for purchase.

IBM Tivoli® Storage Productivity Center
IBM Tivoli Storage Productivity Center Basic Edition 4.1.1 is preinstalled on the System Storage
Productivity Center server.

IBM System Storage DS8000® R5.0
You can monitor System Storage DS8000 5.0 or earlier releases with System Storage Productivity
Center.

IBM System Storage SAN Volume Controller Console 5.1.0
IBM SAN Volume Controller Console 5.1.0 is preinstalled on the System Storage Productivity Center
server. Because version 5.1.0 no longer requires a CIM agent to communicate with the SAN Volume
Controller, a CIM agent is not installed with the console. Instead, the console uses the CIM agent that
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is embedded in the SAN Volume Controller hardware. To manage older levels of the SAN Volume
Controller, install the corresponding CIM agent on the SSPC server. PuTTY is installed on System
Storage Productivity Center and available for key generation.

IBM System Storage DS® Storage Manager 10.60
A new version of the System Storage DS Storage Manager user interface is available for you to
optionally install on the System Storage Productivity Center server or on a remote server. The DS
Storage Manager 10.60 can manage the IBM DS3000, IBM DS4000®, and IBM DS5000. With DS
Storage Manager 10.60, when you use Tivoli Storage Productivity Center to add and discover a DS CIM
agent you can launch the DS Storage Manager from the topology viewer, the Configuration Utility, or the
Disk Manager of Tivoli Storage Productivity Center.

IBM Java™ 1.5
IBM Java 1.5 is preinstalled and can be used with DS Storage Manager 10.60. You do not need to
download Java from Sun Microsystems.

DS CIM agent management commands
The DS CIM agent management commands (DSCIMCLI) for Release 5.4.3 are preinstalled on the
System Storage Productivity Center server.

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

New in Release 1.3.2
Use this information to learn about the new features and enhancements that are included in IBM® System
Storage™ Productivity Center release 1.3.2.

System Storage Productivity Center 1.3.2 adds the following new features, functions, and enhancements:

Name change
IBM TotalStorage® Productivity Center has been renamed to Tivoli® Storage Productivity Center V4.1.
All user interfaces, documentation, online help, and messages reflect the new name.

Tivoli Storage Productivity Center 4.1
IBM Tivoli Storage Productivity Center Basic Edition 4.1.0 is preinstalled on the IBM System Storage
Productivity Center server. Changes to the IBM Tivoli Storage Productivity Center include the following
major enhancements:

Licensing changes
The following licenses are available for Tivoli Storage Productivity Center.

IBM Tivoli Storage Productivity Center Basic Edition
IBM Tivoli Storage Productivity Center Standard Edition
IBM Tivoli Storage Productivity Center for Disk
IBM Tivoli Storage Productivity Center for Data

Integration of Tivoli Storage Productivity Center and Tivoli Storage Productivity Center for Replication
Tivoli Storage Productivity Center and IBM Tivoli Storage Productivity Center for Replication,
previously separated products, are now integrated. You can start the IBM Tivoli Storage
Productivity Center for Replication 4.1 user interface from within the Tivoli Storage Productivity
Center 4.1 user interface.

Integration of Tivoli Storage Productivity Center and Tivoli Integrated Portal

IBM System Storage Productivity Center 1.4.0 3
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IBM Tivoli Integrated Portal is a standards-based architecture for Web administration. The
installation of Tivoli Integrated Portal is required to enable single sign-on for Tivoli Storage
Productivity Center. Tivoli Storage Productivity Center now installs Tivoli Integrated Portal along
with Tivoli Storage Productivity Center.

Launch in context feature
The launch in context feature enables you to access external applications from the Tivoli Storage
Productivity Center GUI. Three levels of launch in context exist: simple launch discovers basic
information about a device and its management; launch with parameters navigates to a
particular panel or state of an application; and launch with single sign-on lets you access
multiple external applications by using one user ID and password.

Single sign-on authentication
Single sign-on is an authentication process that enables you to enter one user ID and password
to access multiple applications. It requires a centralized user and group repository that all
participating applications can access, such as a directory that complies with the Lightweight
Directory Access Protocol (LDAP).

Support of Storage Resource agents
On Microsoft® Windows®, AIX®, and Linux®, Tivoli Storage Productivity Center supports Storage
Resource agents. The Storage Resource agent probe provides the same information as
information that is collected by probes that use the Data agent. The Storage Resource agents do
not require the Agent Manager. Storage Resource agents offer a variety of asset reports, as well
as topology and Data Path Explorer functions.

Support for IBM DB2® 9.5
Tivoli Storage Productivity Center now supports DB2 9.5. You can migrate your Tivoli Storage
Productivity Center databases from DB2 9.1 or DB2 8.2 to DB2 9.5. DB2 9.5 is optional. Tivoli
Storage Productivity Center continues to support DB2 9.1.

System Storage SAN Volume Controller
IBM SAN Volume Controller console and SAN Volume Controller CIM agent 4.3.1 are preinstalled on
the IBM System Storage Productivity Center server.

To communicate with the SAN Volume Controller, the SAN Volume Controller console can use a CIM
agent that is embedded in the SAN Volume Controller hardware or a proxy CIM agent that is installed
on other hardware. When you add a SAN Volume Controller CIM agent to the Tivoli Storage Productivity
Center, you can use the embedded CIM agent or the proxy CIM agent.

System Storage DS® Storage Manager
A new version of the IBM System Storage DS Storage Manager user interface is available for you to
optionally install on the System Storage Productivity Center server or on a remote server. The DS
Storage Manager 10.50 can manage the DS3000, DS4000®, and DS5000.

DS CIM agent management commands
The DS CIM agent management commands (DSCIMCLI) for 5.4.2 are preinstalled on the System
Storage Productivity Center system.

Enhancements to Password Tool
The Password Tool that you use to change the DB2 user, WebSphere® user, and DB2 service passwords
now generates fewer messages and command windows.

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Printable documentation
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Print a single topic, using either the print function of your Web browser or the print function of the information
center. To print multiple topics easily, print from the PDF version of this documentation.

Viewing, printing, and saving a PDF

The topics in the information center are captured in a series of PDF documents that are accessible from this
topic. Printing from a PDF is the best way to print multiple topics at one time.

1. Download Adobe Acrobat Reader, if necessary.
2. View and print one of the available PDF files.
3. Save the PDF file to open it in Acrobat Reader without a browser.

Downloading Adobe Acrobat Reader

You need Adobe Acrobat Reader to view or print these PDF files. You can download a free copy from the
Adobe Web site  (www.adobe.com/products/acrobat/readstep.html).

Viewing and printing PDF files

Click one of the following links to view the corresponding PDF within your browser. Print the PDF by selecting
the Print icon on the browser toolbar, or by selecting File > Print.

Introduction and Planning Guide (about 1452 KB)
Rack Installation Instructions (about 1194 KB)
Read This First flyer (about 208 KB)
User's Guide (about 3536 KB)

Saving a PDF file

To save a PDF file, complete the following steps:

1. Right-click the link to the PDF in your browser.
2. Perform one of the following tasks:

For Internet Explorer Click Save Target As.

For Netscape Navigator or Mozilla Click Save Link As.

3. Navigate to the directory in which you want to save the PDF file.
4. Click Save.

Printing a single topic

The Print Page button ( ) is located on the border of the information center.

1. Display the topic that you want to print by selecting it from the table of contents or from the search
results.

2. (Recommended) Click the displayed topic to place focus on the content area of the information center.
3. Click the Print Page button.

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)
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Getting started
The topics in this section describe preinstallation resources and tasks.

Roadmap for IBM System Storage Productivity Center
Use the Roadmap to quickly install and configure the IBM® System Storage™ Productivity Center
(SSPC).
Planning work sheet
As the customer, you are required to provide the IBM service representatives with information about
these work sheets so they can set up the SSPC server. If you do not provide this information, it will
delay the time it takes to set up the SSPC server.
Accessibility
IBM strives to provide products with usable access for everyone, regardless of age or ability.

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Roadmap for IBM System Storage Productivity Center
Use the Roadmap to quickly install and configure the IBM® System Storage™ Productivity Center (SSPC).

Task

Who
performs
task Go to this link

Read the Introduction section to familiarize yourself
with the product

Customer Introduction

Ensure that all prerequisites are met Customer Prerequisites

Complete the Planning work sheet and assemble the
materials that are needed for the installation

Customer Planning work sheet and For the
customer: preparing for the
installation

Install the System Storage Productivity Center Model
2805-MC4 in the rack and connect the cables

IBM Service
Representat
ive

For the IBM Service Representative:
installing the hardware

Start the Model 2805-MC4 server and configure the
operating system

IBM Service
Representat
ive

For the IBM service representative:
configuring the operating system

Set the time and configure the network IBM Service
Representat
ive

For the IBM service representative:
completing the initial configuration
tasks

Test the installation IBM Service
Representat
ive

For the IBM service representative:
testing the installation
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Task

Who
performs
task Go to this link

Change the SSPC password IBM Service
Representat
ive

For the IBM service representative:
completing the installation

Configure IBM System Storage Productivity Center to
work with the DS8000® element managers

Customer Configuring SSPC for the DS8000

Configure IBM System Storage Productivity Center to
work with the SAN Volume Controller

Customer Configuring SSPC for SAN Volume
Controller

Configure IBM System Storage Productivity Center to
work with the DS3000, DS4000®, and DS5000

Customer Configuring SSPC for DS3000,
DS4000, and DS5000

Configure IBM System Storage Productivity Center to
work with IBM Tivoli Storage Productivity Center for
Replication

Customer Configuring SSPC for IBM Tivoli
Storage Productivity Center for
Replication

Parent topic: Getting started

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Planning work sheet
As the customer, you are required to provide the IBM® service representatives with information about these
work sheets so they can set up the SSPC server. If you do not provide this information, it will delay the time it
takes to set up the SSPC server.

System Storage Productivity Center server information

As part of the SSPC planning, select the rack position. The position in the rack is identified by an Electrical
Industries Association (EIA) number. The SSPC has a height of one EIA, referred to as 1U. Select a location in
the rack that allows enough space for hardware components that might be installed at a future date.

A keyboard and mouse with Universal Serial Bus (USB) connectors are required for the initial setup of the
SSPC. A video display is also required. You can install an optional keyboard video mouse (KVM) unit by
ordering Feature Code 9100. If you install it as part of this service action, record the rack location of the KVM
unit in Table 1.
Tip: As a best practice, install the KVM unit directly above or below the System Storage™ Productivity Center
server so that the connecting cables of the device can reach the server. Feature code 9100 comes with
installation instructions. If you ordered this feature code, follow the instructions but do not remove and
discard the rubber pads under the keyboard. Peel off the protective strip on the console to expose the
adhesive surface and place the keyboard into the tray. Press the keyboard firmly so that it adheres to the tray.
You can discard the switch mounting brackets that come with feature code 9100.

Table 1. EIA location of the System Storage Productivity Center server and the keyboard
video mouse unit

System Storage Productivity
Center hardware location

EIA number: __________

IBM System Storage Productivity Center 1.4.0 7

http://www.ibm.com/servers/storage/support/software/tpc/
http://www.ibm.com/legal/


within the rack

Keyboard video mouse unit
location within the rack (this
may be installed already and
is optional)

EIA number: __________

Windows Server 2008 Enterprise Edition Product Key and computer name

During the initial Windows® configuration process, you are prompted to enter the 25-digit Windows product
key. The key is printed on a sticker labeled "Proof of License Certificate of Authority" and is located on the
outside top cover of the System Storage Productivity Center server. Record this key now because the sticker
might be obscured when you place the System Storage Productivity Center server in the hardware rack.

Windows product key: 
__ __ __ __ __ - __ __ __ __ __ - __ __ __ __ __ - __ __ __ __ __ - __ __ __ __ __

Table 2. Computer name
Field Entry Notes

System Storage
Productivity
Center

Computer name: 
___________________

Specify the System Storage Productivity
Center computer name, list it here so that the
IBM service representative can set it during
the installation.

Table 3. Customer Passwords
Field Entry Notes

Windows
Administrator
Password

Administrator Password: 
___________________

List the password that the IBM service
representative will set the Administrator ID to
during the initial logon to the System Storage
Productivity Center. 

This password can be changed after the
system has been installed. 

The password must conform to the following
rules: 8 characters, one number, one
uppercase character.

Host
authentication
password

Host authentication 
password:
___________________

List the password that is used by the Tivoli®
Storage Productivity Center when
communicating with the Fabric agents. This
password can be different than the Windows
administrator password.

This password can be changed after the
system has been installed.

The password must conform to the following
rules: 8 characters, one number, one
uppercase character.

System Storage Productivity Center physical location
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In Table 4, record the IP addresses and host name for the SSPC.

Table 4. IP addresses and host name
Field IP address or host name Notes

SSPC IP address IP address: ___________________ This value is the address for the System
Storage Productivity Center server.

SSPC Subnet Mask IP address: ___________________ This value hides the IP address. Obtain
this value by typing ipconfig in a
command prompt window on any
computer on the network or by asking
the network administrator.

SSPC Default gateway IP address: ___________________ This value is the router that allows
access from one network to another
network. Obtain this value by typing
ipconfig in a command prompt window
on any computer on the network or by
asking the network administrator.

SSPC Preferred DNS
address

DNS address: ___________________ This value is the address for the domain
name server for your site. Obtain this
value by typing ipconfig in a command
prompt window on any computer on the
network or by asking the network
administrator.

SSPC Alternate DNS
address

DNS address: ___________________ This value is the alternate address for the
domain name server for your site. Obtain
this value by typing ipconfig in a
command prompt window on any
computer on the network or by asking
the network administrator.

DNS suffix DNS suffix: _____________________ This value is the part of a fully qualified
domain name that represents a grouping
of host names. For example, in the fully
qualified domain name of sspc.ibm.com,
the DNS suffix is ibm.com. Obtain this
value from the network administrator.

Device information

Use the following tables to record information about your storage system.

Table 5. Device information for DS8000
Device
type

Default
ports User ID, password, and host name

IP address of
storage system

DS8000®
element
manager

8451
(http)
8452
(https)

Default user ID: admin IP address HMC:
__________ 

IBM System Storage Productivity Center 1.4.0 9



Device
type

Default
ports User ID, password, and host name

IP address of
storage system

Default password:
admin 
You must change the default password when you log on.
Changing the default password automatically changes the
DS8000 CIM agent password to match it.

Host name:
__________

Note: Do not use special characters such as # or & in the host
name. This causes the host name to be truncated.

DS8000
CIM agent

For
embedde
d CIM
agent:

Default user ID:
admin

For embedded
CIM agent:

6989
(https)

The default password automatically changes to match the
DS8000 element manager password.

IP address of
HMC:
__________

For proxy
CIM
agent:

Host name:
__________

For proxy CIM
agent:

5988
(http) 
5989
(https)

  IP address of
proxy CIM agent:
__________

Table 6. Device information for SAN Volume Controller

Device type Default ports
User ID, password, and
host name

IP address of storage
system

SAN Volume Controller
CIM agent

For embedded CIM
agent:

5989 (https)

Default user ID: 
superuser

IP address:
______________

Default password:
passw0rd

Host name: 
__________

Parent topic: Getting started
Parent topic: Planning

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Accessibility
IBM strives to provide products with usable access for everyone, regardless of age or ability.
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This product uses standard Windows navigation keys.

For more information about accessibility, see Accessibility features for IBM Tivoli Storage Productivity Center.

Parent topic: Getting started

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Overview
IBM® System Storage™ Productivity Center (SSPC) is an IBM Machine Type 2805 server and preinstalled
software that can help you improve and centralize the management of your storage environment through the
integration of products. It provides a single point from which to manage your storage systems.

System Storage Productivity Center simplifies storage management by:

Centralizing the management of storage network resources with IBM storage management software
Providing greater synergy between storage management software and IBM storage devices
Reducing the number of servers that are required to manage your software infrastructure
Providing a simple migration path from basic device management to using storage management
applications that provide higher-level functions

System Storage Productivity Center is a 1U, rack-mounted hardware appliance that has IBM Tivoli® Storage
Productivity Center Basic Edition and IBM Tivoli Storage Productivity Center for Replication installed on it. See
Figure 1 for a view of the hardware.
Figure 1. Front view of the System Storage Productivity Center server. The illustrations in this document might
differ slightly from your model.
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Figure 2 shows an overview of how the System Storage Productivity Center, IBM Tivoli Storage Productivity
Center, IBM Tivoli Storage Productivity Center for Replication, and the hardware and software for IBM System
Storage DS8000®, IBM System Storage SAN Volume Controller, IBM System Storage DS3000, IBM System
Storage DS4000®, and IBM System Storage D5000 all relate with each other.

Note: The IBM Tivoli Storage Productivity Center was formerly the IBM TotalStorage® Productivity Center.
Figure 2. Overview of System Storage Productivity Center

System Storage Productivity Center provides integration of storage management applications for the following
products:

IBM Tivoli Storage Productivity Center Basic Edition
IBM Tivoli Storage Productivity Center Basic Edition simplifies the complexity of managing multiple
SAN-attached storage devices because you can perform device configuration and management of SAN-
attached devices from a single console.
With Basic Edition, you can manage network storage components based on SMI-S, such as:

IBM System Storage SAN Volume Controller
IBM TotalStorage Enterprise Storage Server® (ESS)
IBM System Storage disk systems (DS3000, DS4000, DS5000, DS6000™, and DS8000 series)
Other storage systems that use SMI-S standards

Device discovery is performed by Service Location Protocol (SLP), as specified by SMI-S. Configuration
of the discovered devices is possible in conjunction with CIM agents associated with those devices,
using the standard mechanisms defined in SMI-S. Tivoli Storage Productivity Center gathers events and
can start an element manager specific to each discovered device.

For SAN fabrics, Tivoli Storage Productivity Center simplifies the management and improves the
availability of the SAN environment. You can monitor and report on SAN resources and use a single
location for zone control. Tivoli Storage Productivity Center discovers existing zones and zone members
so that you can modify or delete them. You can create new zones, and you can also use aliases.

Tivoli Storage Productivity Center gives you the ability to view events happening in your SAN
environment and record state changes. Events related to topology changes or updates can be
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forwarded to the IBM Tivoli Enterprise Console®, to another manager that uses Simple Network
Manager Protocol (SNMP), or to both.

For the SAN fabric, Tivoli Storage Productivity Center works with host bus adapters (HBAs), disk
systems, tape systems, SAN switches, routers, and gateways.

SSPC might also be used with other hardware because that hardware is used by Tivoli Storage
Productivity Center. For a complete list of supported devices, go to
http://www.ibm.com/software/sysmgmt/products/support/IBMTotalStorageProductivityCenterSt
andardEdition.html and click Plan > [View all Plan documents].

Integrated into the IBM Tivoli Storage Productivity Center are both the IBM Tivoli Storage Productivity
Center for Replication and the IBM Tivoli Integrated Portal.

Note: Tivoli Storage Productivity Center for Replication was formerly a separate product.

IBM Tivoli Integrated Portal is a standards-based architecture for Web administration. You can access
Tivoli Storage Productivity Center and Tivoli Storage Productivity Center for Replication from the Tivoli
Integrated Portal GUI, and you can access Tivoli Storage Productivity Center for Replication from the
Tivoli Storage Productivity Center GUI.

With the Tivoli Storage Productivity Center, components of the Tivoli Integrated Portal, Tivoli Storage
Productivity Center for Replication, and Tivoli Storage Productivity Center are automatically configured
to use a feature known as launch in context. The launch in context feature gives you the ability to
access external applications from the Tivoli Storage Productivity Center GUI. The most prevalent
external applications that use the launch in context feature are element managers. An element
manager is typically vendor-specific software that administers a particular storage device. The launch
in context feature provides starting points in the Tivoli Storage Productivity Center GUI so you can click
a button or select a menu item to start an element manager and work with a specific device.

There are three levels of launch in context ability:

Simple launch
This level exists in TotalStorage Productivity Center 3.3.2. Tivoli Storage Productivity Center
discovers basic information about the device and the management of the device.

Launch with parameters
You can specify additional parameters in the URL or command-line interface when starting an
application. When the parameters are passed, you can navigate to a particular panel or state of
the application that was started. You can also identify objects to operate on and possibly provide
values to use in the operation.

Launch with single sign-on
You can enhance the launch in context feature to include single sign-on. Single sign-on is an
authentication process that lets you enter one user ID and password to access multiple
applications. Single sign-on integrates with the launch in context feature so that you can move
from one application to a specific location in a second application. An external application can
use single sign-on to authenticate with the same user repository as Tivoli Storage Productivity
Center. An example of such a user repository is a directory that complies with the Lightweight
Directory Access Protocol (LDAP).

External applications that do not include the WebSphere® Application Server require the
authentication service that is provided by Tivoli Integrated Portal. For example, the element
managers for the IBM System Storage DS8000 (the DS8000 Storage Manager) and the SAN
Volume Controller both use the authentication service of Tivoli Integrated Portal to handle
launch in context with single sign-on from the Tivoli Storage Productivity Center GUI.
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The installation of Tivoli Integrated Portal is required to enable single sign-on for Tivoli Storage
Productivity Center. Single sign-on lets you access:

Tivoli Storage Productivity Center and Tivoli Storage Productivity Center for Replication
from the Tivoli Integrated Portal GUI
Tivoli Storage Productivity Center for Replication from the Tivoli Storage Productivity
Center GUI
External applications, such as element managers from the Tivoli Storage Productivity
Center GUI

The single sign-on feature requires a centralized user and group repository, such as an LDAP-
compliant directory, that all participating applications can access. Also, Tivoli Storage
Productivity Center uses Lightweight Third Party Authentication (LTPA) tokens to pass the user
information between applications. To use LTPA tokens for single sign-on, each participating
application must possess the same set of keys to encode and decode the user information
contained in the token. As an additional security feature, the LTPA tokens expire after a
determined amount of time. When the tokens expire, you must reenter your user ID and
password information.

If you select operating system authentication, the use of the single sign-on feature is limited.
Operating system authentication does not use single sign-on for element managers, even when
the element manager is installed on the same server as Tivoli Storage Productivity Center. For
more information about authentication,

Tivoli Storage Productivity Center works with Storage Resource agents on Microsoft® Windows®, AIX®,
and Linux®. The Storage Resource agent probe is equivalent to the information that is collected by
probes that use the Data agent. The Storage Resource agents do not require the Agent Manager and
can be deployed to other systems by using the Tivoli Storage Productivity Center GUI on the server
system. Storage Resource agents offer asset reports (including reports for HBAs), capacity reports,
subsystem-to-host-storage correlation (including multipathing information), and topology and Data
Path Explorer functions. They do not offer file system scans, discovery or topology of network-attached
storage, zoning and zone control functions, or subsystem device-driver configuration. For this
information, you can continue to use the Data agent and Fabric agent. For additional information and to
view sample reports,

Tivoli Storage Productivity Center now works with DB2® 9.5. You can, optionally, migrate your Tivoli
Storage Productivity Center databases from DB2 9.1 or DB2 8.2 to DB2 9.5. Tivoli Storage Productivity
Center continues to work with DB2 9.1.

System Storage DS8000 Storage Manager
The IBM System Storage DS8000 Storage Manager user interface is accessible from the Tivoli Storage
Productivity Center user interface. Tivoli Storage Productivity Center provides a DS8000 element
manager page, which you can use to add and manage multiple DS8000 element managers from one
console. With the DS8000 element manager page, you can:

Access the IBM DS8000 Storage Manager interface that is embedded in the DS8000 Hardware
Management Console (HMC) and
Use the IBM DS8000 Storage Manager interface to configure and administer its associated IBM
DS8000 storage arrays.

The HMC is the console located inside the IBM DS8000 storage system. Starting with Release 2, the
IBM DS8000 includes the CIM agent, the Enterprise Storage Server Network Interface Server, and the
client as well as the disk drives. The HMC uses WebSphere to display Web pages to the Web browser
that is embedded in the Tivoli Storage Productivity Center user interface, a browser directly on the
HMC, or an external browser. Starting with Release 3, the use of the Tivoli Storage Productivity Center
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user interface is required. If the IBM DS8000 has an HMC that has been upgraded from Release 2 to
Release 3 or later, you can start the user interface through an external browser.

The IBM DS8000 Storage Manager is preinstalled on the DS8000 HMC. This software will continue to
be included with the HMC.

The CIM agent for the IBM DS8000 is embedded in the HMC. Tivoli Storage Productivity Center can be
configured to communicate with the CIM agent. The CIM agent is required for storage asset
information, provisioning, alerting, and performance monitoring. The CIM agent conforms to the
Storage Networking Industry Association (SNIA) Storage Management Initiative - Specification (SMI-S)
to provide a communication transport between Tivoli Storage Productivity Center and the managed
devices. The CIM agent must be enabled by the IBM service representative for R2, R3, and R4, but not
for R4.1 or later. The CIM agent is enabled by default for R4.1 or later.

The DS CIM agent that is embedded in the IBM DS8000 must be configured. To configure the DS CIM
agent, you can click the Launch DSCIMCLI icon on the desktop to open a command prompt window. For
information about the DSCIMCLI, go to:
http://www.ibm.com/servers/storage/support/software/cimdsoapi/

System Storage SAN Volume Controller

The SAN Volume Controller combines software and hardware into an appliance that uses symmetric
virtualization.

Symmetric virtualization creates a pool of managed disks (MDisks) from the attached storage systems.
Those storage systems are then mapped to a set of virtual disks (VDisks) for use by attached host
systems. System administrators can view and access a common pool of storage on the SAN.

The IBM System Storage SAN Volume Controller Console is installed with System Storage Productivity
Center. The SAN Volume Controller Console is a separate icon from the Tivoli Storage Productivity
Center user interface icon on your desktop.

With version 5.1.0, the SAN Volume Controller Console no longer requires a CIM agent to communicate
with the SAN Volume Controller. As a result, a CIM agent is not included as part of the graphical user
interface (GUI) of the SAN Volume Controller. Instead, the console uses the CIM agent that is
embedded in the SAN Volume Controller hardware. If it is necessary to manage an older level of the
SAN Volume Controller, install the corresponding CIM agent on the SSPC server. PuTTY is installed on
SSPC and available for key generation.

The SAN Volume Controller software performs the following functions for the host systems that attach
to SAN Volume Controller over the SAN:

Creates a single pool of storage
Provides logical unit virtualization
Manages logical volumes
Mirrors logical volumes

The SAN Volume Controller also provides the following features:

Large cache
Copy Services

FlashCopy® (point-in-time copy)
Metro Mirror (synchronous copy)
Global Mirror (asynchronous copy)
Data migration

Space management
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Mapping that is based on performance of the characteristics that you want
Service quality metering
Space-efficient logical volumes (thin provisioning)

The SAN Volume Controller hardware consists of a SAN Volume Controller node that is an individual
server in a SAN Volume Controller cluster.

The nodes are always installed in pairs, with a minimum of one and a maximum of four pairs of nodes
constituting a cluster. Each pair of nodes is known as an I/O group. All I/O operations that are managed
by the nodes in an I/O group are cached on both nodes. I/O groups take the storage that is presented
to the SAN as MDisks by the storage systems and translates the storage into logical disks, known as
VDisks, that are used by applications on the hosts. A node resides in only one I/O group and provides
access to the VDisks in that I/O group.

With SAN Volume Controller, you can work with virtual disk copies, so that when the SAN Volume
Controller is probed by Tivoli Storage Productivity Center, all virtual disks have underlying logical
volumes representing the virtual disk.

Tivoli Storage Productivity Center for Replication

Beginning with Release 4.1, IBM Tivoli Storage Productivity Center for Replication and Tivoli Storage
Productivity Center, previously separated products, are integrated. This means that you can start the
IBM Tivoli Storage Productivity Center for Replication user interface from within the Tivoli Storage
Productivity Center user interface.

By concentrating support for different hardware, interface implementations, element managers, and
session managers into a single product, Tivoli Storage Productivity Center for Replication acts as an
IBM single point of control for hardware-provided copy services. For high-level interfaces, it leverages
use of copy services by providing a standard interface, standard states, and standard status across
different copy types and different hardware. For example, the basic functions of Tivoli Storage
Productivity Center for Replication 4.1 provide management of IBM FlashCopy, Metro Mirror and Global
Mirror capabilities for the IBM ESS Model 800, IBM DS6000, and IBM DS8000. Tivoli Storage
Productivity Center for Replication also manages FlashCopy and Metro Mirror for the SAN Volume
Controller.

System Storage Productivity Center requires you to purchase and accept the license for the Tivoli
Storage Productivity Center for Replication Two Site Business Continuity (BC), Tivoli Storage
Productivity Center for Replication Three Site Business Continuity (BC), or a 60-day trial version (try
and buy) before using the product.

Two Site BC provides continuous availability and disaster recovery solutions by using point-in-time
replication, which includes FlashCopy, and continuous replication, which includes Metro Mirror, Global
Mirror, and Metro Global Mirror. With Tivoli Storage Productivity Center for Replication Two Site BC, you
can use failover and failback to ensure that your data exists on both of your sites, and you can reverse
the direction of your sessions' data flow (making your secondary site your primary site, if necessary).

Three Site BC is an optional feature that provides you with all of the capabilities of Tivoli Storage
Productivity Center for Replication Two Site, as well as the ability to perform a Metro Global Mirror (with
failover/failback) to secondary and tertiary sites.

Note: There are different hardware feature codes that you must purchase and install on the hardware
itself for different hardware features to work. For example, if you want to use FlashCopy on the
DS8000, you must have the hardware feature code to run FlashCopy on the DS8000. To determine the
feature codes for supported hardware, contact your IBM marketing representative.
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Tivoli Storage Productivity Center for Replication is available on a trial basis before purchase. For
information, see .

With the integration of IBM Tivoli Storage Productivity Center for Replication and Tivoli Storage
Productivity Center, you can:

Access Tivoli Storage Productivity Center and Tivoli Storage Productivity Center for Replication
from the Tivoli Integrated Portal GUI, and access Tivoli Storage Productivity Center for
Replication from the Tivoli Storage Productivity Center GUI.
Use the Tivoli Storage Productivity Center GUI to set up Tivoli Storage Productivity Center for
Replication SNMP alerts and IBM Tivoli Enterprise Console events.
Provide a Tivoli Storage Productivity Center superuser role that has authority over all Tivoli
Storage Productivity Center commands. Tivoli Storage Productivity Center for Replication
includes a replication administrator role that has authority to all Tivoli Storage Productivity
Center for Replication commands. Tivoli Storage Productivity Center for Replication will honor
the Tivoli Storage Productivity Center superuser role, giving the superuser role authority over all
Tivoli Storage Productivity Center and Tivoli Storage Productivity Center for Replication
commands.

IBM System Storage DS3000, DS4000, and DS5000 Storage Manager

You can optionally install the DS3000, DS4000, and DS5000 Storage Manager user interface on the
System Storage Productivity Center server, or a remote server so that you can manage the storage
systems from a single console.

The DS4000 series of storage servers use Redundant Array of Independent Disks (RAID) technology.
RAID technology is used to protect the user data from disk drive failures. DS4000 storage servers
contain Fibre Channel (FC) interfaces to connect both the host systems and disk drive enclosures.

The storage servers in the DS4000 series provide high system availability through the use of hot-
swappable and redundant components. This is crucial when the storage server is placed in high-end
customer environments such as server consolidation on storage area networks (SANs).

The DS Storage Manager software is used to configure, manage, and troubleshoot the DS4000 or
DS5000 storage servers. With DS Storage Manager, you can:

Configure RAID arrays and logical drives
Assign logical drives to hosts
Replace and rebuild failed disk drives
Expand the size of the arrays and logical drives
Convert from one RAID level to another

The DS Storage Manager also offers troubleshooting and management tasks such as:

Checking the status of the storage server components
Updating the firmware of the RAID controllers
Managing the storage server

After you add and discover a DS CIM agent, you can launch the DS Storage Manager from the user
interface of the Tivoli Storage Productivity Center 4.1.1. You can launch the Storage Manager from the
topology viewer, Configuration Utility, or Disk Manager.

Also with DS Storage Manager, you can use advanced features of IBM Tivoli Storage Productivity Center
for Replication, such as FlashCopy, Volume Copy, and Enhanced Remote Mirroring.
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To use Tivoli Storage Productivity Center to view reports and topology from the DS3000, DS4000, or
DS5000, you must first install the Engenio SMI-S Provider (CIM agent) for the storage system (on a
separate server; not the System Storage Productivity Center server). For information about the Engenio
SMI-S Provider, contact LSI at
http://www.lsi.com/storage_home/products_home/external_raid/management_software/smis_provid
er/index.html.

Beginning with System Storage Productivity Center 1.4, when you configure the SSPC for the DS3000,
DS4000, or DS5000, it is no longer necessary to install Java™. Instead, IBM Java 1.5 comes
preinstalled on the SSPC server.

DS CIM agent management commands
The DS CIM agent management commands (DSCIMCLI) are installed on the System Storage
Productivity Center system. The DSCIMCLI can manage the CIM agents for DS8000, DS6000, and ESS.
For information about the CIM agent management commands, see DS Open Application Programming
Interface Reference at http://www.ibm.com/servers/storage/support/software/cimdsoapi/. You see the
"Support for CIM Agent for DS Open (API)" page. Click Install > Documentation. Reference the correct
document for your CIM agent.
Use the following DS CIM agents for the specified releases:

DS CIM agent 5.4.1 for DS8000 R4.1
DS CIM agent 5.4.2 forDS8000 R4.2
DS CIM agent 5.4.3 for DS8000 R4.3

Tivoli Storage Productivity Center demonstration
The Tivoli software demonstration Web site provides an introduction and a product demonstration for
the storage management products you might use.
IBM System Storage Productivity Center options
IBM System Storage Productivity Center offers several different packages depending on the functions
you want. This topic provides information about those packages.
IBM System Storage Productivity Center packages
IBM System Storage Productivity Center offers several different packages depending on the functions
you want.
Maintaining user IDs and passwords
Use this procedure to change the passwords for Windows Administrator, DB2 user, DB2 services, and
IBM Tivoli Storage Productivity Center for Replication.
Identifying responsibilities for maintaining, upgrading, and configuring the SSPC server
Use this information to learn about what responsibilities you have for maintaining, upgrading, and
configuring the SSPC server.
IBM System Storage Productivity Center desktop
The IBM System Storage Productivity Center desktop displays the icons you can use to open the user
interfaces for the different products.
Hardware components
The SSPC consists of an IBM System x® server running the Microsoft Windows Server 2008 Enterprise
Edition operating system. This topic describes the standard SSPC server configuration.

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Tivoli Storage Productivity Center demonstration
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The Tivoli software demonstration Web site provides an introduction and a product demonstration for the
storage management products you might use.

For a demonstration of IBM® Tivoli® Storage Productivity Center, including an overview, expert videos, product
demonstrations, and additional resources, see http://www.ibm.com/software/tivoli/library/demos/tpc-
launchpad.html.

Parent topic: Overview

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

IBM System Storage Productivity Center options
IBM® System Storage™ Productivity Center offers several different packages depending on the functions you
want. This topic provides information about those packages.

The following software components are preinstalled on the System Storage Productivity Center 2805-MC4
server:

The English version of Microsoft® Windows® Server 2008 32-bit Enterprise Edition
IBM DB2® Enterprise Server Edition 9.5 with Fix Pack 3
IBM Tivoli® Storage Productivity Center 4.1.1
IBM Tivoli Storage Productivity Center for Replication 4.1.1
SAN Volume Controller Console version 5.1.0
IBM DS CIM agent management commands (DSCIMCLI) 5.4.3

When you start the SSPC server, the system will prompt you for the acceptance of the Windows License
Agreement and for the license key.

You can optionally install these programs:

Tivoli Storage Productivity Center upgrades
There are several different commercially available packages of Tivoli Storage Productivity Center that
provide additional functionality beyond Tivoli Storage Productivity Center Basic Edition. Tivoli Storage
Productivity Center for Disk allows you to monitor storage systems for performance. Tivoli Storage
Productivity Center for Data allows you to collect and monitor file systems and databases. Tivoli
Storage Productivity Center Standard Edition is a bundle that includes all other packages, along with
SAN planning tools that make use of information collected from the Tivoli Storage Productivity Center
components. A complete overview of the Tivoli Storage Productivity Center suite of products is
available at http://www.ibm.com/systems/storage/software/center/products.html. For instructions
about upgrading Tivoli Storage Productivity Center,

DS CLI commands
You can install the DS CLI commands on the System Storage Productivity Center server. (Do not
confuse these commands with the DS CIM agent commands: DSCIMCLI.) For information about
installing DS CLI commands, see
http://publib.boulder.ibm.com/infocenter/dsichelp/ds8000ic/index.jsp. Click Command-line interface
> Installing the DS CLI.

DS3000, DS4000®, or DS5000 Storage Manager user interface
You can install the DS3000, DS4000, or DS5000 Storage Manager user interface on the SSPC server.
For information about installing the user interface, see

Antivirus software
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You can install antivirus software but it is your responsibility to keep your antivirus software up to date.
Important: As a best practice, install antivirus software on the SSPC server but no other software
(except for the upgrades to the programs listed in this topic). While antivirus applications can offer
protection to servers that might be in an unprotected environment, installing other software can cause
port conflicts or performance issues. Other precautions that you can take to protect the SSPC server
include enabling security updates to the operating system and establishing a backup procedure for the
SSPC.

Parent topic: Overview

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

IBM System Storage Productivity Center packages
IBM® System Storage™ Productivity Center offers several different packages depending on the functions you
want.

When you purchase SSPC, you receive IBM Tivoli® Storage Productivity Center and IBM Tivoli Storage
Productivity Center for Replication preinstalled.

Tivoli Storage Productivity Center Basic Edition
Tivoli Storage Productivity Center Basic Edition has IBM Tivoli Storage Productivity Center for Disk
functions. Tivoli Storage Productivity Center Basic Edition offers these functions:

Device discovery
Disk-storage-system management including discovery, monitoring, and provisioning (for
example, volume creation and configuration) for all devices in your SAN
Asset and capacity reporting
Fabric management including discovery, monitoring, and provisioning (for example, zone control
and planning)
Tape management including discovery and monitoring
Management of topology viewer and storage health

Tivoli Storage Productivity Center Basic Edition centralizes management of networked storage devices
that implement the SNIA Storage Management Initiative Specification (SMI-S). This package includes
support for the IBM System Storage DS® family and IBM System Storage SAN Volume Controller. Tivoli
Storage Productivity Center Basic Edition can help reduce storage management complexity and costs,
and help improve data availability using SMI-S.

You can upgrade Tivoli Storage Productivity Center Basic Edition to IBM Tivoli Storage Productivity
Center for Data, IBM Tivoli Storage Productivity Center for Disk, or IBM Tivoli Storage Productivity
Center Standard Edition by purchasing licenses for these packages. The packages provide features
such as performance reporting, server rollup reporting, file-level capacity utilization, SAN planning
tools, and SAN configuration analysis tools. To determine which package best suits your storage-
management needs, see Table 1. For additional information about Tivoli Storage Productivity Center
packages, see IBM Tivoli Storage Productivity Center licenses.

Table 1. Finding the right solution to your storage-management needs
If you need... The best solution is...
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If you need... The best solution is...

A way to measure and forecast storage
growth

IBM Tivoli Storage Productivity Center for
Data

A way to rationalize and classify storage data
through the information lifecycle

IBM Tivoli Storage Productivity Center for
Data

Management of disk performance IBM Tivoli Storage Productivity Center for
Disk

Management of multiple arrays IBM Tivoli Storage Productivity Center for
Disk

A tool to manage SAN configuration,
availability, and performance

IBM Tivoli Storage Productivity Center
Standard Edition

A consolidated view of storage infrastructure
(Disk/SAN/capacity)

IBM Tivoli Storage Productivity Center
Standard Edition

A way to measure IBM and heterogeneous
storage from a single tool

IBM Tivoli Storage Productivity Center
Standard Edition

The ability to manage cumbersome tasks,
such as provisioning, zoning, configuration,
monitoring, and problem determination

IBM Tivoli Storage Productivity Center
Standard Edition

More than one of the preceding storage-
management needs

IBM Tivoli Storage Productivity Center
Standard Edition

The provisioning of both IBM and
heterogeneous storage

IBM Tivoli Storage Productivity Center
Standard Edition or IBM Tivoli Storage
Productivity Center with Advanced
Provisioning

IBM Tivoli Storage Productivity Center for Replication
The basic functions of Tivoli Storage Productivity Center for Replication provide management of IBM
FlashCopy®, Metro Mirror and Global Mirror capabilities for the IBM ESS Model 800, IBM DS6000™,
DS8000®, and IBM SAN Volume Controller.

You can also purchase the licenses for these packages:

IBM Tivoli Storage Productivity Center for Data

The data manager is the component that is responsible for understanding the behavior of the user data
located in the file systems and databases. The data manager includes enterprise-wide reporting and
monitoring, policy-based management, and automated capacity provisioning for direct-attached
storage (DAS), network-attached storage (NAS), and SAN environments.

The purpose of this component is to discover the usage patterns and capacity utilization of the storage
from an application's point of view. The data manager is also responsible for gathering application
usage demographics, reporting on storage from an application's perspective, and performing and
automating actions that provision application storage either by itself or invoking other components to
do so. The data manager is additionally responsible for collecting and analyzing performance
information from the file systems and the databases that are used by applications.

The data manager:

Includes many advanced features for monitoring and automating capacity utilization of your file
systems and databases, helping you manage more storage with the same staff
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Provides enterprise and capacity reporting and role-based management
Ensures application availability by providing storage on demand for file systems
Supports leading databases and provides chargeback capabilities based on storage usage
Supports complex heterogeneous environments such as Direct Access Storage, network-
attached storage and Storage Area Network (SAN), including intelligent disk subsystems and
tape libraries

IBM Tivoli Storage Productivity Center for Disk

The disk manager is the component that is responsible for discovering and monitoring storage
subsystems and performing and automating actions that provision disk resources. The disk manager is
additionally responsible for collecting and analyzing performance information from storage subsystems
and helping in the management of SAN-attached heterogeneous storage devices from a single console.

The disk manager:

Monitors and tracks the performance of SAN-attached Storage Management Initiative
Specification (SMI-S) compliant storage devices (for example, IBM, EMC, HDS, HP, Engenio, and
so forth).
Enables proactive performance management by setting performance thresholds based on
performance metrics and by generating alerts when those thresholds are met.
Provides the data path explorer view to allow administrators to view the paths between servers
and storage subsystems or between storage subsystems (for example, SAN Volume Controller to
back-end storage). Performance and health overlays on this view will provide a mechanism to
assess the impact of performance or device state in the paths on the connectivity between the
systems.
Provides storage provisioning for IBM and heterogeneous storage.
Provides advanced performance management for the DS8000 and SAN Volume Controller.
Provides tape asset reporting.

IBM Tivoli Storage Productivity Center Standard Edition
This package includes IBM Tivoli Storage Productivity Center for Data and IBM Tivoli Storage
Productivity Center for Disk.
Standard Edition also provides:

SAN planning tools:

Volume Planner
The Volume Planner helps administrators plan for the provisioning of subsystem storage
based on capacity, storage controller type, number of volumes, volume size, performance
requirements, RAID level, performance utilization, and capacity utilization.

Path Planner
The Path Planner enables administrators to plan and implement storage provisioning for
hosts and storage subsystems with multipath support in fabrics managed by Tivoli
Storage Productivity Center.

Zone Planner
The Zone Planner enables administrators to plan for zoning and LUN masking
configuration based on the following information: host ports, storage controller ports,
zones, zone sets, switches, user zoning input, user LUN masking input, existing LUN
masking or mapping.

SAN configuration tools:

Configuration analysis
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This tool allows the system administrators to check whether existing configurations
violate defined best practices and policies.

Configuration history
This tool displays the changes that have occurred in the SAN environment over a period of
time.

Fabric management tools:

The fabric manager is the component that is responsible for discovering, monitoring, and
controlling the SAN topology, primarily concentrating on the SAN fabric and on the hosts and
storage systems that are zoned for access. The fabric manager is responsible for collecting and
analyzing performance information from SAN fabrics. The fabric manager is a comprehensive
management solution for heterogeneous fabric support (for example, Brocade, Cisco, McDATA,
and so forth). It includes automatic resource and topology discovery, monitoring performance
and alerts, and zone control.

Table 2 shows a comparison of Tivoli Storage Productivity Center Basic Edition and Tivoli Storage Productivity
Center Standard Edition.

Table 2. Comparison of function of the IBM Tivoli Storage Productivity Center Basic Edition
to the IBM Tivoli Storage Productivity Center Standard Edition

Function
DS Storage
Manager

SAN Volume
Controller
console

IBM Tivoli Storage
Productivity
Center Basic
Edition

IBM Tivoli
Storage
Productivity
Center
Standard
Edition

Storage configuration and status reporting

Discovery and configuration of
devices

✓ ✓ ✓ ✓

Management of multiple
storage systems and SAN
Volume Controller in one user
interface

✓ ✓ ✓ ✓

View of topology and storage
management

    ✓ ✓

Use of provisioning, including
fabric zoning, and disk LUN
assignment

    ✓ ✓

Management of configuration,
presentation of configuration
changes over time periods,
planning of storage
configuration, and proposal of
recommendations

      ✓

Storage reporting

Report of basic assets and
capacity

    ✓ ✓
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Function
DS Storage
Manager

SAN Volume
Controller
console

IBM Tivoli Storage
Productivity
Center Basic
Edition

IBM Tivoli
Storage
Productivity
Center
Standard
Edition

Report of relationships of
computers, file systems, and
disk LUNs and volumes

    ✓ ✓

Analysis of capacity and
prediction of growth

      ✓

Report of customized and
detailed capacity, including
chargeback and database
reporting

      ✓

Performance management

Report of performance and
thresholds

      ✓

Advice about volume
performance and DS8000
configuration information
based on performance
workloads

      ✓

Report and monitoring of fabric
performance

      ✓

IBM Tivoli Storage Productivity Center licenses
The following product licenses are available for IBM Tivoli Storage Productivity Center: Basic, Data,
Disk, and Standard. Each license determines the functions that are accessible in the user interface.
This topic lists the functions that are included with each license to help you determine which one best
meets your storage management needs.

Parent topic: Overview

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

IBM Tivoli Storage Productivity Center licenses
The following product licenses are available for IBM® Tivoli® Storage Productivity Center: Basic, Data, Disk,
and Standard. Each license determines the functions that are accessible in the user interface. This topic lists
the functions that are included with each license to help you determine which one best meets your storage
management needs.

IBM Tivoli Storage Productivity Center Standard Edition
Contains all the functions for data management, disk management, fabric management, and tape
management, plus:
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Analytical functions
Configuration Analysis
Configuration History
SAN Planner

IBM Tivoli Storage Productivity Center for Data Edition
Includes data management, basic tape, disk, and fabric management, database monitoring, and
chargeback functions, but does not include performance monitoring functions.

IBM Tivoli Storage Productivity Center for Disk Edition
Includes basic disk, fabric, tape, and data management functions and storage system performance
monitoring, but does not include fabric performance monitoring, chargeback, and database monitoring
functions.

IBM Tivoli Storage Productivity Center Basic Edition
Includes basic disk, fabric, tape, and data management functions, but does not include chargeback,
database monitoring, and performance monitoring functions.

Use the following tables to view the specific functions, reports, and elements of the user interface that are
available in each license.

Table 1. Available functions in each Tivoli Storage Productivity Center license
Function Basic Edition Disk Edition Data Edition Standard Edition

Administrative Services

Device Discovery Yes, but not all1 Yes, but not all1 Yes Yes

Data Sources Yes, but not all2 Yes, but not all2 Yes Yes

Configuration Yes, but not all3 Yes, but not all3 Yes Yes

IBM Tivoli Storage Productivity Center

Configuration
Utility

Yes Yes Yes Yes

Reporting

Batch
Reports
User ID
reports
System
Reports
Rollup
Reports
Data Source
Reports

Yes

Not all reports are
available in the Basic
edition. See table 2
below for a list of
available reports.

Yes

Not all reports are
available in the Disk
edition. See table 2
below for a list of
available reports.

Yes

Not all reports are
available in the
Data edition. See
table 2 below for a
list of available
reports.

Yes

Topology Viewer Yes Yes Yes Yes

Monitoring

Probes
TPC Server
Probes

Yes4

No
Yes4

No
Yes
Yes

Yes
Yes
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Function Basic Edition Disk Edition Data Edition Standard Edition

Storage Resource
Group
Management

Yes Yes Yes Yes

Analytics

Configuratio
n History
Storage
Optimizer
SAN Planner
Configuratio
n Analysis

No
No
No
No

No
No
No
No

No
No
No
No

Yes
Yes
Yes
Yes

Alerting

Alert Log
Authenticati
on
Configuratio
n Alerts

Yes, but not all5

Yes
Yes, but not all5

Yes
Yes
Yes

Yes
Yes

Data Manager

Monitoring

Groups
Pings
Scans
Profiles

Yes
Yes
No
No

Yes
Yes
No
No

Yes
Yes
Yes
Yes

Yes
Yes
Yes
Yes

Alerting Yes, but not all6 Yes, but not all6 Yes Yes

Policy
Management

No No Yes Yes

Reporting Yes

Not all reports are
available in the Basic
edition. See table 2
below for a list of
available reports.

Yes

Not all reports are
available in the Disk
edition. See table 2
below for a list of
available reports.

Yes Yes

Data Manager for
Databases

No No Yes Yes

Data Manager for
Chargeback

No No Yes Yes

Disk Manager
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Function Basic Edition Disk Edition Data Edition Standard Edition

Storage
Subsystems

Create
Volumes
Create
Virtual Disks
Launch
Element
Manager

Yes

Yes
Yes
Yes

Yes

Yes
Yes
Yes

Yes

Yes
Yes
Yes

Yes

Yes
Yes
Yes

Storage Optimizer No No No Yes

SAN Planner No No No Yes

Monitoring

Groups
Jobs
Storage
Subsystem
Performanc
e

Yes
Yes
No

Yes
Yes
Yes

Yes
Yes
No

Yes
Yes
Yes

Alerting Yes Yes Yes Yes

Profile
Management

No Yes No Yes

Reporting

Groups
Storage
Subsystems
Storage
Subsystem
Performanc
e

Yes
Yes
No

Yes
Yes
Yes

Yes
Yes
No

Yes
Yes
Yes

Fabric Manager

Fabrics Yes Yes Yes Yes

Monitoring

Groups
Jobs
Switch
Performanc
e Monitors

Yes
Yes
No

Yes
Yes
No

Yes
Yes
No

Yes
Yes
Yes

Alerting Yes Yes Yes Yes
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Function Basic Edition Disk Edition Data Edition Standard Edition

Reporting

Switch
Performanc
e

No No No Yes

Tape Manager Yes Yes Yes Yes

Element Manager Yes Yes Yes Yes

Replication
Manager

Yes Yes Yes Yes

Notes:

1. You cannot run the following discovery jobs in the Basic and Disk editions: Netware Filer, Windows
Domain, NAS, SAN FS, and VMware VI Data Source.

2. You cannot associate VMware VI Data Sources or TPC Servers with Tivoli Storage Productivity Center
in the Basic and Disk editions.

3. The following nodes under Configuration are not available in the Basic and Disk editions:
License Keys
Quota and Constraint e-mail Address Rules
Scan/Probe Agent Administration
Manual NAS/Netware Server Entry
NetWare Tree Logins
Resource History Retention for Databases
Removed Resource Retention for Databases
Configuration History Settings

4. Use probes and Storage Resource agents to collect asset and capacity information about storage
entities in the Disk and Basic editions. To collect specific file level information (for example, usage
statistics), you must use the Data or Standard editions to run scans on your file systems.
Note: You cannot probe hypervisors in the Basic and Disk editions.

5. The following nodes under Alert Log are not available in the Basic and Disk editions:
Directory
User
OS User Group
Configuration Analysis (also not available in the Data edition)
Hypervisor

6. The following nodes under Data Manager > Alerting are not available in the Basic and Disk editions:
Directory Alerts
Hypervisor Alerts

Table 2. Available reports in each IBM Tivoli Storage Productivity Center license
Reports Basic Edition Disk Edition Data Edition Standard Edition

Batch Reports No Yes1, 2 Yes2 Yes

System Reports:

Data
Fabric
Disk

Yes
Yes, but not all 3

No

Yes
Yes, but not all 3

Yes

Yes
Yes, but not all 3

No

Yes
Yes
Yes
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Reports Basic Edition Disk Edition Data Edition Standard Edition

Rollup Reports  No No Yes Yes

Data Source Reports Yes Yes Yes Yes

Asset reports:

By Cluster
By Computer
By Hypervisor
By OS Type
By Storage
Subsystem
System-wide

Yes
Yes
Yes
Yes
No
Yes, but not all 4

Yes
Yes
Yes
Yes
No
Yes, but not all 4

Yes
Yes
Yes
Yes
Yes
Yes

Yes
Yes
Yes
Yes
Yes
Yes

Availability reports Yes Yes Yes Yes

TPC-wide Storage Space
reports:

Disk Space
File System Space
Consumed File
System Space
Available File
System Space

Yes
Yes
Yes
Yes

Yes
Yes
Yes
Yes

Yes
Yes
Yes
Yes

Yes
Yes
Yes
Yes

Usage reports No No Yes Yes

Usage Violation reports No No Yes Yes

Backup reports No No Yes Yes

Monitored Computer
Storage Space reports

Yes Yes Yes Yes

Storage Subsystem
reports

No Yes Yes Yes

Storage Subsystem
Performance reports

No Yes No Yes

Switch Performance
reports

No No No Yes

Tape Library report No Yes Yes Yes
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Reports Basic Edition Disk Edition Data Edition Standard Edition

Notes:

1. You must install Agent Manager and a Data agent to enable batch reports for these licenses. The Data
agent must be installed on the computer on which you want to run batch reports.

2. The following batch reports are not available in the following editions:
Basic edition: No batch reports are available
Disk edition: Rollup Reports, Usage, Usage Violations, Backup, Switch Performance
Data edition: Storage Subsystem Performance, Switch Performance

3. The following Fabric system reports are not available in the Basic, Disk, and Data editions: Top switch
Ports Data Rate Performance, Top Switch Ports Packet Rate Performance, Switch Port Errors, Switch
Performance.

4. The following Asset > System-wide reports are not available in the Basic and Disk editions:
Unmanaged Virtual Machines, Virtual Machines with no VMWare Agent, Monitored Directories,
Unmanaged Computers, Users, OS User Groups.

Parent topic: IBM System Storage Productivity Center packages
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Maintaining user IDs and passwords
Use this procedure to change the passwords for Windows® Administrator, DB2® user, DB2 services, and IBM®
Tivoli® Storage Productivity Center for Replication.

For security reasons, change the Windows Administrator password on a regular basis. Each time that you
change the Windows Administrator password you must also run the Password Tool that is located on the SSPC
desktop. When you use the Password Tool, you change the passwords for DB2 user, DB2 services, and IBM
Tivoli Storage Productivity Center for Replication. The tool then makes modifications to the IBM DB2, Tivoli
Storage Productivity Center for Replication, and IBM WebSphere® applications so that they can authenticate
properly to the Windows operating system whenever you change the Windows Administrator password.

To change the Windows Administrator, DB2 user, DB2 services, and Tivoli Storage Productivity Center for
Replication passwords, follow these steps.

Important: The password that you use for DB2 user, DB2 services and Tivoli Storage Productivity Center for
Replication must match the Windows Administrator password.

1. Logon to SSPC using the Windows Administrator user ID.
2. Change the Windows Administrator password by performing the following steps.

a. From the SSPC desktop, click Start > Control Panel.
b. From the Control Panel window, double-click User Accounts.
c. Click Change your password.
d. In the Set Password window, type the new password twice. Click Change password to change

the password. The User Accounts window is redisplayed. Close the window.
3. On the SSPC desktop, double-click the SSPC Password Tool icon to change the passwords for DB2 user,

DB2 services, and Tivoli Storage Productivity Center for Replication. The Choose the password to
change window is displayed and the Change DB2 user password for Device and Data Server option is
selected.
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Tip: If the icon for the Password Tool was deleted from the SSPC desktop, perform the following steps
to start the tool:

a. Open a command prompt window and change the directory to C:\Program
Files\IBM\TPC\data\server\tools.

b. Type changepasswords to start the Password Tool.
4. Click OK. The Change DB2 user password for Device and Data Server window is displayed.
5. Perform the following steps:

a. Type the password that is the same as the Windows Administrator password in both the Enter
password and Confirm password fields.

b. The Restart the Data and Device Server option is selected. Leave it as it is and click OK.
c. At the message Are you sure you want to change the password? click Yes. The

Changing DB2 password for user Administrator window is displayed and shows progress
messages while the password is changed. The process takes approximately 5 minutes.

d. When Complete is displayed, click Back to Main. The Choose the password to change window is
redisplayed.

6. Select Change password for the DB2 services and click OK. The Changing DB2 Services password
window is displayed.

7. Perform the following steps:
a. Type the user name of DB2 Services in the DB2 Services Username field.
b. Type the password that is the same as the Windows Administrator password in both the Enter

password and Confirm password fields.
c. Click OK.
d. At the message Are you sure you want to change the password? click Yes. The

Changing DB2 Services password window is displayed and shows progress messages while the
password is changed.

e. When Complete is displayed, click Back to Main. The Choose the password to change window is
redisplayed.

8. Select Change TPC-R password to change the password for Tivoli Storage Productivity Center for
Replication, and click OK. The Change TPC-R password window is displayed.

9. Perform the following steps:
a. Type the password that is the same as the Windows Administrator password in both the Enter

password and Confirm password fields.
b. Click OK.
c. At the message Are you sure you want to change the password? click Yes. The

Changing TPC-R password window is displayed and shows progress messages while the
password is changed.

d. When Complete is displayed, click Back to Main. The Choose the password to change window is
redisplayed.

Note: To verify the password change has completed successfully check the log located in c:\Program
Files\IBM\TPC\Data\log\PWTool.log.

10. Click Exit program to exit the Password Tool.
11. Press any key to continue, and close the command prompt window. This completes the password

change.
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Identifying responsibilities for maintaining, upgrading, and
configuring the SSPC server

Use this information to learn about what responsibilities you have for maintaining, upgrading, and configuring
the SSPC server.

SSPC 2805-MC4 is an offering that comprises an IBM maintained server and customer maintained software.

It is the customer's responsibility for maintaining, upgrading, and configuring the applications that are
installed on the SSPC server. This includes any release level updates and associated fix packs to the
preinstalled software, which includes but is not limited to:

Microsoft Windows operating system (support is provided by Microsoft)
IBM DB2 Enterprise Server Edition 9.5 with Fix Pack 3
IBM® Tivoli® Storage Productivity Center software
IBM System Storage™ SAN Volume Controller software
IBM Tivoli Storage Productivity Center for Replication software
IBM System Storage DS3000, DS4000®, or DS5000 software
IBM DS CIM agent management commands (DSCIMCLI)
Any other applications such as antivirus software (support is provided by your antivirus software
vendor)

Important: As a best practice, install antivirus software on the SSPC server but not other software (except for
the upgrades to the software listed in this topic). While antivirus applications can offer protection to servers
that might be in an unprotected environment, installing other software can cause port conflicts or
performance issues. Other precautions that you can take to protect the SSPC server include enabling security
updates to the operating system and establishing a backup procedure for the SSPC.

It is also the customer's responsibility to back up and recover the SSPC system.

You, as the customer, are required to provide the IBM service representatives with the information on the
work sheets so they can set up the SSPC server. See Planning work sheet.

IBM is responsible for:

SSPC 2805-MC4 hardware support and repair as covered under warranty or authorized service
agreement.
IBM software support as covered under warranty or authorized service agreement.

Parent topic: Overview
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IBM System Storage Productivity Center desktop
The IBM® System Storage™ Productivity Center desktop displays the icons you can use to open the user
interfaces for the different products.

On your desktop, you see the icons for the following user interfaces:
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Productivity Center (this includes the DS8000 element managers)
IBM Tivoli® Storage Productivity Center for Replication
SAN Volume Controller
Launch DSCIMCLI Command Window
TIP console
SSPC Password Tool (to change the DB2 user, WebSphere service, and DB2 services password)

You also see icons for the following:

SSPC Support Links which provides direct links to product support Web sites
IBM Help for SSPC which provides online help for SSPC

Parent topic: Overview
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Hardware components
The SSPC consists of an IBM® System x® server running the Microsoft® Windows® Server 2008 Enterprise
Edition operating system. This topic describes the standard SSPC server configuration.

The SSPC 2805-MC4 server is a rack-model server with the following characteristics:

One Intel® Xeon® quad-core processor, with a speed of 2.4 GHz, a cache of 8 MB, and power
consumption of 80 W
8 GB of RAM (eight 1-inch dual in-line memory modules of double-data-rate three memory, with a data
rate of 1333 MHz)
Two 146 GB hard disk drives, each with a speed of 15 K
One Broadcom 6708 Ethernet card
One CD/DVD bay with read and write-read capability

Optionally, you can add a keyboard, video, and mouse (KVM) unit, or a redundant power supply.

The SSPC 2805-MC4 server supports six 2.5-inch hot-swap Serial Attached SCSI (SAS) hard disk drives.

Note: You can create a server that is equivalent to the SSPC by installing the SSPC software on any supported
server. However, the hardware support included with the SSPC is available only if the software is installed on a
2805-MC4 server. For more information, see .

For additional information, see the IBM System x3550 M2 Type 7946 Installation and User's Guide. This
publication is available on the IBM System Storage Productivity Center Documentation CD, which comes with
the SSPC server.

Parent topic: Overview
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Planning
This section includes topics that provide information about how to plan for the IBM® System Storage™
Productivity Center.

Planning work sheet
As the customer, you are required to provide the IBM service representatives with information about
these work sheets so they can set up the SSPC server. If you do not provide this information, it will
delay the time it takes to set up the SSPC server.
Maintenance responsibilities
Responsibility for updating and maintaining hardware and software for the SSPC, as well as other tasks,
is divided between you and your IBM service representative.
Planning for hardware installation
The SSPC server is installed by an IBM service representative. Before the IBM service representative
can set up your IBM System Storage Productivity Center hardware, you must verify that the
prerequisite conditions for installation are met.
Planning
This section provides planning information for the IBM System Storage Productivity Center.

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
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Planning work sheet
As the customer, you are required to provide the IBM® service representatives with information about these
work sheets so they can set up the SSPC server. If you do not provide this information, it will delay the time it
takes to set up the SSPC server.

System Storage Productivity Center server information

As part of the SSPC planning, select the rack position. The position in the rack is identified by an Electrical
Industries Association (EIA) number. The SSPC has a height of one EIA, referred to as 1U. Select a location in
the rack that allows enough space for hardware components that might be installed at a future date.

A keyboard and mouse with Universal Serial Bus (USB) connectors are required for the initial setup of the
SSPC. A video display is also required. You can install an optional keyboard video mouse (KVM) unit by
ordering Feature Code 9100. If you install it as part of this service action, record the rack location of the KVM
unit in Table 1.
Tip: As a best practice, install the KVM unit directly above or below the System Storage™ Productivity Center
server so that the connecting cables of the device can reach the server. Feature code 9100 comes with
installation instructions. If you ordered this feature code, follow the instructions but do not remove and
discard the rubber pads under the keyboard. Peel off the protective strip on the console to expose the
adhesive surface and place the keyboard into the tray. Press the keyboard firmly so that it adheres to the tray.
You can discard the switch mounting brackets that come with feature code 9100.

Table 1. EIA location of the System Storage Productivity Center server and the keyboard
video mouse unit

System Storage Productivity
Center hardware location

EIA number: __________
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within the rack

Keyboard video mouse unit
location within the rack (this
may be installed already and
is optional)

EIA number: __________

Windows Server 2008 Enterprise Edition Product Key and computer name

During the initial Windows® configuration process, you are prompted to enter the 25-digit Windows product
key. The key is printed on a sticker labeled "Proof of License Certificate of Authority" and is located on the
outside top cover of the System Storage Productivity Center server. Record this key now because the sticker
might be obscured when you place the System Storage Productivity Center server in the hardware rack.

Windows product key: 
__ __ __ __ __ - __ __ __ __ __ - __ __ __ __ __ - __ __ __ __ __ - __ __ __ __ __

Table 2. Computer name
Field Entry Notes

System Storage
Productivity
Center

Computer name: 
___________________

Specify the System Storage Productivity
Center computer name, list it here so that the
IBM service representative can set it during
the installation.

Table 3. Customer Passwords
Field Entry Notes

Windows
Administrator
Password

Administrator Password: 
___________________

List the password that the IBM service
representative will set the Administrator ID to
during the initial logon to the System Storage
Productivity Center. 

This password can be changed after the
system has been installed. 

The password must conform to the following
rules: 8 characters, one number, one
uppercase character.

Host
authentication
password

Host authentication 
password:
___________________

List the password that is used by the Tivoli®
Storage Productivity Center when
communicating with the Fabric agents. This
password can be different than the Windows
administrator password.

This password can be changed after the
system has been installed.

The password must conform to the following
rules: 8 characters, one number, one
uppercase character.

System Storage Productivity Center physical location
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In Table 4, record the IP addresses and host name for the SSPC.

Table 4. IP addresses and host name
Field IP address or host name Notes

SSPC IP address IP address: ___________________ This value is the address for the System
Storage Productivity Center server.

SSPC Subnet Mask IP address: ___________________ This value hides the IP address. Obtain
this value by typing ipconfig in a
command prompt window on any
computer on the network or by asking
the network administrator.

SSPC Default gateway IP address: ___________________ This value is the router that allows
access from one network to another
network. Obtain this value by typing
ipconfig in a command prompt window
on any computer on the network or by
asking the network administrator.

SSPC Preferred DNS
address

DNS address: ___________________ This value is the address for the domain
name server for your site. Obtain this
value by typing ipconfig in a command
prompt window on any computer on the
network or by asking the network
administrator.

SSPC Alternate DNS
address

DNS address: ___________________ This value is the alternate address for the
domain name server for your site. Obtain
this value by typing ipconfig in a
command prompt window on any
computer on the network or by asking
the network administrator.

DNS suffix DNS suffix: _____________________ This value is the part of a fully qualified
domain name that represents a grouping
of host names. For example, in the fully
qualified domain name of sspc.ibm.com,
the DNS suffix is ibm.com. Obtain this
value from the network administrator.

Device information

Use the following tables to record information about your storage system.

Table 5. Device information for DS8000
Device
type

Default
ports User ID, password, and host name

IP address of
storage system

DS8000®
element
manager

8451
(http)
8452
(https)

Default user ID: admin IP address HMC:
__________ 
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Device
type

Default
ports User ID, password, and host name

IP address of
storage system

Default password:
admin 
You must change the default password when you log on.
Changing the default password automatically changes the
DS8000 CIM agent password to match it.

Host name:
__________

Note: Do not use special characters such as # or & in the host
name. This causes the host name to be truncated.

DS8000
CIM agent

For
embedde
d CIM
agent:

Default user ID:
admin

For embedded
CIM agent:

6989
(https)

The default password automatically changes to match the
DS8000 element manager password.

IP address of
HMC:
__________

For proxy
CIM
agent:

Host name:
__________

For proxy CIM
agent:

5988
(http) 
5989
(https)

  IP address of
proxy CIM agent:
__________

Table 6. Device information for SAN Volume Controller

Device type Default ports
User ID, password, and
host name

IP address of storage
system

SAN Volume Controller
CIM agent

For embedded CIM
agent:

5989 (https)

Default user ID: 
superuser

IP address:
______________

Default password:
passw0rd

Host name: 
__________

Parent topic: Getting started
Parent topic: Planning
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Maintenance responsibilities
Responsibility for updating and maintaining hardware and software for the SSPC, as well as other tasks, is
divided between you and your IBM® service representative.
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You are responsible for maintaining and upgrading the following applications on the SSPC server:
Microsoft® Windows® operating system
IBM DB2® Enterprise Server Edition 9.5, Fix Pack 3
IBM Tivoli® Storage Productivity Center
IBM System Storage™ SAN Volume Controller
IBM Tivoli Storage Productivity Center for Replication (if installed)
Agent Manager and agents (if installed)
DS CIM agent management commands (DSCIMCLI) utility (if applicable)
DS3000, DS4000®, and DS5000 (if applicable)
Any other applications, such as antivirus software

You are responsible for backing up and recovering the SSPC system. For information,
The IBM service representative is responsible for the following tasks:

Installing the initial SSPC hardware
Upgrading the SSPC hardware
Installing ordered feature codes and Miscellaneous Equipment Specification (MES)

Parent topic: Planning
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Planning for hardware installation
The SSPC server is installed by an IBM® service representative. Before the IBM service representative can set
up your IBM System Storage™ Productivity Center hardware, you must verify that the prerequisite conditions
for installation are met.

1. Verify that the IBM service representative has checked Authorized Problem Analysis Reports (APARs)
and Flashes on the SSPC Support Web page for information about changes to documentation and
known product issues. Access the SSPC Support Web site at
http://www.ibm.com/systems/support/storage/software/sspc and click Flashes.

2. Ensure that your physical site meets the environmental requirements for the SSPC. See Features and
specifications for more information.

3. Verify that you have adequate rack space for the hardware. The SSPC server requires at least 1
Electrical Industries Association (EIA) unit (1 U) of available rack space.
Note: Select a rack location that allows for future expansion of existing hardware components.

4. Fill out Planning work sheet. Complete this work sheet before the IBM service representative arrives to
install the hardware. The IBM service representative needs the information in this work sheet to
perform the installation procedure.

5. If you plan to use the SSPC to manage previously installed IBM System Storage DS8000® devices,
verify that the CIM Object Manager (CIMOM) located on each DS8000 Hardware Management Console
(HMC) is turned on. For instructions, refer to the documentation that comes with your IBM System
Storage DS8000.

6. If a previously installed DS8000 device is using the DS8000 Release 2 HMC, upgrade HMC to Release 3
or later.

7. If you plan to use the SSPC to manage SAN Volume Controller nodes, ensure that the SSPC server is
near the SAN Volume Controller nodes. The SSPC server must be located no more than 50 feet away
from the SAN Volume Controller nodes.

8. SSPC requires a USB keyboard and mouse, and a video display. You may provide these, or you can
order the keyboard, video, and mouse (KVM) package along with SSPC.
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During the hardware installation process, an IBM service representative will perform the following tasks:

1. Unpack and rack mount the SSPC server.
2. Start the SSPC server.
3. Configure the SSPC server's IP address.
4. Connect the SSPC server to your network.
5. Verify that the SSPC server can contact the DS3000, DS4000®, DS5000, DS8000, and SAN Volume

Controller devices.

Hardware installation instructions are provided for the IBM service representative in Read This First: Installing
the IBM System Storage Productivity Center, which comes with the server.

Features and specifications
Before an IBM service representative can install the IBM System Storage Productivity Center (SSPC),
you must prepare the physical environment. This includes verifying that there is adequate space
available, and that requirements for power and environmental conditions are met.
Configuration information and capacity limits for the SSPC server
Capacity limits for CIM agents
Optional ordered equipment
Additional feature codes are ordered to augment the functionality of the IBM System Storage
Productivity Center. The following is a list of supported feature codes.
Supported hardware
The following table shows IBM System Storage Productivity Center software support for each
supported hardware system.

Parent topic: Planning
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Features and specifications
Before an IBM® service representative can install the IBM System Storage™ Productivity Center (SSPC), you
must prepare the physical environment. This includes verifying that there is adequate space available, and
that requirements for power and environmental conditions are met.

Table 1 describes the physical characteristics and environmental requirements for the SSPC 2805-MC4
server.

Table 1. Features and specifications for the IBM System Storage Productivity Center 2805-
MC4 server

Processor:

Supports up to two Intel® Xeon® processors
(one that is preinstalled)
Type: Quad-core (four cores per
microprocessor, with 8 MB shared among
cores)
Speed: 2.4 GHz
Cache: 8 MB
Power consumption: 80W (see Note 1)

Integrated functions:

Broadcom 6708 Ethernet card

Acoustical noise emissions: (See Note 2)

Sound power, idling: 6.1 bels maximum
Sound power, operating: 6.1 bels maximum

Environment:
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Memory:

Minimum: 1 GB
Maximum: 8 GB
Type: Eight 1-inch dual inline memory
modules (DIMMs) of double-data-rate three
(DDR3) memory
Data rate: 1333 MHz

Hard disk drives:

Two 146 GB hard disk drives, each with a
speed of 15 K
Six 2.5-inch expansion bays for hot-swap,
Serial Attached SCSI (SAS) hard disk drives

Bay for CD or DVD:

One read or write-read bay for CD or DVD

Power supply:

One standard power supply
For redundancy support, a maximum of two
675-watt ac (110 or 220 V ac auto-sensing)
hot-swap power supplies

Hot-swap fans:

Six dual-motor hot-swap fans

Size:

Height: 43 mm (1.69 in., 1U)
Depth: 711 mm (28 in.)
Width: 440 mm (17.3 in.)
Maximum weight: 15.4 kg (34 lb) when fully
configured

Air temperature:
Server on: 10°C to 35°C (50.0°F to
95.0°F); altitude: 0 to 
914 m (2998.7 ft)
Server off: -40°C to 60°C (-104°F to
140°F); maximum altitude: 2133 m
(6998.0 ft)

Humidity:
Server on: 8% to 80%
Server off: 8% to 80%

Heat output: (see Note 1)

Approximate heat output:

Minimum configuration: 662 Btu per hour
(194 watts)
Maximum configuration: 2302 Btu per hour
(675 watts)

Electrical input:

Sine-wave input (47 to 63 Hz) required
Input voltage, low range:

Minimum: 100 V ac
Maximum: 127 V ac

Input voltage, high range:
Minimum: 200 V ac
Maximum: 240 V ac

Input kilovolt-amperes (kVA), approximately:
Minimum: 0.194 kVA
Maximum: 0.700 kVA

Notes:

1. Power consumption and heat output vary depending on the number and type of optional features
installed and the power-management optional features in use.

2. The sound levels were measured in controlled acoustical environments according to the procedures
specified by the American National Standards Institute (ANSI) S12.10 and ISO 7779 and are reported
in accordance with ISO 9296. Actual sound-pressure levels in a given location might exceed the
average values stated because of room reflections and other nearby noise sources. The noise
emission level is stated in the declared (upper limit) sound-power level, in bels, for a random sample
of system.

Parent topic: Planning for hardware installation
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This information center is powered by Eclipse technology. (http://www.eclipse.org)

Configuration information and capacity limits for the SSPC
server

Table 1 gives the capacity limits for the SSPC 2805-MC4. Design your SSPC servers so that none of the limits
in Table 1 is exceeded.

For information about capacity limits for proxy CIM agents, see Table 1.

Table 1. Configuration information and capacity limits for SSPC 2805-MC4
Characteristic Value

Configuration Up to two Intel® Xeon™ processors (one is preinstalled). The
two servers must be of the same speed (for example, two 2.4
GHz processors).
Type: Quad-core (four cores per microprocessor, with 8 MB
shared among cores)
Speed: 2.4 GHz
Power consumption: 80 W
Type: Eight 1-inch dual inline memory modules (DIMMs) of
double-data-rate three (DDR3) memory
Data rate: 1333 MHz
Hard disk drives: Two 146 GB hard disk drives, each with a
speed of 15 K
Ethernet card: Broadcom 6708
Six 2.5-inch hot-swap Serial Attached SCSI (SAS) hard disk
drive expansion bays
One read or write-read bay for CD or DVD
Optional secondary power supply

Maximum volumes 30000

Maximum subsystems 100

Maximum switches 100

Maximum switch ports 2500

Maximum copyset pairs (for Tivoli®
Storage Productivity Center for
Replication)

10000

Maximum data agents 1500

Parent topic: Planning for hardware installation
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Capacity limits for CIM agents
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Beginning with Release 4.1, the DS8000® CIM agent is embedded in the DS8000 server and is not required to
be on the SSPC server. Also, for SAN Volume Controller 4.3.1 and later, the CIM agent is embedded in the SAN
Volume Controller server.

Other supported storage devices use proxy CIM agents. A proxy CIM agent is not embedded in the device
hardware, but instead is located on another server. Table 1 gives the capacity limits for proxy CIM agents for
other supported devices.

Table 1. Capacity limits for proxy CIM agents
Storage Volumes Storage systems Agent server requirements

DS6000™ series and ESS 10000 10 Intel®, dual processor 3.2 GHz, 4 GB
RAM
System p®, dual p5, 4 GB RAM

DS3000, DS4000®, and
DS5000 series

512 10 Intel, dual processor 3.2 GHz, 4 GB
RAM
System p, dual p5, 4 GB RAM

Parent topic: Planning for hardware installation

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Optional ordered equipment
Additional feature codes are ordered to augment the functionality of the IBM® System Storage™ Productivity
Center. The following is a list of supported feature codes.

FC 9100 - Keyboard, Video, Mouse (KVM) Unit
Ordering this feature code provides the hardware to install a keyboard, video, mouse (KVM) unit.

FC 1810 - IBM System Storage Productivity Center Redundant Power Supply
Ordering this feature code provides the hardware to install a second power supply. When ordering this
feature code, specify whether it applies to SSPC 2805-MC2, 2805-MC3, or 2805-MC4.

FC 1170 - Wall Line Cable
Ordering this feature code provides the hardware to replace the single wall line cord with the Y-cord for
dual power supplies.

Parent topic: Planning for hardware installation
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Supported hardware
The following table shows IBM® System Storage™ Productivity Center software support for each supported
hardware system.
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Table 1. System Storage Productivity Center supported hardware
Supported Hardware

(see Note)
Supported Software

IBM Tivoli® Storage
Productivity Center

IBM Tivoli
Storage

Productivity
Center for

Replication

IBM
System
Storage

SAN
Volume

Controller DSCIMCLI

IBM DS
Storage
Manager

DS3000 X       X

DS4000® X       X

DS5000 X       X

DS6000™ X X   X  

DS8000® X X   X  

SAN Volume Controller X X X    

ESS Model 800 X X   X  

TS3310 Tape Library X        

TS3500 Tape Library X        

Note: SSPC might also support other hardware because that hardware is supported by Tivoli Storage
Productivity Center. For a complete list of supported devices, see
http://www.ibm.com/software/sysmgmt/products/support/IBMTotalStorageProductivityCenterStand
ardEdition.html and click Plan > [View all Plan documents].

Parent topic: Planning for hardware installation
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Planning
This section provides planning information for the IBM® System Storage™ Productivity Center.

The preinstalled System Storage Productivity Center software includes the following:

English version of Microsoft® Windows® Server 2008 32-bit Enterprise Edition
IBM DB2® Enterprise Server V9.5 with Fix Pack 3
IBM Tivoli® Storage Productivity Center 4.1.1
IBM Tivoli Storage Productivity Center for Replication 4.1.1
IBM SAN Volume Controller console version 5.1.0 and CIM agent version 4.3.1
IBM DS CIM agent management commands (DSCIMCLI) version 5.4.3

Planning for software configuration
You are responsible for configuring and maintaining the software that is preinstalled on the IBM System
Storage Productivity Center server.
Licensing
License entitlement for preinstalled and optional software must be purchased separately from the IBM
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System Storage Productivity Center server. The IBM System Storage DS8000® is also separately
licensed. Ensure that the necessary licenses have been purchased before the IBM service
representative arrives to install the System Storage Productivity Center server.
Web browsers
Internet Explorer 7 is the default browser for SSPC.
User IDs, passwords, and user roles
Use this information to know what user IDs and passwords are assigned to your SSPC system, and how
to assign user roles in IBM System Storage Productivity Center.
Evaluating the Tivoli Storage Productivity Center for Replication (try and buy) product
You can evaluate IBM Tivoli Storage Productivity Center for Replication in your environment for no
charge.
For the customer: activating the Microsoft Windows license
Getting security updates to the Windows operating system
This section describes how to obtain security updates for the 32-bit Windows operating system.
Subscribing to technical support Web sites
It is a good practice to subscribe to the IBM technical support Web sites to receive information about
important technical notes, flashes, and APAR information.
Initial tasks for installing and configuring SSPC
The information in this section describes the tasks that are required to install and configure IBM
System Storage Productivity Center and indicates whether they are performed by the customer or the
IBM service representative.

Parent topic: Planning
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Planning for software configuration
You are responsible for configuring and maintaining the software that is preinstalled on the IBM® System
Storage™ Productivity Center server.

An IBM service representative will install the System Storage Productivity Center hardware and set the IP
address for the System Storage Productivity Center server. After the SSPC is installed and before you can use
it, you must configure the SSPC to each device that you want it to monitor (for example, the IBM System
Storage DS8000® or the IBM System Storage SAN Volume Controller).
Note: License entitlement for preinstalled and optional software is purchased separately from System Storage
Productivity Center. See Licensing for more information.
System Storage Productivity Center software configuration consists of the following tasks:

1. Check the following Web site for any updates to the preinstalled software:
http://www.ibm.com/systems/support/storage/software/sspc.

2. Configure the IBM Tivoli® Storage Productivity Center to manage your DS8000, DS5000, DS4000®, and
DS3000 systems.

3. If you plan to use the System Storage Productivity Center to manage SAN Volume Controller clusters,
configure the SAN Volume Controller Console and command-line interface.

4. Install and configure optional software.
Important: As a best practice, install antivirus software on the SSPC server but no other software
(except for the upgrades to the programs listed in Licensing). While antivirus applications can offer
protection to servers that might be in an unprotected environment, installing other software can cause
port conflicts or performance issues. Other precautions that you can take to protect the SSPC server
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include enabling security updates to the operating system and establishing a backup procedure for the
SSPC.

You can configure the DS CIM agent that is embedded in the DS8000 server with the DS CIM
agent management command package (DSCIMCLI) that is preinstalled on SSPC. For information
about configuring the CIM agent management commands and how to use the commands, see
the IBM System Storage DS Open Application Programming Interface Reference at the following
Web site:
http://www.ibm.com/servers/storage/support/software/cimdsoapi/
System Storage Productivity Center can act as a server to distribute the GUI code for DS3000,
DS4000, and DS5000 Storage Manager, as needed. Ensure that the version of GUI code that the
System Storage Productivity Center will distribute will work with the DS3000, DS4000, and
DS5000 server, as applicable.
Install the licenses for the IBM Tivoli Storage Productivity Center for Replication on the System
Storage Productivity Center server to manage IBM FlashCopy®, Metro Mirror and Global Mirror
functions.

Parent topic: Planning

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Licensing
License entitlement for preinstalled and optional software must be purchased separately from the IBM®
System Storage™ Productivity Center server. The IBM System Storage DS8000® is also separately licensed.
Ensure that the necessary licenses have been purchased before the IBM service representative arrives to
install the System Storage Productivity Center server.

Preinstalled software

The following software is preinstalled on the System Storage Productivity Center server:

Microsoft® Windows® Server 2008 Enterprise Edition
IBM Tivoli® Storage Productivity Center 4.1.1 Basic Edition
IBM Tivoli Storage Productivity Center for Replication 4.1.1
IBM DB2® Enterprise Server Edition 9.5 with Fix Pack 3
IBM System Storage SAN Volume Controller Console version 5.1.0
PuTTY

Important: As a best practice, install antivirus software on the SSPC server but no other software (except for
the upgrades to the programs listed in this topic). While antivirus applications can offer protection to servers
that might be in an unprotected environment, installing other software can cause port conflicts or
performance issues. Other precautions that you can take to protect the SSPC server include enabling security
updates to the operating system and establishing a backup procedure for the SSPC.

The Basic Edition of Tivoli Storage Productivity Center can be upgraded to the Standard Edition, which
includes additional data analysis and performance reporting features. For information about upgrading to
these packages,

The IBM Tivoli Storage Productivity Center Basic Edition software is licensed per System Storage Productivity
Center server, regardless of the number of processors or amount of data managed. Licensing includes the first
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year of software support. After the first year, support is provided on a subscription basis.

Tivoli Storage Productivity Center for Replication is installed with local OS authentication. This program is
non-licensed. You are required to purchase and install the 2-site or 3-site license to use the functions of Tivoli
Storage Productivity Center for Replication.

Licensing for the IBM DB2 Enterprise Server is included in the Tivoli Storage Productivity Center Basic Edition
license agreement.

Parent topic: Planning
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Web browsers
Internet Explorer 7 is the default browser for SSPC.

The following browsers are supported by IBM® Tivoli® Storage Productivity Center:

Windows:
Internet Explorer 7
Firefox 1.5
Firefox 2.0
Firefox 3.0

AIX:
Firefox 2.0

Linux:
Firefox 2.0

You must configure Internet Explorer 7 to always allow pop-up windows for SAN Volume Controller. Click
Tools > Pop-up Blocker > Turn Off Pop-up Blocker. Additionally, if you receive a message that content was
blocked because it was not signed by a valid security certificate, click the Information Bar at the top of the
window and select Show blocked content. For more information about these requirements, see http://www-
1.ibm.com/support/docview.wss?
rs=591&context=STPVGU&context=STPVFV&q1=master+console&uid=ssg1S1003315&loc=en_US&cs=utf-
8&lang=en.

Tips:

If you plan to access SSPC using a Web browser other than the one that is preinstalled on the system,
use the configuration instructions for that browser to ensure that new pop-up windows can
automatically open when you visit a Web site. Also, uninstall or turn off any applications that block or
suppress pop-up windows.
If you launch the DS8000® user interface, SAN Volume Controller console, IBM Tivoli Storage
Productivity Center for Replication, DS3000, DS4000®, or DS5000 through a URL or host name, you
must add the URL to the trusted zone in the browser.

Microsoft Phishing Filter
If you are using Internet Explorer and see a window with the title "Microsoft Phishing Filter", this is a
Microsoft window to warn you if the Web site you are visiting might be impersonating another Web site.
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Microsoft Phishing Filter
If you are using Internet Explorer and see a window with the title "Microsoft Phishing Filter", this is a Microsoft
window to warn you if the Web site you are visiting might be impersonating another Web site.

You can turn the Phishing Filter on or off automatically. Click What is Phishing Filter on the window to find
out more information about the filter. It is suggested that you turn the phishing filter off. Click OK.
Parent topic: Web browsers
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User IDs, passwords, and user roles
Use this information to know what user IDs and passwords are assigned to your SSPC system, and how to
assign user roles in IBM® System Storage™ Productivity Center.

Default user IDs and passwords

When you receive your SSPC system, there are default user IDs and passwords assigned.

See Table 1 for the SSPC user IDs and passwords.
Table 1. Default user IDs and passwords for SSPC

Component
Default user
ID Default password Description

Windows Administrato
r

None, you must set it
the first time you log
into SSPC

This user ID is part of the Windows
Administrators group. Use this user ID to log into
System Storage Productivity Center.

To set this password, see For the IBM service
representative: configuring the operating system.

IBM System
Storage SAN
Volume
Controller

superuser When you change
password on SAN
Volume Controller

SAN Volume Controller CIM agent and GUI

User IDs and passwords for DS8000

For DS8000® release 4.0 and earlier, the CIM agent administrator and storage administrator are required to
create and maintain user passwords for both the CIM agent and the DS8000 management applications.
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For DS8000 release 4.1 and later, the embedded CIM agent does not require configuration changes to
manage DS8000 devices. Instead, the DS8000 device user names and passwords are used to authenticate
CIM client requests. The DS8000 administrator must create user names and passwords that CIM clients can
use to attach to the CIM agent. Each user that is created must be in the administrator group. Users that are
created in any group other than the administrator group, cannot function with DS8000 release 4.1 and 4.2
CIM agents. The DS8000 administrator can use the DSCLI or the HMC console GUI to create the user names
and passwords.

If you log in to the DS8000 Element Manager for the first time using the administrator user ID, you are
required to change the password.

You need one user ID and password to set up the Element Manager. The user ID and password for the
Element Manager is stored in the Tivoli® Storage Productivity Center database. After the user ID and password
are stored, when you log into the Element Manager within Tivoli Storage Productivity Center, that stored user
ID and the privileges associated with it is used.

Note: If you upgrade a DS8000 previous to release 4.1 to release 4.1 or later (with the embedded CIM agent),
you must do one of the following to attach the CIM agent:

Change all the Tivoli Storage Productivity Center user IDs and passwords
Recreate all administrative user accounts.

For information on setting up LDAP and single sign-on in Tivoli Storage Productivity Center, see Configuring
Tivoli Storage Productivity Center for DS8000 LDAP support and Single sign-on.

User roles for Tivoli Storage Productivity Center

In a production environment, SSPC is typically the control point of the storage systems that store large
amounts of data. The security of the SSPC server is very important. Tivoli Storage Productivity Center
supports application-level security using role-based authorization. With Tivoli Storage Productivity Center,
you can assign different users with different roles and segregate duties among users.

You should ensure that in a multiple-user environment, all users accessing Tivoli Storage Productivity Center
also have the authority to manage other aspects of the storage environment.

The procedure to add users to SSPC requires Tivoli Storage Productivity Center administrator authority and
can be done as two tasks:

Set up the user ID at the operating system level and then add this user ID to a group.
Set up Tivoli Storage Productivity Center to map the operating system group to a Tivoli Storage
Productivity Center role.

You can use many types of user roles. The commonly used roles for a user of SSPC are the disk administrator
and disk operator.

For more information on how to add a user role to Tivoli Storage Productivity Center, see Adding user IDs to
SSPC.

Parent topic: Planning
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Evaluating the Tivoli Storage Productivity Center for
Replication (try and buy) product

You can evaluate IBM® Tivoli® Storage Productivity Center for Replication in your environment for no charge.

Overview

A 60-day trial version (try and buy) copy of Tivoli Storage Productivity Center for Replication Two Site BC
provides the same functions as the licensed product. The trial version is available if you have System Storage™
Productivity Center and Tivoli Storage Productivity Center for Replication preinstalled in your environment.
The trial version licensing package is limited to ten customers at one time.

To obtain the license key information, contact your IBM Business Partner or authorized IBM sales
representative. After obtaining the license key, perform the following steps:

1. From the My Work pane, select Administration.
2. Type the update key, and select Update.

After 60 days, you must order the licensed product to use IBM Tivoli Storage Productivity Center for
Replication.

Upgrading from the try and buy product

You can upgrade from a try and buy version of Tivoli Storage Productivity Center for Replication to the licensed
product by contacting your IBM Business Partner or authorized IBM sales representative.

Parent topic: Planning

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

For the customer: activating the Microsoft® Windows license
If you did not check the Automatically activate Windows when I am online option during the IBM® System
Storage™ Productivity Center installation or you do not have SSPC Internet connectivity, you must activate the
license for Windows® using these steps. If you did enable the Automatically activate Windows when I am
online option, you can skip this step.
Important: From the first time you start the SSPC server, you have 60 days to activate the Windows license
and complete the Windows setup. If you exceed the 60-day time limit, you cannot use Windows until you
activate the license.

1.  Click Start and right-click Computer, and select Properties.
2.  In the Windows activation section, click Activate Windows now and follow the instructions to

activate Windows using the phone.

Parent topic: Planning

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
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This information center is powered by Eclipse technology. (http://www.eclipse.org)

Getting security updates to the Windows operating system
This section describes how to obtain security updates for the 32-bit Windows® operating system.

The procedure for getting security updates to the Windows operating system varies, depending on whether
your SSPC is connected to the Internet. The sections that follow describe each method. SSPC uses the
Windows Server 2008 Enterprise Edition 32-bit operating system. Do not obtain security updates for a 64-bit
operating system. Updates prior to February 2009 are installed on SSPC.
Parent topic: Planning

Getting security updates through the Internet

To obtain security updates to the Windows operating system if your SSPC is connected to the Internet, use the
following steps:

1. From you SSPC desktop, click Start > Windows Update. The Windows Update window displays.
2. If prompted, follow the instructions to install ActiveX Control.
3. Click Express. The Express results window displays.
4. Click Install Updates. The Installing updates window displays while the updates are downloaded.
5. After the updates are installed, perform one of the following steps:

a. Click Restart to reboot the system. You will be asked to change your password.
b. Click Cancel to return to the SSPC desktop.

Getting security updates outside of the Internet

To obtain security updates to the Windows operating system if your SSPC is not connected to the Internet, use
the following steps:

1. From a laptop or personal computer that is connected to the Internet, go to
http://catalog.update.microsoft.com/v7/site/Install.aspx.

2. If prompted, follow the instructions to install ActiveX Control. Access the Windows Update Catalog.
3. Search for updates in the Windows Update Catalog by performing the following steps:

a. In the Search box, enter Windows server 2008 security and click Search.
b. View the list that displays to find the updates that you want to download. Disregard updates for

x64-bit and Itanium-based systems.
c. Select an update and click Add to add it to the download basket.
d. Repeat these steps to search for additional updates to download.

4. Download the updates that you selected by performing the following steps:
a. From the Search box, click view basket to view the contents of your download basket.
b. Verify your list of updates and click Download. If you are prompted, click Accept to accept the

license agreement.
c. Select the location where you want to save the updates. Enter the full path of the folder or click

Browse to locate the folder.
d. Click Continue to start the download.
e. When the download is complete, click Close to close the Download Window.
f. Close the Windows Update Catalog Window.
g. Go to the location that you specified in step 4.c.
h. To transfer the files from your PC to the server, use a USB key of 512 MB or greater, or use a CD-

R or CD-RW.
i. Double-click each update and follow the instructions to install it.
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Subscribing to technical support Web sites
It is a good practice to subscribe to the IBM technical support Web sites to receive information about
important technical notes, flashes, and APAR information.

For more information about the IBM® System Storage™ Productivity Center technical support Web site, see
http://www.ibm.com/systems/support/storage/software/sspc.

For more information about the IBM Tivoli® Storage Productivity Center technical support Web site, see
http://www.ibm.com/systems/support/storage/software/tpc/.

To receive future support notifications, go to the right and from the Stay informed pane, click Subscribe. You
will be required to enter your IBM ID and password. Once authenticated, you will see a Subscriptions page
which provides information about the following:

How to create and organize subscriptions
How you are notified about subscriptions
How to specify the frequency of email notifications
How to subscribe for specific topics per product
How to unsubscribe

Parent topic: Planning
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Initial tasks for installing and configuring SSPC
The information in this section describes the tasks that are required to install and configure IBM® System
Storage™ Productivity Center and indicates whether they are performed by the customer or the IBM service
representative.

Figure 1 illustrates the steps that the IBM service representative and you must perform to install and
configure the IBM System Storage Productivity Center.

Figure 1. Overview of installing and configuring the System Storage Productivity Center
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Use Table 1 to help you complete the steps that you need to set up and configure SSPC.
Table 1. Initial tasks to complete for configuring SSPC

Task Responsibility Description Completed?
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Task Responsibility Description Completed?

Install storage
system hardware:
DS8000®, SAN
Volume Controller

IBM service
representative

Install the hardware. You can also install
supported tape devices.

You do not have to have all the storage devices
installed before configuring SSPC. You can
install devices at a later time.

 

Install non-IBM
supported storage
systems or devices

User If you install non-IBM supported storage
systems or devices, contact your vendor for
information about CIM agents.

 

Install storage
system hardware:
DS3000, DS4000®,
and DS5000

User Install the hardware. You do not have to have
all the storage devices installed before
configuring SSPC. You can install devices at a
later time.

 

Start CIM agents for
DS8000

IBM service
representative

Start the CIM agent for DS8000. The CIM
agent for DS8000 release 2 or later is
preinstalled on the HMC. The IBM service
representative is responsible for starting the
CIM agent for R2, R3, and R4. The CIM agent is
automatically enabled for R4.1.

 

Add SAN Volume
Controller clusters to
the SAN Volume
Controller GUI

User Start the SAN Volume Controller GUI from the
SSPC desktop (you need the IP address of the
CIM agent that is used by the SAN Volume
Controller clusters).

 

Install switches User Install the switches. See your switch vendor
for information.

 

Install fabric CIM
agent

User Install the fabric CIM agent. The preferred
method for data collection with McData and
Brocade switches are through the fabric CIM
agents. See your fabric CIM agent provider for
information.

 

Fill out work sheet User Fill out planning work sheets so the IBM
service representative can configure
Windows® and set up storage system
environment. See Planning work sheet.

 

Unpack SSPC, install
SSPC hardware,
connect cables,
configure the server,
test the SSPC
installation

IBM service
representative

Unpack and set up the SSPC hardware.
Configure and test the SSPC server. See
Setting up the SSPC server.

 

Activate the
Windows license

User Activate the Windows license. See For the
customer: activating the Microsoft Windows
license.

 

Change SSPC server
host name

IBM service
representative

Change the SSPC server host name. See
Changing the server host name when DB2
extended security is off.
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Task Responsibility Description Completed?

Change Windows
Administrator
password

User Change the Windows Administrator password.
See Maintaining user IDs and passwords.

 

Configure SSPC for
DS8000

User Configure SSPC for the DS8000. See
Configuring SSPC for the DS8000.

 

Configure SSPC for
SAN Volume
Controller

User Configure SSPC for the SAN Volume Controller.
See Configuring SSPC for SAN Volume
Controller.

 

Configure SSPC for
DS3000, DS4000, or
DS5000

User Configure SSPC for the DS3000, DS4000, or
DS5000. See Configuring SSPC for DS3000,
DS4000, and DS5000.

 

Configure SSPC for
IBM Tivoli Storage
Productivity Center
for Replication

User Configure SSPC for IBM Tivoli Storage
Productivity Center for Replication. See
Configuring SSPC for IBM Tivoli Storage
Productivity Center for Replication.

 

Configure SSPC for
tape

User    

Configure SSPC for
other devices

User    

Table 2 contains other optional tasks you might want to perform after you have completed configuring SSPC.
Table 2. Other optional configuration tasks for SSPC

Task Description

Add SSPC users See Adding user IDs to SSPC.

Change DB2 user ID
password

See Maintaining user IDs and passwords

Parent topic: Planning
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Setting up the SSPC server
This topic describes the tasks that the IBM® service representative performs to install the IBM System
Storage™ Productivity Center, including procedures for installing the SSPC server in a rack, connecting the
cables, configuring the server, starting the server, and testing the installation.

Introduction
The IBM System Storage Productivity Center (SSPC) 2805-MC4 contains a SAS hot-swap hard disk
drive (2.5-inch drive).
Prerequisites
For the customer: preparing for the installation
For the IBM Service Representative: installing the hardware
For the IBM service representative: configuring the operating system
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For the IBM service representative: completing the initial configuration tasks
Running the SSPC Password Tool
Run the Password Tool to change the Windows Administrator password and the host authentication
password.
For the IBM service representative: completing the installation
The SSPC hardware installation is now complete. You can assist the customer with the following
software-related tasks:
For the IBM service representative: testing the installation
During the test, if you are prompted to register the Microsoft® Windows® Server 2008 Enterprise
operating system, minimize the message and continue with the procedure.

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Introduction
The IBM® System Storage™ Productivity Center (SSPC) 2805-MC4 contains a SAS hot-swap hard disk drive
(2.5-inch drive).

Figure 1 shows the System Storage Productivity Center 2805-MC4.

Figure 1. The IBM System Storage Productivity Center 2805-MC4. This illustration might differ slightly from
your hardware.

The SSPC comes with a limited warranty, which is available in the box with the server and on the IBM System
Storage Productivity Center Documentation CD.

For complete rack installation and removal instructions, see the IBM Rack installation instructions document.
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To learn about installing optional devices, refer to the System x3550 M2 Type 7946 User's Guide located on
the IBM System Storage Productivity Center Documentation CD, which comes with the server.

Parent topic: Setting up the SSPC server
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Prerequisites

Attention: Ensure that the customer work sheet (located in Planning work sheet) has been completely filled
out by the customer before continuing with this installation procedure.

Have the following documents available before starting the procedure (they are included in the box with
the server):

Read This First: Installing the IBM System Storage Productivity Center flyer
Planning Work Sheet (located in the Read This First: Installing the IBM System Storage Productivity
Center flyer). The work sheet is also located and should be completely filled out by the customer.
Ensure that it has been completed before starting this procedure.
IBM Important Notices
Rack installation instructions
IBM System Storage Productivity Center Documentation CD
IBM System Storage Productivity Center Introduction and Planning Guide (on the Documentation CD)
IBM System Storage Productivity Center User's Guide (on the Documentation CD)

Attached devices must be ready

If you intend to connect the SSPC to other supported devices, such as a DS8000® system, it is optimal to have
those devices fully functioning at this time.

Keyboard, mouse, and video display

A keyboard and mouse with Universal Serial Bus (USB) connectors are required for the initial setup of the
SSPC. A video display is also required. You can install an optional Keyboard, Video, Mouse (KVM) unit by
ordering Feature Code 9100.

Parent topic: Setting up the SSPC server
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For the customer: preparing for the installation
1.  For future reinstallation or recovery, retain all paperwork, CDs, and other information shipped with

the SSPC in a safe location.
2.  Complete the Planning work sheet.
3.  Read the document titled IBM Important Notices that is included in the shipping box.
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4.  Obtain an Ethernet cable to use during the installation.
5.  Installation requires a compatible keyboard, display, mouse, and interconnect cables. If you need to

purchase these items, ask your sales representative to order feature code 9100.
Tip: Feature code 9100 comes with installation instructions. If you ordered this feature code, follow the
instructions but do not remove and discard the rubber pads under the keyboard. Peel off the protective
strip on the console to expose the adhesive surface and place the keyboard into the tray. Press the
keyboard firmly so that it adheres to the tray. You can discard the switch mounting brackets that come
with feature code 9100.

6.  During SSPC installation, accept software licensing agreements when prompted by the IBM service
representative.

7.  After completing the hardware installation, the IBM service representative can help you perform the
IBM System Storage™ DS8000® element manager setup. You must configure the IBM System Storage
Productivity Center for the SAN Volume Controller, the DS3000, DS4000®, DS5000, or the IBM Tivoli®
Storage Productivity Center for Replication.

Parent topic: Setting up the SSPC server
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For the IBM Service Representative: installing the hardware
Perform the following steps to install the SSPC in a rack:

1.  Check for flashes and APAR information by accessing the IBM Support Page for SSPC
(http://www.ibm.com/systems/support/storage/software/sspc) and clicking Flashes.

2.  As is best practice, ensure that all related network-storage devices are fully functioning (for
example, IBM® System Storage™ DS8000®).

3.  Unpack the contents of the SSPC shipping box and check off the items in .
4.  Unpack the box that contains the cable-management arm.

Tip: Save all packaging material until the cable-management arm is fully assembled. Small hardware
pieces might not be visible and might be discarded accidentally with the packaging material. Carefully
remove the plastic ties from the cable-management arm and do not destroy them. You might choose to
use them to secure cables.

5.  Read the enclosed IBM Important Notices.
6.  Locate the Rack installation instructions in the plastic bag that contains the IBM System Storage

Productivity Center documentation.
7.  On the Planning Work Sheet, write down the 25-digit Windows® Product Key number that is found

on the Microsoft® Windows Server 2008 Enterprise label affixed to the top of the SSPC.
8.  Disregard the instructions that are packaged with the slide rails, and mount the SSPC server by

performing the steps in the IBM Rack installation instructions. Set aside the screws that come with the
slide rails; they are not necessary.

9.  Make the following cable connections on the back panel of the SSPC.
a.  Connect the Ethernet cable from customer's network to Ethernet 1 port, which is located at

the left rear of the SSPC.
Important: Do not use the other two Ethernet ports at this time or the network connection will
fail.

b.  Connect the keyboard and mouse to USB 1 and USB 2 ports. If using a keyboard and mouse
combination, connect to the USB 1 connector.

c.  Connect the video display cable to video connector port.
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d.  Connect the power cord (included) to the customer's rack-mounted power distribution unit
(PDU) or power outlet, then to the power supply connector on the SSPC server. (If an optional
redundant power supply is already installed, connect that power supply to a PDU, and plug the
remaining power cord into a second PDU to increase redundancy.)

10.  Connect the video display power cord to the video display, then to the customer's rack-mounted
PDU or power outlet.

11.  Secure all cables. Ensure that the cables have adequate slack to allow for full movement of both the
cable-management arm and the server, and to allow for disconnection.

12.  At the rear of the SSPC, remove the hanging tag with the address of the baseboard management
controller (BMC) media access control (MAC) and give it to the customer to store with the product
documentation. After you deploy the server, remove the BMC MAC address tag from the rear of the
sever so that it does not impede airflow.
Important: The server's Ethernet ports are set to Dynamic Host Configuration Protocol (DHCP) by
default. To find the BMC on an existing network, the server must identify itself by its default host name.
The default host name for each server is the last eight characters of the BMC MAC address. In addition
to being printed on the hanging tag, the BMC MAC address is also in the setup utility and on a label on
the system board.

Parent topic: Setting up the SSPC server

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

For the IBM service representative: configuring the operating
system

A step in this section requires the customer's participation.

1.  Slide the cover of the power-control button to the left and press the power-control button to start
the server and the operating system. The following messages are displayed whenever the server starts
or restarts and no disk is in the CD/DVD drive:

Boot Fail. CD/DVD Rom 
Boot Fail. Floppy Drive

Ignore these messages. The server continues to start. This process takes between five and ten minutes
to complete, and the server restarts before the Set Up Windows window is opened.

2.  In the Set Up Windows window, enter the Country or region, Time and currency, and Keyboard
layout information. Click Next.

3.  Enter the 25-digit Windows® product key without dashes (recorded in Windows Server 2008
Enterprise Edition Product Key and computer name).

4.  In the Windows product key window, ensure that Automatically activate Windows when I am online
is checked and click Next.
Important: The customer must read and accept the license agreement in the next step. The IBM®
service representative cannot do this on behalf of the customer.

5.  In the Microsoft® Software License Terms window, select I accept the license terms and click Next.
6.  Enter the computer name that the customer specified in Table 2. Click Start.
7.  Windows opens a panel that reads The user's password must be changed before
logging on the first time. Click OK.
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8.  Set the Windows Administrator password field to the one in Table 3 of the Planning Work Sheet.
Click the arrow button.

9.  Click OK at the confirmation window to complete the Set Up Windows window.

Parent topic: Setting up the SSPC server

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

For the IBM service representative: completing the initial
configuration tasks

Tip: For some SSPC servers, the Password Tool window opens in the foreground and the Initial Configuration
Tasks window (mentioned in step 1) opens in the background. You perform the steps in the Initial
Configuration Tasks window first.

1.  In the Initial Configuration Tasks window, click Set time zone and configure the clock and time zone
to match the time setting of the network. Click OK to return to the Initial Configuration Tasks window.

2.  Click Configure Networking.
a.  Double-click the Local Area Connection Network icon.
b.  Click Properties.
c.  If you do not use Internet Protocol Version 6, use the up or down arrow keys (↑ or ↓) to

highlight Internet Protocol Version 6 (TCP/ IPv6) and clear the check box.
d.  Use the up or down arrow keys (↑ or ↓) to highlight Internet Protocol Version 4 (TCP/ IPv4)

and click Properties.
e.  Select Use the following IP address and enter the values for the IP, Subnet Mask, Default

Gateway, Preferred DNS, and Alternate DNS address fields, recorded in Table 2 of the Planning
work sheet.

f.  Click Advanced and on the Advanced TCP/IP Settings panel, click the DNS tab.
g.  In the DNS suffix for this connection field, enter the DNS suffix recorded in Table 4 of the

Planning work sheet.
h.  Close all windows until you return to the Initial Configuration Tasks window.
i.  At the bottom left of the screen, click Start and select All Programs > Accessories >

Command Prompt.
j.  To verify that the network settings are correct, type ipconfig and press Enter. Depending on

which version of Internet Protocol you are using, locate the IPv4 or IPv6 address on the window
and write it down.

k.  To verify whether the SSPC is connected to the network, click Start > Control Panel. The
Network and Sharing Center window shows icons that represent the SSPC server, the network,
and the Internet:

If the SSPC is connected to the network, a green line exists between the SSPC server and
the network.
If the SSPC is not connected to the network, a red X exists between the SSPC server and
the network, and the network is grayed.

Parent topic: Setting up the SSPC server

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
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This information center is powered by Eclipse technology. (http://www.eclipse.org)

Running the SSPC Password Tool
Run the Password Tool to change the Windows Administrator password and the host authentication
password.

Follow these steps:

1. In the Taskbar, click the SSPC Password Tool. If the tool is closed, open it by double-clicking the SSPC
Password Tools icon that is located on the desktop. If you open the SSPC Password Tools icon, follow
the instructions for changing the password in Maintaining user IDs and passwords.

2. In the Administrator password field, enter the Windows Administrator password that was specified in
Table 3 of the Planning Work Sheet.

3. In the Host authentication password field, enter the Host authentication password specified in Table 3.
The Host authentication password is used for Tivoli Storage Productivity Center Fabric agents. You
must enter the host authentication password even if you are not installing Fabric agents. You can use
the same password as the administrator user ID or a different password. Enter this information and
click OK.

4. The Confirm password change window opens. Click Yes.
5. The Changing Passwords for SSPC status window is displayed. Wait for this process to complete. You

will see the text Complete! when the process has completed. You see error messages in the log. They
can be ignored.

6. When prompted, click Exit.

Parent topic: Setting up the SSPC server

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

For the IBM service representative: completing the
installation

The SSPC hardware installation is now complete. You can assist the customer with the following software-
related tasks:

1.  From the Initial Configuration Tasks window, click Enable Windows automatic updating and
feedback.

a.  Click Manually configure settings.
b.  In the Windows Error Reporting section, click Change Setting, select I don't want to

participate, don't ask me again, and click OK.
c.  Close all windows until you return to the Initial Configuration Tasks window.

2.  At the bottom of the Initial Configuration Tasks window, click Do not show this window at login, and
click Close.

3.  The Server Manager window opens after completing the initial configuration tasks. Close the
window. You can review the Server Manager settings after completing the installation.

4.  The Password Tool window or the SSPC online help window opens. Minimize the SSPC online help
window.
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5.  Change the System Storage™ Productivity Center password using the SSPC Password Tool. Using the
tool, you or the customer can change the DB2® user, WebSphere® user, and DB2 service passwords at
one time according to their password policies.

a.  In the Taskbar, click SSPC Password Tool. If the tool is closed, open it by double-clicking
SSPC Password Tools icon that is located on the desktop.

b.  In the Administrator password field, enter the Windows Administrator password that was
specified in Table 3 of the Planning Work Sheet.

c.  In the Host authentication password field, enter the Host authentication password that was
specified in Table 3 of the Planning Work Sheet. Confirm the password, and click OK.
Notes:

i. If the DB2 servers already have been started, the following error messages are displayed.
Ignore them and continue with this procedure.

Changing DB2 User password for Data Server... 
Changing DB2 User password for Device Server... 
OpenServiceW failed, error code = 5 
OpenServiceW failed, error code = 5 
OpenServiceW failed, error code = 5 
OpenServiceW failed, error code = 5

ii. The password tool can take at least 5 minutes to run.
d.  The status for changing the password opens. When the password tool has completed, you

will see a message that the tool has finished processing and the Exit button is enabled. Click
Exit.

6.  Add a DS8000® element manager For instructions, double-click the IBM Help for SSPC icon on the
desktop or see the information about configuring the SSPC for the DS8000 in the IBM System Storage
Productivity Center Introduction and User's Guide.

Parent topic: Setting up the SSPC server

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

For the IBM service representative: testing the installation
During the test, if you are prompted to register the Microsoft® Windows® Server 2008 Enterprise operating
system, minimize the message and continue with the procedure.

Verify that the System Storage™ Productivity Center can communicate with the network by completing the
following steps:

1.  To verify whether the device that you want to connect to the SSPC is connected to the network (for
example, a DS8000®), perform one of the following steps:

Click Start > Network. The Network window opens and lists the devices that are connected to
the network.
At the bottom left of the screen, click Start and select All Programs > Accessories > Command
Prompt. Type ping XXX.XXX.XXX.XXX (where XXX.XXX.XXX.XXX is the IP address of a device,
such as a DS8000), and press Enter. (A list of network devices is in Device information.)
Tip: A ping to a device might not be successful because some devices do not reply to a ping.

The SSPC server has a good network connection if the reply is similar to the following example:
Reply from XXX.XXX.XXX.XXX: bytes=32 time<1ms TTL=122
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If the reply timed out, resolve the problem using the following methods:

Disconnect the Ethernet cable on the rear of the SSPC from Ethernet 1. Then, reconnect
the Ethernet cable to Ethernet 1.
Ask the customer to check with the Network Administrator to verify the IP address of the
device, verify that the device is active, and ensure that there are no firewall issues.
If the ping command still does not work and you suspect that it might be a hardware error,
call IBM® support at 1-800-IBM-SERV (1-800-426-7378), and select hardware support.
Refer to the machine type as 2805 and have the serial number available. If IBM support
determines it is a software issue, call back and select software support. You must present
the Customer ID and refer to the machine as the Tivoli® Storage Productivity Center. To
contact the IBM Support Center outside the United States, go to
http://www.ibm.com/planetwide.

2.  Close the command prompt window after communication between the SSPC and the customer's
network has been successfully verified.

3.  Close the Network and Sharing Center window.
4.  Return to the Initial Configuration Tasks window.
5.  If the SSPC online help window is displayed, minimize it.

Parent topic: Setting up the SSPC server

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Configuring SSPC for the DS8000
Use this procedure to configure IBM® System Storage® Productivity Center (SSPC) so that IBM Tivoli® Storage
Productivity Center can monitor the IBM System Storage DS8000®.

Overview

Important: In releases of IBM System Storage DS8000 Version 8.0 and later, the DS8000 CIM Agent was
disabled. While the hardware for IBM System Storage Productivity Center is still supported, you cannot use it
to monitor DS8000 storage systems where the CIM agent is disabled. To monitor versions 8.0 and later of
DS8000, consider upgrading all the software that it requires, which includes:

Upgrading IBM DB2®.
Purchasing IBM Spectrum Control (formerly known as IBM Tivoli Storage Productivity Center) to
replace IBM System Storage Productivity Center.

To learn more about upgrading and purchasing software, contact an IBM Sales Specialist at
https://www.ibm.com/systems/storage/spectrum/control/index.html.

Requirement: This procedure assumes you have the following settings:

DS8000 R4.1 or later.
The CIM agent is embedded in the Hardware Management Console and is enabled.
The DS8000 administrator has created user names and passwords that CIM clients can use to attach to
the CIM agent.
Each user name that is created must be in the administrator group.
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Prepare Internet Explorer and Windows Server 2008

1. Configure Internet Explorer 7 to allow pop-up windows using the following steps:
a. Open the Internet Explorer by clicking the Internet Explorer icon located on the Quick Launch

toolbar.
b. From the Internet Explorer toolbar, click Tools > Pop-up Blocker > Turn Off Pop-up Blocker.

Note: If you receive a message that content has been blocked because it was not signed by a valid
security certificate, click the Information Bar at the top of the window and select Show blocked
content.

2. Add the IP address of the DS8000 Hardware Management Console (HMC) to the Internet Explorer list
of trusted sites using the following steps:

a. Open Internet Explorer by clicking the Internet Explorer icon located on the Quick Launch
toolbar.

b. From the Internet Explorer toolbar, click Tools > Internet options.
c. Click the Security tab, click the Trusted sites icon and then click Sites.
d. In the Add this web site to the zone field, type the IP address of the DS8000 Hardware

Management Console. Click Add and the IP address is added to the Websites field.
e. Click Close and then click OK to exit the Internet Options window, and then close the Internet

Explorer.

Configure IBM Tivoli Storage Productivity Center for DS8000

1. Start Tivoli Storage Productivity Center. You can double-click the Productivity Center icon on the
desktop or click Start > All Programs > IBM Tivoli Storage Productivity Center > Productivity Center.

2. Log on to the Tivoli Storage Productivity Center user interface with the default user ID and password.
Tip: The default password was set using the Password Tool during the System Storage Productivity
Center initial configuration.

3. The first time that you log on to the Tivoli Storage Productivity Center user interface, the license
agreement window opens. Read the terms of the license agreement. If you agree with the terms of the
license agreement, select I accept the terms of the license agreement. Click Next. You will not see this
panel on subsequent losing.

The Welcome to the IBM Tivoli Storage Productivity Center panel opens if it was not disabled prior to
this procedure.

4. Add a DS8000 element manager using the following steps:
a. Click Element Management on the Welcome to the IBM Tivoli Storage Productivity Center

window.
If you closed the Welcome to the IBM Tivoli Storage Productivity Center window without clicking
Element Management, you can access it in this way:

i. Expand IBM Tivoli Storage Productivity Center.
ii. Click Configuration Utility.

iii. Click the Element Manager tab and click Refresh.
b. In the DS8000 Element Manager section, click Select Action > Add Element manager.
c. In the Add Element Manager window, enter the following information:

Host
Enter the Domain Name System (DNS) name or Internet Protocol (IP) address of the host
computer where the element manager is located. You can enter an IPv4 or IPv6 name or
address depending on what address types are configured on the element manager and on
the system where Tivoli Storage Productivity Center is installed.
Restriction: If the computer on which the element manager is located is IPv6-only, the
Tivoli Storage Productivity Center servers must be installed on an IPv6-only or dual stack
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(IPv4 and IPv6 addresses are configured) computer.
Enter an IPv4 address in the following format: ###.###.###.###. For example:
127.0.0.1.
Enter an IPv6 address. These addresses are typically written as eight groups of
four hexadecimal digits, but might vary from site to site. For example:
2001:db8:0:0:1812:5b9e:3391:3156. You can use IPv6 addresses if the computer
where Tivoli Storage Productivity Center is dual-stack enabled (IPv4 and IPv6).

Port
Enter the port number on which the element manager listens for requests. The default
port number that is shown depends on the value that is selected in the Protocol field. You
can modify the port number if required for your environment.

Username
If the DS8000 requires a user name to log on, enter that user name in this field.

Password
If the DS8000 requires a password to log on, enter the password here.

If the DS8000 element manager that you are adding is a new installation and the user
password for the enterprise storage server network interface (ESSNI) has not been
changed from the initial value of admin, you are prompted to change the password. Be
prepared to enter a password and record the new password in a safe place.

Password Confirm
Enter the same password that you entered in the Password field.

Protocol
Select the protocol (HTTP or HTTP) for the element manager.

Display Name
If you specify a display name, it is used to identify this element manager in the element
manager table. If you do not specify a display name, the IP address of the element
manager is used instead.

d. Click Save to add the DS8000 element manager. Tivoli Storage Productivity Center tests the
connection to the element manager. If the connection was successful, the element manager is
displayed in the DS8000 element manager table.

If the connection is unsuccessful, an error message is displayed indicating that the element
manager at the specified IP address could not be added. Click Cancel to close the window
without adding the DS8000 element manager.

5. Configure the CIM agent using the following steps. You can obtain the Hardware Management Console
IP address, user name (default user ID), and password from the device information section of the
planning work sheet.
Attention: The CIM agent must be enabled by the IBM service representative for releases R2, R3, and
R4, but not for R4.1 or later. The CIM agent is enabled by default for R4.1 or later. Before using the
SSPC with the DS8000, verify with the DS8000 service representative that the CIM agent is running.

a. On the SSPC desktop, double-click the Launch DSCIMCLI icon. A command prompt window
opens.

b. At the prompt, enter the Hardware Management Console IP address of the DS8000 that was
recorded in the device information section of the planning work sheet. Press Enter.

c. At the prompt, enter the user name of the DS8000 element manager and press Enter.
Requirement: If you changed the password that you entered in step 4 you must enter that new
password in step 5.d.

d. At the prompt, enter the password of the DS8000 element manager and press Enter.
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After you click Enter, the DSCIMCLI script runs the LSD -l command to verify that the CIM agent
is connected to the DS8000 element manager and is properly configured.

For more information about these commands, see the IBM System Storage DS® Open Application
Programming Interface Reference (for CIM agent 5.4.1 and 5.4.2).

Any error messages from the DSCIMCLI script are displayed in the command prompt window.

e. When the command prompt (C:\Program Files\IBM\DSCIMCLI\Windows>) is displayed, the
Hardware Management Console procedure is complete. Close the command prompt window.

6. Add a CIM agent to Tivoli Storage Productivity Center using the following steps:
a. Start Tivoli Storage Productivity Center by double-clicking the Productivity Center icon on the

desktop.
b. From the Tivoli Storage Productivity Center navigation tree, expand IBM Tivoli Storage

Productivity Center and click Configuration Utility. (Or, click Configuration in the Welcome to the
IBM Tivoli Storage Productivity Center window, if the window was not disabled before this
procedure.)

c. Click the Services tab and expand the CIM Agents section.
d. Click Add and the Add CIMOM page opens.

Specify information about the CIM agent:

Host
Specify the IP address of the DS8000 CIM agent that was recorded in the device
information section of the planning work sheet. You can enter a host name, IPv4 address,
or IPv6 address depending on what is supported within your environment.

Port
Enter the port number on which the CIMOM communicates.

If you are creating a non-embedded CIM agent, set the port to 5988 (http) or 5989
(https). This port number can be changed.

If you are creating an embedded CIM agent, set the port to 6989. This port number
cannot be changed.

Username
Enter the default user ID for the DS8000 CIM agent that was recorded in the device
information section of the planning work sheet.

Password
Enter the password for the DS8000 CIM agent (recorded in the device information section
of the planning work sheet).

Password Confirm
Reenter the password for the DS8000 CIM agent.

Interoperability Namespace
Do not change the default value. The value is the name space within the CIMOM. This
value might be used if you are connecting a non-IBM device to SSPC. This field is not used
for the DS8000.

Protocol
Enter the protocol to be used when accessing the CIMOM. Possible values are http or
https.

Truststore Location
Do not change the default value. This value is the truststore for the CIMOM. The value
applies only to certain non-IBM devices. This field is no longer used for the DS8000.

Truststore Passphrase
Do not change the default value. The passphrase for the truststore for the CIMOM applies
only to certain non-IBM devices. This field is not used for the DS8000.
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Display Name
Enter a user-specified name for the CIMOM.

Description
Enter a description of the CIMOM in this field. This description can be any combination of
alphanumeric characters. This field is optional.

e. Select Test CIMOM connectivity before adding.
f. Click Save. If the connection to the CIM agent was made, a new entry is added to the list CIM

Agents in the CIM Agents section and the Connection Status column displays Success. If the
connection was not made to the CIM agent, check your settings in the Add CIMOM page, verify
that the CIMOM is active, and check your firewall settings.

7. Run a CIMOM discovery job using the following steps:
a. Click Run CIMOM Discovery Now.
b. After you submit a CIMOM discovery job, a message is displayed with the text CIMOM
Discovery Job submitted. Click OK to close the message.

A CIMOM discovery job can take a while to report status. If the job has completed successfully, a green
square is shown in front of the date in the navigation tree.

8. Check the status of the CIM Agents using the following steps:
a. From the navigation tree, expand Administrative Services > Discovery > CIMOM. A list containing

the dates of the most recent CIMOM jobs is displayed below the CIMOM node.
b. In the navigation tree, click the current date. The status of all the CIMOM discovery jobs is listed

in the right pane.
Tip: A CIMOM discovery job can take a long time to run. You can periodically check the status of
a job by right-clicking CIMOM in the navigation pane and selecting Refresh Job List from the
pop-up menu.

c. After the job completes, check the discovered CIMOMs. From the navigation window, expand
Administrative Services, and click Data Sources > CIMOM Agents. The CIM agents that have
been discovered are listed.

9. Run a Tivoli Storage Productivity Center probe job to collect data about the storage subsystems using
the following steps:
Tip: Probe jobs can take a long time depending on how many volumes and LUNs your storage system
has.

a. From the Tivoli Storage Productivity Center navigation tree, expand IBM Tivoli Storage
Productivity Center and click Configuration Utility.

b. Click the Disk Manager tab.
c. Expand the Storage Subsystem Probes section and click Create Probe.
d. Click the What to PROBE tab and, complete the following steps:

i. In the Available list, expand Storage subsystems and click All Storage Subsystems.
ii. Click >> to move the resources to the Current Selections list.

iii. Click the When to Run tab and schedule when you want the probe job to start and what
time zone you want to use.

iv. Click the Alert tab and set the Triggering Conditions and Triggered Actions options that
you want for the alert.

v. For more information about these fields and working with alerts, see the Tivoli Storage
Productivity Center online help system by pressing F1 or clicking the Help menu.

vi. Click the diskette icon that is located on the tool bar, enter a name for the probe job, and
click OK save the probe job. After you submit a probe job, a message is displayed with the
text Probe submitted. Click OK to close the message. Saving a probe job can take a
long time.

vii. To view the probe jobs and their status, expand IBM Tivoli Storage Productivity Center
and click Monitoring > Probes.
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e. To view the probe jobs and their status, expand IBM Tivoli Storage Productivity Center >
Monitoring > Probes node.
Note: For more information about these fields and working with alerts, see the Tivoli Storage
Productivity Center online help system by pressing F1 or clicking the Help menu.

f. Wait for the probe job to complete.
10. Verify that the DS8000 can be accessed:

a. In navigation tree, expand IBM Tivoli Storage Productivity Center and click Topology.
b. Click Storage. The DS8000 storage subsystems that you just added is displayed in the topology

viewer.
c. Double-click the storage subsystem to view all the subcomponents. Using the topology viewer,

you can explore each subsystem in detail. For information about how to use the topology viewer,
access the Tivoli Storage Productivity Center online help system by clicking the Help menu. To
learn how to view or generate reports about the storage subsystems, go to the IBM Tivoli
Storage Productivity Center Information Center at
http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp and search for Choosing a
report type.

11. To access the DS8000 GUI, expand Element Manager and click DS8000. In the right pane, select the
DS8000 that you want. From the Select Action list, click Launch Default Element Manager. This opens
the DS8000 Storage Manager GUI so that you can administer the DS8000.

Completing the configuration

1. Activate the Windows license.
If you did not check Automatically activate Windows when I am online option during the IBM System
Storage Productivity Center installation or you do not have SSPC Internet connectivity, you must
activate the license for Windows using these steps. If the Automatically activate Windows when I am
online option was enabled, you can skip this step.
Important: From the first time you start the SSPC server, you have 60 days to activate the Windows
license and complete the Windows setup. If you exceed the 60-day time limit, you cannot use Windows
until you activate the license.

a. Click the Windows Start button, right-click Computer and select Properties.
b. At the System panel, click Activate Windows now and follow the instructions to activate

Windows using the phone.
2. Optional: Subscribe to the following technical support Web sites to receive information about important

technical notes, flashes, and APAR information.
To receive support notifications for the Tivoli Storage Productivity Center:

a. Go to
http://www.ibm.com/software/sysmgmt/products/support/IBMTotalStorageProductivityC
enterStandardEdition.html.

b. In the Stay Informed section on the right, click My notifications.
c. When you access the page, enter your IBM ID and password.
d. After your user ID is authenticated, the Help tab on the My Notifications page provides the

following information:
How to create and organize subscriptions
How you are notified about subscriptions
How to specify the frequency of email notifications
How to subscribe for specific topics per product
How to unsubscribe

To receive support notifications for the System Storage Productivity Center:
a. Go to http://www.ibm.com/systems/support/storage/software/sspc.
b. In the Stay Informed section on the right, click My notifications.
c. When you access the page, enter your IBM ID and password. Click Learn more to view

information about how to use the My notifications tool.
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Configuring SSPC for SAN Volume Controller
Use this procedure to configure IBM® System Storage™ Productivity Center (SSPC) so that IBM Tivoli® Storage
Productivity Center can monitor storage subsystems under SAN Volume Controller management.

Overview

This scenario assumes that you are using SAN Volume Controller version 5.1 with the embedded CIM agent.

Prepare Internet Explorer and Windows Server 2008

1. Configure Internet Explorer 7 to allow pop-up windows using the following steps:
a. Open the Internet Explorer by clicking the Internet Explorer icon located on the Quick Launch

toolbar.
b. From the Internet Explorer toolbar, click Tools > Pop-up Blocker > Turn Off Pop-up Blocker.

Note: If you receive a message that content has been blocked because it was not signed by a valid
security certificate, click the Information Bar at the top of the window and select Show blocked
content.

2. Add the IP address of the SAN Volume Controller to the Internet Explorer list of trusted sites using the
following steps:

a. Open the Internet Explorer by clicking the Internet Explorer icon located on the Quick Launch
toolbar.

b. From the Internet Explorer toolbar, click Tools > Internet options.
c. Click the Security tab, click the Trusted sites icon and then click Sites.
d. In the Add this web site to the zone field, type the IP address of the SAN Volume Controller.

Click Add and the IP address is added to the Websites field.
e. Click Close and then click OK to exit the Internet Options window, and then close the Internet

Explorer.

Configure SAN Volume Controller

The CIM agent for SAN Volume Controller is part of the SAN Volume Controller cluster and provides Tivoli
Storage Productivity Center with access to SAN Volume Controller clusters. You must configure Tivoli Storage
Productivity Center to provide the CIM agents in your environment with the correct user names and
passwords.

1. Add the SVC cluster to your SAN Volume Controller console using the following steps.
a. On the SSPC desktop, double-click the SAN Volume Controller icon or enter this address in your

Web browser: http://IP_address:9080/ica/login. Substitute IP_address with the IP
address of your SAN Volume Controller.

b. From the My Work navigation pane, click Clusters.
c. On the Viewing Clusters page, click Add a Cluster. Click OK.
d. In the Cluster IP Address field, enter the IP address of the SVC cluster. Click OK.

Important: Do not select the Create (Initialize) Cluster function unless you must initialize your
clusters because enabling this option erases your cluster configuration.

2. Start the SVC cluster management console using the following steps:
a. On the Viewing Clusters page, select the SVC cluster you added.
b. Click Add a Cluster and select Launch the SAN Volume Controller Console.
c. Click Go. The SVC cluster management console Welcome window opens. This windows provides

you with a navigation tree that you can use to access configurations settings.
3. Create a SAN Volume Controller user.
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a. Double-click the SAN Volume Controller console icon on the System Storage Productivity Center
desktop.

b. From the My Work navigation pane, click Manage Authentication > Users.
c. In the right pane, select Create a User. Click Go.
d. From the Create a User window, enter the information to create a new user and click OK.

Configure the Tivoli Storage Productivity Center for SAN Volume Controller

1. Start Tivoli Storage Productivity Center by double-clicking the Productivity Center icon on the desktop.
2. Log on to the Tivoli Storage Productivity Center user interface with the default user ID and password.

Tip: The default password was set using the Password Tool during the System Storage Productivity
Center initial configuration.

3. The first time that you log on to the Tivoli Storage Productivity Center user interface, the license
agreement window opens. Read the terms of the license agreement. If you agree with the terms of the
license agreement, select I accept the terms of the license agreement. Click Next. You will not see this
panel on subsequent logins.
The Welcome to the IBM Tivoli Storage Productivity Center panel opens if it was not disabled prior to
this procedure.
Figure 1. Welcome to the IBM Tivoli Storage Productivity Center panel. This panel provides links to
commonly used Tivoli Storage Productivity Center tasks.

4. Add a CIM agent to Tivoli Storage Productivity Center using the following steps:
a. Click Configuration on the Welcome page. If the Welcome page is not displayed, from the Tivoli

Storage Productivity Center navigation tree expand IBM Tivoli Storage Productivity Center. Click
Configuration Utility.

b. Click the Services tab and expand the CIM Agents section.
c. Click Add and the Add CIMOM page opens.

Specify information about the CIM agent:

Host
Specify the IP address of the SAN Volume Controller. You can enter a host name, IPv4, or
IPv6 address depending on what is supported within your environment:

Port
Enter the port number on which the CIMOM communicates.

The port number for the embedded SAN Volume Controller CIM agent is 5989 (https).

Username
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Enter the user ID for the SAN Volume Controller CIM agent. The default user ID is
superuser.

Password
Enter the password for the SAN Volume Controller CIM agent.

Password Confirm
Reenter the password for the SAN Volume Controller CIM agent.

Interoperability Namespace
Enter a value for the name space within the CIM agent. The value for the embedded SAN
Volume Controller CIM agent 5.1 is /root/ibm.

Protocol
Enter the protocol to be used when accessing the CIM agent. Use https for the
embedded SAN Volume Controller CIM agent 5.1.

Truststore Location
Do not change the default value.

Truststore Passphrase
Do not change the default value. The passphrase for the truststore for the CIMOM applies
only to certain non-IBM devices.

Display Name
Enter a user-specified name for the CIM Agent.

Description
Enter a description of the CIM agent in this field. This description can be any combination
of alphanumeric characters. This field is optional.

d. Select Test CIMOM connectivity before adding.
e. Click Save. If the connection to the CIM agent was successful, a new entry is added to the list

CIM Agents in the CIM Agents section. The Connection Status column displays Success. If the
connection was not made to the CIM agent, try double-checking your settings in the Add CIMOM
page, verifying that the CIMOM is active, and that you are not restricted by your firewall settings.

5. Run a CIMOM discovery job using the following steps:
a. From the Tivoli Storage Productivity Center navigation tree, expand IBM Tivoli Storage

Productivity Center and click Configuration Utility.
b. From the Services tab, expand the CIM Agents section and click Run CIMOM Discovery Now.
c. After you submit a CIMOM discovery job, a message is displayed with the text CIMOM
Discovery Job submitted. Click OK to close the message.

A CIMOM discovery job can take a while to report status. If the job has completed successfully, a green
square is shown in front of the date in the navigation tree.

6. Run a Tivoli Storage Productivity Center probe job to collect data about the storage subsystems using
the following steps:
Tip: Probe jobs can take a long time depending on how many VDisks and MDisks your storage system
has.

a. From the Tivoli Storage Productivity Center navigation tree, expand IBM Tivoli Storage
Productivity Center and click Configuration Utility.

b. Click the Disk Manager tab.
c. Expand the Storage Subsystem Probes section and click Create Probe.
d. Click the What to Probe tab and, complete the following steps:

i. In the Available list, highlight Storage subsystems and select All Storage Subsystems.
ii. Click >> to move the resources to the Current Selections list.

iii. Click the When to Run tab and schedule when you want the probe job to start and what
time zone you want to use.

iv. Click the Alert tab and set the Triggering Conditions and Triggered Actions options that
you want for the alert.
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v. For more information about these fields and working with alerts, see the Tivoli Storage
Productivity Center online help system by pressing F1 or clicking the Help menu.

vi. Click the diskette icon that is located on the tool bar, enter a name for the probe job, and
click OK save the probe job.
Tip: Running a probe job can take a long time.

vii. To view the probe jobs and their status, expand IBM Tivoli Storage Productivity Center
and click Monitoring > Probes.

Completing the configuration

1. Activate the Windows® license.
If you did not check Automatically activate Windows when I am online option during the IBM System
Storage Productivity Center installation or you do not have SSPC Internet connectivity, you must
activate the license for Windows using these steps. If the Automatically activate Windows when I am
online option was enabled, you can skip this step.
Important: From the first time you start the SSPC server, you have 60 days to activate the Windows
license and complete the Windows setup. If you exceed the 60-day time limit, you cannot use Windows
until you activate the license.

a. Click the Windows Start button, right-click Computer and select Properties.
b. At the System panel, click Activate Windows now and follow the instructions to activate

Windows using the phone.
2. Optional: Subscribe to the following technical support Web sites to receive information about important

technical notes, flashes, and APAR information.
To receive support notifications for the Tivoli Storage Productivity Center:

a. Go to
http://www.ibm.com/software/sysmgmt/products/support/IBMTotalStorageProductivityC
enterStandardEdition.html.

b. In the Stay Informed section on the right, click My notifications.
c. When you access the page, enter your IBM ID and password.
d. After your user ID is authenticated, the Help tab on the My Notifications page provides the

following information:
How to create and organize subscriptions
How you are notified about subscriptions
How to specify the frequency of email notifications
How to subscribe for specific topics per product
How to unsubscribe

To receive support notifications for the System Storage Productivity Center:
a. Go to http://www.ibm.com/systems/support/storage/software/sspc.
b. In the Stay Informed section on the right, click My notifications.
c. When you access the page, enter your IBM ID and password. Click Learn more to view

information about how to use the My notifications tool.

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Configuring SSPC for DS3000, DS4000, and DS5000
Use this procedure to configure IBM® System Storage™ Productivity Center (SSPC) so that IBM Tivoli® Storage
Productivity Center can manage the DS3000, DS4000®, and DS5000.
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Overview

If you are installing the DS Storage Manager on the System Storage Productivity Center, you do not have to
download Java™ 1.5. The SSPC has preinstalled the package that enables DS Storage Manager launch in
context capabilities. If you are installing the DS Storage Manager on a remote host (a system that does not
have SSPC installed), you must have the IBM Tivoli Storage Productivity Center GUI and Java 1.5 installed on
the remote host. The DS Storage Manager is installed from the IBM Tivoli Storage Productivity Center GUI.

Follow these major steps:

1. Prepare Internet Explorer and Windows® Server 2008. See Prepare Internet Explorer and Windows
Server 2008.

2. Configure Tivoli Storage Productivity Center using one of the following procedures:
Configuring Tivoli Storage Productivity Center on the SSPC. See Configuring IBM Tivoli Storage
Productivity Center on the SSPC.
Configuring Tivoli Storage Productivity Center on a system without SSPC installed. See
Configuring Tivoli Storage Productivity Center on a system without SSPC installed.

3. Complete the configuration. See Completing the configuration.

Prepare Internet Explorer and Windows Server 2008

1. Configure Internet Explorer 7 to allow pop-up windows using the following steps:
a. Open Internet Explorer by clicking the Internet Explorer icon located on the Quick Launch

toolbar.
b. From the Internet Explorer toolbar, click Tools > Pop-up Blocker > Turn Off Pop-up Blocker.

Note: If you receive a message that content has been blocked because it was not signed by a valid
security certificate, click the Information Bar at the top of the window and select Show blocked
content.

2. Add the IP address of the Storage subsystem to the Internet Explorer list of trusted sites using the
following steps:

a. From the Internet Explorer toolbar, click Tools > Internet options.
b. Click the Security tab, click the Trusted sites icon and then click Sites.
c. In the Add this web site to the zone field, type the IP address of the storage subsystem. Click

Add and the IP address is added to the Websites field.
d. On the Security tab, click Custom Level. In the Security Settings panel, make sure that

Downloads > File download has Enable checked. This step is required if you are downloading
the DS Storage Manager to a remote host.

e. Click Close and then click OK to exit the Internet Options window.

Configuring IBM Tivoli Storage Productivity Center on the SSPC

1. Log on to the IBM Tivoli Storage Productivity Center using the following steps:
a. Start Tivoli Storage Productivity Center by double-clicking the Productivity Center icon that is on

the SSPC desktop or by clicking Start > All Programs > IBM Tivoli Storage Productivity Center >
Productivity Center.

b. Log on to the Tivoli Storage Productivity Center user interface with the user ID and password.
Tip: The default password was set using the Password Tool during the System Storage
Productivity Center initial configuration.

If localhost is displayed in the Server field of the login window for Tivoli Storage Productivity
Center, type the host name or the IP address of the SSPC server in this field.
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c. The first time that you log on to the Tivoli Storage Productivity Center user interface, the license
agreement window opens. Read the terms of the license agreement. If you agree with the terms
of the license agreement, select I accept the terms of the license agreement. Click Next. You will
not see this panel on subsequent logins.
The Welcome to the IBM Tivoli Storage Productivity Center panel opens if it was not disabled
prior to this procedure.
Figure 1. Welcome to the IBM Tivoli Storage Productivity Center panel. This panel provides links
to commonly used Tivoli Storage Productivity Center tasks.

2. Add a CIM agent to Tivoli Storage Productivity Center using the following steps:
a. From the Tivoli Storage Productivity Center navigation tree, expand IBM Tivoli Storage

Productivity Center and click Configuration Utility.
b. Click the Services tab and expand the CIM Agents section.
c. Click Add and the Add CIMOM page opens.

Specify information about the CIM agent:

Host
Enter the hostname or IP address of the machine with the CIM agent. You can enter a
host name, IPv4 address, or IPv6 address depending on what is supported within your
environment:

Port
Enter the port number on which the CIMOM communicates.

The default port numbers for the CIMOM are 5988 (http) or 5989 (https). This port
number can be changed.

Username
Enter the default user ID for the CIM agent.

Password
Enter the password for the CIM agent.

Password Confirm
Reenter the password for the CIM agent.

Interoperability Namespace
The value is the name space within the CIMOM.
Note: For information about namespaces, go to the IBM Tivoli Storage Productivity Center
Information Center and search for interop namespaces.

Protocol
Enter the protocol to be used when accessing the CIMOM. Possible values are http or
https.
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Truststore Location
This field is not used by the CIM agent provider.

Truststore Passphrase
This field is not used by the CIM agent provider.

Display Name
Enter a user-specified name for the CIMOM.

Description
Enter a description of the CIMOM in this field. This description can be any combination of
alphanumeric characters. This field is optional.

d. Select Test CIMOM connectivity before adding.
e. Click Save. If the connection to the CIM agent was successfully made, a new entry is added to

the list CIM Agents in the CIM Agents section. The Connection Status column displays Success.
If the connection was not made to the CIM agent, try double-checking your settings in the Add
CIMOM page, verifying that the CIMOM is active, and that you are not restricted by your firewall
settings.

3. Run a CIMOM discovery job using the following steps.
a. From the Tivoli Storage Productivity Center navigation tree, expand IBM Tivoli Storage

Productivity Center and click Configuration Utility.
b. From the Services tab, expand the CIM Agents section and click Run CIMOM Discovery Now.
c. After you submit a CIMOM discovery job, a message is displayed with the text CIMOM
Discovery Job submitted. Click OK to close the message.

d. Check the status of the CIMOM discovery job. From the Tivoli Storage Productivity Center
navigation tree, expand Administrative Services and click Discovery. The new CIMOM job is
listed along with its timestamp in the navigation tree.

A CIMOM discovery job can take a while to report status. If the job has completed successfully, a green
square is shown in front of the date in the navigation tree.

4. Download the DS Storage Manager GUI:
a. From the Tivoli Storage Productivity Center navigation tree, expand IBM Tivoli Storage

Productivity Center > Topology > Storage. In the right pane, expand the subsystem icon. Right-
click the DS3000, DS4000, or DS5000 icon and click DS4000 Storage Manager.

b. A panel is displayed titled "There is a problem with this website's security certificate." Click
Continue to this website.

c. The License Agreement for Machine Code for DS Storage Manager opens. Read the terms of the
license agreement. If you agree with the license agreement, select I accept the terms of the
License Agreement. Click OK. If you do not accept the license agreement, the application will
not be installed.

d. The DS Storage Manager Initial Setup Tasks panel is displayed. You can now configure your
storage subsystem.

5. Run a Tivoli Storage Productivity Center probe job to collect data about the storage subsystems using
the following steps:
Tip: Probe jobs can take a long time depending on how many volumes and LUNs your storage system
has.

a. From the Tivoli Storage Productivity Center navigation tree, expand IBM Tivoli Storage
Productivity Center, and click Configuration Utility.

b. Click the Disk Manager tab.
c. Expand the Storage Subsystem Probes section and click Create Probe.
d. Click the What to PROBE tab and, complete the following steps:

i. In the Available list, double-click Storage subsystems and select the resources you want
to probe.

ii. Click >> to move the resources to the Current Selections list.
iii. Click the When to Run and select Run Now.

74   IBM System Storage Productivity Center 1.4.0



iv. Click the Alert tab and set the Triggering Conditions and Triggered Actions options that
you want for the alert.

v. For more information about these fields and working with alerts, see the Tivoli Storage
Productivity Center online help system by pressing F1 or clicking the Help menu.

vi. Click the diskette icon that is located on the tool bar, enter a name for the probe job, and
click OK save the probe job.
Tip: Running a probe job can take a long time.

e. To view the probe jobs and their status, expand IBM Tivoli Storage Productivity Center and click
Monitoring > Probes.

f. The new probe is listed in the navigation tree.
g. Wait for the probe job to complete.

Configuring Tivoli Storage Productivity Center on a system without SSPC
installed

When you are configuring Tivoli Storage Productivity Center on a system without SSPC installed, you must
have the Tivoli Storage Productivity Center GUI and Java 1.5 installed on the remote system. Follow these
steps to download the Tivoli Storage Productivity Center GUI and DS Storage Manager on a remote system.

1. Launch the Tivoli Storage Productivity Center GUI.
a. Access Java Web Start to launch the Tivoli Storage Productivity Center GUI. From the remote

system, open a Web browser window and enter the Web address of the target server:

http://SSPC_server:9550/ITSRM/app/en_US/index.html

Where SSPC_server is the IP address of the SSPC server.
Note: If you receive multiple Warning - Hostname Mismatch windows when using Java Web
Start, click Run in each window until they no longer display.

b. The Java Web Start panel is displayed. If you do not have Java 1.5 installed on the remote host,
install the JRE.

IBM 1.5.0 JRE for Windows IA32
IBM 1.5.0 JRE for Linux® IA32
IBM 1.5.0 SDK for AIX® PPC32

Figure 2. Java Web Start panel

c. Download the JRE.
i. Click the appropriate JRE as shown in Figure 2.
ii. The Tivoli Storage Productivity Center License Agreement panel is displayed. Read the

terms of the license agreement. If you agree with the terms, click Agree. If you do not
agree with the terms and click Disagree, the program will not be launched.
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Note: Leave this License Agreement panel open because you will launch the IBM Tivoli
Storage Productivity Center GUI from this panel.

iii. A panel is displayed asking if you want to run the file. Click Run.
iv. A panel is displayed asking if you want to install the Java Runtime Environment. Click Yes.
v. The Choose Setup Language panel is displayed. Enter English. Click OK.

vi. The Welcome panel is displayed. Click Next.
vii. The Java License Agreement panel is displayed. Read the terms of the license agreement.

If you agree with the terms, click Agree. If you do not agree with the terms and click
Disagree, the program will not be launched.

viii. The Choose Destination Location panel is displayed. Click Next.
ix. The Setup Status panel is displayed.
x. The Browser Registration panel is displayed. Select the browser you want to associate

with the Java plug-in. Click Next.
xi. The InstallShield Wizard Complete panel is displayed. Click Finish.

d. Return to the IBM Tivoli Storage Productivity Center License Agreement panel after you have
downloaded the JRE. Click TPC GUI (Java Web Start) at the bottom of the page. This will launch
the IBM Tivoli Storage Productivity Center GUI.

2. Log on to the IBM Tivoli Storage Productivity Center user interface using the following steps:
a. Log on to the Tivoli Storage Productivity Center user interface with the user ID and password.

Tip: The default password was set using the Password Tool during the System Storage
Productivity Center initial configuration.

b. The first time that you log on to the Tivoli Storage Productivity Center user interface, the license
agreement window opens. Read the terms of the license agreement. If you agree with the terms
of the license agreement, select I accept the terms of the license agreement. Click Next. You will
not see this panel on subsequent logins.

The Welcome to the IBM Tivoli Storage Productivity Center panel opens if it was not disabled
prior to this procedure.

3. Add a CIM agent to Tivoli Storage Productivity Center using the following steps:
a. From the Tivoli Storage Productivity Center navigation tree, expand IBM Tivoli Storage

Productivity Center and click Configuration Utility.
b. Click the Services tab and expand the CIM Agents section.
c. Click Add and the Add CIMOM page opens.

Specify information about the CIM agent:

Host
Enter the hostname or IP address of the machine with the CIM agent. You can enter a
host name, IPv4 address, or IPv6 address depending on what is supported within your
environment:

Port
Enter the port number on which the CIMOM communicates.

The default port numbers for the CIMOM are 5988 (http) or 5989 (https). This port
number can be changed.

Username
Enter the default user ID for the CIM agent.

Password
Enter the password for the CIM agent.

Password Confirm
Reenter the password for the CIM agent.

Interoperability Namespace
The value is the name space within the CIMOM.
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Note: For information about namespaces, go to the IBM Tivoli Storage Productivity Center
Information Center and search for interop namespaces.

Protocol
Enter the protocol to be used when accessing the CIMOM. Possible values are http or
https.

Truststore Location
This field is not used by the CIM agent provider.

Truststore Passphrase
This field is not used by the CIM agent provider.

Display Name
Enter a user-specified name for the CIMOM.

Description
Enter a description of the CIMOM in this field. This description can be any combination of
alphanumeric characters. This field is optional.

d. Select Test CIMOM connectivity before adding.
e. Click Save. If the connection to the CIM agent was successfully made, a new entry is added to

the list CIM Agents in the CIM Agents section. The Connection Status column displays Success.
If the connection was not made to the CIM agent, try double-checking your settings in the Add
CIMOM page, verifying that the CIMOM is active, and that you are not restricted by your firewall
settings.

4. Run a CIMOM discovery job using the following steps.
a. From the Tivoli Storage Productivity Center navigation tree, expand IBM Tivoli Storage

Productivity Center and click Configuration Utility.
b. From the Services tab, expand the CIM Agents section and click Run CIMOM Discovery Now.
c. After you submit a CIMOM discovery job, a message is displayed with the text CIMOM
Discovery Job submitted. Click OK to close the message.

d. Check the status of the CIMOM discovery job. From the Tivoli Storage Productivity Center
navigation tree, expand Administrative Services and click Discovery. The new CIMOM job is
listed along with its timestamp in the navigation tree.

A CIMOM discovery job can take a while to report status. If the job has completed successfully, a green
square is shown in front of the date in the navigation tree.

5. Download the DS Storage Manager GUI:
a. From the Tivoli Storage Productivity Center navigation tree, expand IBM Tivoli Storage

Productivity Center > Topology > Storage. In the right pane, expand the subsystem icon. Right-
click the DS3000, DS4000, or DS5000 icon and click DS4000 Storage Manager.

b. A panel is displayed titled "There is a problem with this website's security certificate." Click
Continue to this website.

c. The License Agreement for Machine Code for DS Storage Manager opens. Read the terms of the
license agreement. If you agree with the license agreement, select I accept the terms of the
License Agreement. Click OK. If you do not accept the license agreement, the application will
not be installed.

d. The DS Storage Manager Initial Setup Tasks panel is displayed. You can now configure your
storage subsystem.

6. Run a Tivoli Storage Productivity Center probe job to collect data about the storage subsystems using
the following steps:
Tip: Probe jobs can take a long time depending on how many volumes and LUNs your storage system
has.

a. From the Tivoli Storage Productivity Center navigation tree, expand IBM Tivoli Storage
Productivity Center and click Configuration Utility.

b. Click the Disk Manager tab.
c. Expand the Storage Subsystem Probes section and click Create Probe.
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d. Click the What to PROBE tab and, complete the following steps:
i. In the Available list, double-click Storage subsystems and select the resources you want

to probe.
ii. Click >> to move the resources to the Current Selections list.

iii. Click the When to Run and select Run Now.
iv. Click the Alert tab and set the Triggering Conditions and Triggered Actions options that

you want for the alert.
v. For more information about these fields and working with alerts, see the Tivoli Storage

Productivity Center online help system by pressing F1 or clicking the Help menu.
vi. Click the diskette icon that is located on the tool bar, enter a name for the probe job, and

click OK save the probe job.
Tip: Running a probe job can take a long time.

e. To view the probe jobs and their status, expand IBM Tivoli Storage Productivity Center and click
Monitoring > Probes.

f. The new probe is listed in the navigation tree.
g. Wait for the probe job to complete.

Completing the configuration

1. Activate the Windows license using the following steps:
If you did not check Automatically activate Windows when I am online option during the IBM System
Storage Productivity Center installation or you do not have SSPC Internet connectivity, you must
activate the license for Windows using these steps. If the Automatically activate Windows when I am
online option was enabled, you can skip this step.
Important: From the first time you start the SSPC server, you have 60 days to activate the Windows
license and complete the Windows setup. If you exceed the 60-day time limit, you cannot use Windows
until you activate the license.

a. Click the Windows Start button, right-click Computer and select Properties.
b. At the System panel, click Activate Windows now and follow the instructions to activate

Windows using the phone.
2. Optional: Subscribe to the following technical support Web sites to receive information about important

technical notes, flashes, and APAR information.
To receive support notifications for the Tivoli Storage Productivity Center:

a. Go to
http://www.ibm.com/software/sysmgmt/products/support/IBMTotalStorageProductivityC
enterStandardEdition.html.

b. In the Stay Informed section on the right, click My notifications.
c. When you access the page, enter your IBM ID and password.
d. After your user ID is authenticated, the Help tab on the My Notifications page provides the

following information:
How to create and organize subscriptions
How you are notified about subscriptions
How to specify the frequency of email notifications
How to subscribe for specific topics per product
How to unsubscribe

To receive support notifications for the System Storage Productivity Center:
a. Go to http://www.ibm.com/systems/support/storage/software/sspc.
b. In the Stay Informed section on the right, click My notifications.
c. When you access the page, enter your IBM ID and password. Click Learn more to view

information about how to use the My notifications tool.
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 Tivoli Storage Productivity Center Basic Edition
IBM® System Storage™ Productivity Center uses IBM Tivoli® Storage Productivity Center Basic Edition to
perform device discovery, monitoring and reporting functions.

Tivoli Storage Productivity Center Basic Edition centralizes management of networked storage devices that
implement the SNIA Storage Management Initiative Specification (SMI-S). The basic edition includes support
for the IBM System Storage DS® family and IBM System Storage SAN Volume Controller. IBM Tivoli Storage
Productivity Center Basic Edition can help reduce storage management complexity and costs, and help
improve data availability using SMI-S.

The procedures in this section describe how to use the tools in IBM Tivoli Storage Productivity Center Basic
Edition, such as the topology viewer and reporting.

Using the topology viewer to view storage systems
You can use the topology viewer to monitor and troubleshoot your storage environment and perform
critical storage-management tasks.
Using the topology viewer to see storage systems managed by the SAN Volume Controller
In the topology viewer, you can view a graphical representation of the storage systems managed by the
SAN Volume Controller.
Accessing reports about storage resources
IBM System Storage Productivity Center uses the functionality of IBM Tivoli Storage Productivity Center
to provide reports about storage resources. These reports are organized into different types and
categories to provide both summary and detailed information about the storage resources in your
environment.

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Using the topology viewer to view storage systems
You can use the topology viewer to monitor and troubleshoot your storage environment and perform critical
storage-management tasks.

Start the Tivoli® Storage Productivity Center user interface and log in. Complete the following steps:
Note: These steps describe the process of viewing a DS8000®, however, the procedure is the same for a
DS3000, DS4000®, or DS5000.

1. Expand IBM® Tivoli Storage Productivity Center in the navigation tree.
2. Click Topology > Storage. The topology viewer displays an icon for each of the storage subsystems that

have been defined to IBM System Storage™ Productivity Center. For example, if you added a CIM agent
for a DS8000, you would see an overview of the topology of the DS8000 that looks like Figure 1.
Figure 1. Topology overview
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3. In the topology viewer, double-click the DS8000 icon to see the storage system environment for the
DS8000. The icon, which looks like Figure 2, is circled in Figure 1.

Figure 2. Storage subsystem icon
4. In the topology viewer, click the plus sign (+) on Device to see the disks, pools, and volumes for the

device. Before the device panel is expanded, it looks like Figure 3.
Figure 3. Device panel

5. In the Device panel, click the plus sign (+) on Disks or on Volumes. When the disk panel is expanded, it
looks like Figure 4.
Figure 4. Disks and Volumes panel
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6. In the Disks or Volumes panel, double-click on a disk or volume to see its relationship to the storage
pools. This relationship is indicated by a line from the disk or volume to the pool it is a part of. See
Figure 5.
Figure 5. A disk's relation to a storage pool

7. For more information about the storage subsystem, use the Volume to HBA Assignment reports.
a. Expand Disk Manager in the navigation tree.
b. Click Reporting > Storage Subsystems > Volume to HBA Assignment > By Storage Subsystem.
c. Move the columns that you want to display in the report into the Included Columns field and

click Generate Report. See Figure 6.
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Figure 6. List of storage systems for DS4000 series

d. Click the magnifying glass icon ( ) to the left of any storage system for more information
about the storage system.

Parent topic:  Tivoli Storage Productivity Center Basic Edition

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Using the topology viewer to see storage systems managed by
the SAN Volume Controller

In the topology viewer, you can view a graphical representation of the storage systems managed by the SAN
Volume Controller.

Start the Tivoli® Storage Productivity Center user interface and log in. Complete the following steps:

1. Expand IBM® Tivoli Storage Productivity Center in the navigation tree.
2. Click Topology > Storage. The topology viewer displays an icon for each of the storage subsystems that

have been defined to IBM System Storage™ Productivity Center. For example, if you added a CIM agent
for a SAN Volume Controller, you would see an overview of the topology of the SAN Volume Controller
that looks like Figure 1.
Figure 1. Topology viewer for the SAN Volume Controller
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3. In the topology viewer, double-click the SVC icon to see the storage system environment for the SAN
Volume Controller. The icon, which looks like Figure 2, is circled in Figure 1.
Figure 2. Storage SVC icon

4. In the topology viewer, click the plus sign (+) on Device to see the disks, volumes, and pools for the
SAN Volume Controller. Before the device panel is expanded, it looks like Figure 3
Figure 3. Device panel

5. In the Device panel, click the plus sign (+) on Disks or Volumes. The Disks and Volumes panel looks like
Figure 4.
Figure 4. Disks and Volumes panel
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6. In the Disks or Volumes panel, double-click on a disk or volume to see its relationship to the storage
pools. This relationship is indicated by a line from the disk or volume to the pool it is a part of. See
Figure 5.
Figure 5. Relationship of volume to storage pool

See the IBM Tivoli Storage Productivity Center Information Center at
http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp for more information about how to use the
Tivoli Storage Productivity Center.
Parent topic:  Tivoli Storage Productivity Center Basic Edition

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Accessing reports about storage resources
IBM® System Storage™ Productivity Center uses the functionality of IBM Tivoli® Storage Productivity Center to
provide reports about storage resources. These reports are organized into different types and categories to
provide both summary and detailed information about the storage resources in your environment.
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Data that appears in reports is based on statistical information accumulated by data collection jobs and
stored in the database repository. You can select the specific systems, storage subsystems, switches,
clusters, disks, and file systems upon which you want to report.

Reports are organized into report types and categories, which can be expanded in the navigation tree to reveal
additional sub-categories of reporting. Some reports are also accessible through the topology viewer.

Reporting types: system reports, user ID reports, user-defined online reports
Report categories: asset, Tivoli Storage Productivity Center-wide storage space (capacity), monitored
computer storage space, storage subsystem, tape library, data source

For an example of the reports you can generate see Table 1. Use this table to determine which reports are
most useful to you and which data collection jobs to run for those reports.

For more information about the categories of reports that are available to the IBM System Storage
Productivity Center, go to the IBM Tivoli Storage Productivity Center Information Center at
http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp and search for Reporting.

Table 1. Reports available for IBM Tivoli Storage Productivity Center Basic Edition
Report Category Description What data collection job

should I run for this report?

Asset reports View itemized statistics about your storage
resources in a hierarchy that lets you see the
resources in greater detail.

Location: These reports are available in the
following locations on the navigation tree:

IBM Tivoli Storage Productivity Center >
Reporting > My Reports (if you save the
definition of an online report it appears
in this location)
Data Manager > Reporting > Asset

Probes, Discovery

TPC-wide storage space Identify how much storage space is used and
unused on the disks and file systems in your
environment.

Location: These reports are available in the
following locations on the navigation tree:

IBM Tivoli Storage Productivity Center >
Reporting > My Reports (if you save the
definition of an online report it appears
in this location)
Data Manager > Reporting > TPC-wide
Storage Space

Example: Identify how much storage space is
being used on the file systems within your
environment, and how much unused storage
space is available.

Probes

IBM System Storage Productivity Center 1.4.0 85

http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp


Report Category Description What data collection job
should I run for this report?

Monitored computer
storage space

Use these host-based reports to view the data
that is collected by probes for computers,
network-attached storage, and hypervisors.
These reports contain detailed information
about the consumption of file system space and
enable you to relate that space back to external
or internal storage without counting shared
space multiple times.

Location: These reports are available in the
following locations on the navigation tree:

IBM Tivoli Storage Productivity Center >
Reporting > My Reports (if you save the
definition of an online report it appears
in this location)
Data Manager > Reporting > Monitored
Computer Storage Space

Probes

Storage subsystem
reports

View storage capacity for a computer, file
system, storage subsystem, volume, array site,
rank, and disk. These reports also enable you to
view the relationships among the components
of a storage subsystem.

Location:

Disk Manager > Reporting > Storage
Subsystems
IBM Tivoli Storage Productivity Center >
Reporting > My Reports (if you save the
definition of an online report it appears
in this location)

Example: View the relationships among the
components of a storage subsystem and the
storage capacity for a computer, file system,
storage subsystem, volume, array site, rank,
and disk.

Probes
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Report Category Description What data collection job
should I run for this report?

Data source reports Use data source reports to view detailed
information about the agents from which Tivoli
Storage Productivity Center collects
information about storage resources. Data
sources include CIMOM agents, Data agents,
Fabric agents, VMWare, and subordinate Tivoli
Storage Productivity Center servers.

Location: IBM Tivoli Storage Productivity
Center > Reporting > Data Source Reports

Example: View detailed information about the
CIM Agents that have been added to Tivoli
Storage Productivity Center as data sources.

These reports are available
for data sources that have
been associated with Tivoli
Storage Productivity Center.

Parent topic:  Tivoli Storage Productivity Center Basic Edition
Parent topic: Reference

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Configuring SSPC for IBM Tivoli Storage Productivity Center
for Replication

You must configure SSPC before you can start using IBM® Tivoli® Storage Productivity Center for Replication
with IBM Tivoli Storage Productivity Center. You must purchase and accept the Two Site or Three Site
Business Continuity license before using the product.

Overview

The process for accepting the Two Site or Three Site Business Continuity license copies a new license file into
the license directory. The CD or CD image for the license contains the setup file and the new license file.

The major steps for configuring SSPC for Tivoli Storage Productivity Center for Replication are:

1. Add the IP address for Tivoli Storage Productivity Center for Replication to the trusted zone in Internet
Explorer.

2. Accept the Two Site or Three Site Business Continuity license for Tivoli Storage Productivity Center for
Replication.

3. Open the Tivoli Storage Productivity Center GUI.
4. Manage and monitor Tivoli Storage Productivity Center for Replication.
5. Activate Windows license.
6. Subscribe to technical support Web sites.

Note: There are different hardware feature codes that need to be purchased and installed on the hardware
itself for different hardware features to work. For example, on the DS8000®, if you want to use FlashCopy you
must have the hardware feature code to do FlashCopy on the DS8000. If you want to create a FlashCopy
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session on IBM Tivoli Storage Productivity Center for Replication that manages a DS8000, you need the
FlashCopy feature on your DS8000.

Procedure

Follow these steps:

1. Open Internet Explorer to add the IP address of Tivoli Storage Productivity Center for Replication to the
trusted zone.

a. Open Internet Explorer by double-clicking the Internet Explorer icon on the desktop.
b. Select Tools > Internet options on the Internet Explorer toolbar.
c. Click the Security tab.
d. Click Trusted sites.
e. Click Sites.
f. Type the IP address into the Add this web site to the zone field. Click Add. The IP address is

added to the Web sites field.
g. Click Close.
h. Click OK to exit the Internet Options dialog box.
i. Close Internet Explorer.

2. Accept the Two Site or Three Site Business Continuity license.
Follow these steps:

a. Accept the license for Two Site or Three Site Business Continuity.
Begin the installation by double-clicking the setup file:

installation_directory\setupwin32.exe

b. Click Next on the Welcome page.
c. Review the license agreement. If you agree with the license agreement, click I accept the terms

of the license agreement.
d. InstallShield checks whether the operating system is appropriate for the product installation and

displays the results. Click Next.
e. Confirm the location where Tivoli Storage Productivity Center for Replication is installed by

accepting the default location.
f. InstallShield displays a summary dialog that allows you to change any information that you

entered. After you confirm your information, click Install to copy the new license file onto your
machine.

g. After a successful installation, a summary of the information is displayed. To complete the
installation, click Finish.

3. Start the Tivoli Storage Productivity Center GUI. Follow these steps:
a. Start Tivoli Storage Productivity Center. You can double-click the Productivity Center icon on

the desktop or click Start > All Programs > IBM Tivoli Storage Productivity Center > Tivoli
Storage Productivity Center.

b. Log onto the Tivoli Storage Productivity Center GUI with the default user ID and password. The
default user ID is Administrator. Enter the password for this user ID.

c. The first time you log on to the Tivoli Storage Productivity Center user interface, the license
agreement panel opens. Read the terms of the license agreement. If you agree with the terms of
the license agreement, select I accept the terms of the license agreement. Click Next. This
panel does not open on subsequent logins.

d. The Welcome to the IBM Tivoli Storage Productivity Center panel appears if you have not
disabled it.
Figure 1. Welcome to the IBM Tivoli Storage Productivity Center panel.
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This panel provides links to commonly used Tivoli Storage Productivity Center tasks.
4. Open the IBM Tivoli Storage Productivity Center for Replication GUI.

a. At the bottom of the IBM Tivoli Storage Productivity Center navigation tree, click Replication
Manager > Replication Management. See the Tivoli Storage Productivity Center for Replication
online help for information about how to administer Tivoli Storage Productivity Center for
Replication

b. The following buttons are in the right pane:

Replication Health Overview
The Replication Health Overview button displays the Health Overview panel for IBM
Tivoli Storage Productivity Center for Replication. This panel provides the following
information:

Overall session status: indicates the session status, which can be normal, warning,
or severe.
Overall storage system status: indicates the connection status of the storage
system.
Management server status: indicates the status of the standby server if you are
logged on to the local server. If you are logged on to the standby server, this status
indicates the status of the local server.

See the IBM Tivoli Storage Productivity Center for Replication online help for information
about how to read the Health Overview panel.

Replication Sessions Overview
The Replication Sessions Overview button lists all sessions defined within the IBM Tivoli
Storage Productivity Center for Replication environment including their state and status.
See the IBM Tivoli Storage Productivity Center for Replication online help to learn how to
create a session.

Replication Storage Systems Overview
The Replication Storage Systems Overview button displays the Storage Systems panel.
The Storage Systems panel lists all the known storage systems, and indicates whether the
storage systems are communicating normally with the active and remote servers, if
enabled. See the IBM Tivoli Storage Productivity Center for Replication online help for
information about how to add a storage system and for volume protection.

Replication Paths Overview
The Replication Paths Overview button displays the ESS/DS Paths panel. The ESS/DS
Paths panel summarizes all the known ESS/DS series paths, listing them by storage
system. See the IBM Tivoli Storage Productivity Center for Replication online help for
information about how to manage the paths.
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Replication Management Servers Overview
The Replication Management Servers button displays the Management Servers panel.
The Management Servers main panel displays the status of the management servers
configuration, lists the management servers in operation (up to two), and enables you to
define a standby server, or to define the local server as a standby server to an alternate
server. This panel has two variations, depending on whether or not you have defined a
standby. See the IBM Tivoli Storage Productivity Center for Replication online help for
information about how to manage the servers.

Replication Administration
The Replication Administration button displays the Administration panel. The
Administration panel displays a list of IBM Tivoli Storage Productivity Center for
Replication users and groups and their access privileges, and allows administrators to
take actions on users and groups. See the IBM Tivoli Storage Productivity Center for
Replication online help for information about how to manage users and groups.

Replication Advanced Tools
The Replication Advanced Tools button displays the Advanced Tools panel. The
Advanced Tools panel enables you to create a diagnostic package and change the
automatic refresh rate of the GUI. See the IBM Tivoli Storage Productivity Center for
Replication online help for information about how to create a diagnostic package or
change the refresh rate of the GUI.

5. Activate the Windows® license.
If you did not check Automatically activate Windows when I am online option during the IBM System
Storage™ Productivity Center installation or you do not have SSPC Internet connectivity, you must
activate the license for Windows using these steps. If the Automatically activate Windows when I am
online option was enabled, you can skip this step.
Important: From the first time you start the SSPC server, you have 60 days to activate the Windows
license and complete the Windows setup. If you exceed the 60-day time limit, you cannot use Windows
until you activate the license.
To activate this license, follow these steps:

a. Click the Windows Start button, right-click on Computer and select Properties.
b. At the System panel, click Activate Windows now and follow the instructions to activate

Windows using the phone.
6. Optional: Subscribe to the following technical support Web sites to receive information about important

technical notes, flashes, and APAR information.
To receive support notifications for the Tivoli Storage Productivity Center:

a. Go to
http://www.ibm.com/software/sysmgmt/products/support/IBMTotalStorageProductivityC
enterStandardEdition.html.

b. In the Stay Informed section on the right, click My notifications.
c. When you access the page, enter your IBM ID and password.
d. After your user ID is authenticated, the Help tab on the My Notifications page provides the

following information:
How to create and organize subscriptions
How you are notified about subscriptions
How to specify the frequency of email notifications
How to subscribe for specific topics per product
How to unsubscribe

To receive support notifications for the System Storage Productivity Center:
a. Go to http://www.ibm.com/systems/support/storage/software/sspc.
b. In the Stay Informed section on the right, click My notifications.
c. When you access the page, enter your IBM ID and password. Click Learn more to view

information about how to use the My notifications tool.
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Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
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Additional configuration for System Storage Productivity
Center

The section includes topics on how to configure IBM® System Storage™ Productivity Center.

Changing the server host name when DB2 extended security is off
Use this procedure to change the server's host name. SSPC is shipped with DB2® security turned off.
Changing the server host name when DB2 extended security is on
Use this procedure to change the server's host name when DB2 extended security is turned on.
Turning DB2 extended security on
Use this procedure to turn DB2 extended security on.
Adding user IDs to SSPC
Ensure that in a multiple-user environment, all users accessing IBM Tivoli® Storage Productivity Center
also have the authority to manage other aspects of the storage environment.
Enabling a non-Administrator user ID to create a backup image
You might need to assign properties to a non-Administrator user ID so that the user ID can use the
Windows® Server Backup feature to back up or recover the SSPC image.
Starting management commands for the DS CIM agent
Use this information to start the management commands for the DS CIM (DSCIMCLI) for IBM System
Storage Productivity Center.

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Changing the server host name when DB2 extended security is
off

Use this procedure to change the server's host name. SSPC is shipped with DB2® security turned off.

DB2 has been installed with extended security turned off. Use this procedure to change the server's host
name.

To change the host name, follow these steps.

Note: Do not use this procedure after you have added agents or Agent Manager.

1. Change the server's host name on Windows®.
a. Click Start.
b. Right-click Computer.
c. Click Show on Desktop.
d. On the System window, click Change settings.
e. On the System Properties window, click Change.

IBM System Storage Productivity Center 1.4.0 91

http://www.ibm.com/servers/storage/support/software/tpc/
http://www.ibm.com/legal/
http://www.ibm.com/servers/storage/support/software/tpc/
http://www.ibm.com/legal/


f. On the Computer Name/Domain Changes window, provide a new name in the Computer name
field.

g. If you wish to set the primary DNS suffix for the system, click More and enter the "primary DNS
of this computer" in the "DNS Suffix and NetBIOS Computer Name" panel.

h. Click OK until you see the window "Computer Name/Domain Changes," which tells you to restart
your computer to apply the changes. Click OK to reboot the system.

i. You will see these messages when the system reboots, you can ignore them:

At least one service or driver failed during system startup.   
Use Event Viewer to examine the event log for details. 
 
SQL1042C An unexpected system error occurred.

2. You can open the IBM® Tivoli® Storage Productivity Center user interface and start using the product.

Parent topic: Additional configuration for System Storage Productivity Center

Support | Terms of use | Feedback
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Changing the server host name when DB2 extended security is
on

Use this procedure to change the server's host name when DB2® extended security is turned on.

For information about how to turn DB2 extended security on, see Turning DB2 extended security on.

1. Stop the DB2 Administration Server and the DB2 instance. Open the DB2 command prompt window
and run the following commands:

db2admin stop 
db2stop

2. From the DB2 command prompt window, run the following commands:

db2set -g DB2SYSTEM=new_host_name 
db2set -g DB2_EXTSECURITY=NO 
db2set -all

The db2 set-all command displays the settings so that you can verify the information.

3. Update the DB2 Administration Server configuration by running the following commands:

db2 list admin node directory show detail 
db2 uncatalog node old_host_name  
db2 catalog admin tcpip node new_host_name 
  remote new_host_name system new_host_name 
db2 update admin cfg using DB2SYSTEM new_host_name 
db2 update admin cfg using SMTP_SERVER new_host_name

The db2 uncatalog node command assumes that your admin node name is the same as your old
host name.

4. Edit the db2nodes.cfg file. In the DB2 command prompt window, go to the following directory:
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C:\ProgramData\IBM\DB2\DB2COPY1\DB2

Change the old host name to the new host name in the db2nodes.cfg file.
5. Change the server's host name on Windows® 2008.

a. On the Server Manager, click Change System Properties.
b. On the System Properties window, click the Computer Name tab.
c. On the Computer Name window, click Change.
d. On the Computer Name Changes window, provide a new name in the Computer name field.
e. If you want to set the primary DNS suffix for the system, click More and enter the primary DNS of

this computer in the DNS Suffix and NetBIOS Computer Name panel.
f. Click OK and close the System Properties panel.
g. Click Restart Later.

6. After renaming and restarting the computer, stop the DB2 Administration Server and the DB2 instance.
Open the DB2 command prompt window and run the following commands:

db2admin stop 
db2stop

7. Run the db2extsec command to update the security settings:

db2extsec -a new_host_name\DB2ADMNS -u new_host_name\DB2USERS

8. Start the DB2 Administration Server and the DB2 instance by running the following commands:

db2admin start 
db2start

9. Run an IBM® Tivoli® Storage Productivity Center discovery job using the new host name.

Parent topic: Additional configuration for System Storage Productivity Center

Support | Terms of use | Feedback
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Turning DB2 extended security on
Use this procedure to turn DB2® extended security on.

1. Stop the DB2 Administration Server and the DB2 instance. Open the DB2 command prompt window
and go to the following directory:

C:\Program Files\IBM\SQLLIB\BIN

Run the following commands:

db2admin stop 
db2stop

2. Update the DB2 Administration Server configuration by running the following commands. In the DB2
command prompt window, go to the following directory:

C:\Program Files\IBM\SQLLIB\BIN

Run these commands:

IBM System Storage Productivity Center 1.4.0 93

http://www.ibm.com/servers/storage/support/software/tpc/
http://www.ibm.com/legal/


db2set -g DB2SYSTEM=host_name 
db2 catalog admin tcpip node host_name remote host_name 
  system host_name 
db2 update admin cfg using DB2SYSTEM host_name 
db2 update admin cfg using SMTP_SERVER host_name

3. Edit the db2nodes.cfg file. In the DB2 command prompt window, go to the following directory:

C:\Program Files\IBM\SQLLIB\DB2\db2nodes.cfg

Change the name in the localhost field to the host name in the db2nodes.cfg file.
4. If the DB2ADMNS and DB2USERS groups do not exist, create them now. Add the Administrator user ID

to the DB2ADMNS group.
5. Run the db2extsec command to update the security settings:

db2extsec -a host_name\DB2ADMNS -u host_name\DB2USERS

6. Start the DB2 Administration Server and the DB2 instance.
a. Open the DB2 command prompt window and go to the following directory:

C:\Program Files\IBM\SQLLIB\BIN

b. Run these commands:

db2admin start 
db2start

Parent topic: Additional configuration for System Storage Productivity Center
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Adding user IDs to SSPC
Ensure that in a multiple-user environment, all users accessing IBM® Tivoli® Storage Productivity Center also
have the authority to manage other aspects of the storage environment.

The procedure to add user roles to SSPC requires Tivoli Storage Productivity Center administrator authority
and can be done as two tasks:

Set up the user ID at the operating-system level, and then add this user ID to a group.
Set up Tivoli Storage Productivity Center to map the operating-system group to a Tivoli Storage
Productivity Center role.

Figure 1 illustrates how to add a new user role to the IBM System Storage™ Productivity Center.

Figure 1. Adding a new user to SSPC
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The authorization level in Tivoli Storage Productivity Center depends on the role assigned to a user group. See
Table 1.

Table 1. Roles and authorization levels
Role Authorization level

Superuser Has full access to all Tivoli Storage Productivity Center functions.

Productivity Center administrator Has full access to operations in the Administration section of the
GUI.

Disk administrator Has full access to Tivoli Storage Productivity Center disk
functions.

Disk operator Has access to reports only for Tivoli Storage Productivity Center
disk functions. This includes reports on tape devices.

Fabric administrator Has full access to IBM Tivoli Storage Productivity Center for Fabric
functions.

Fabric operator Has access to reports only for IBM Tivoli Storage Productivity
Center for Fabric functions.

Data administrator Has full access to IBM Tivoli Storage Productivity Center for Data
functions.

Data operator Has access to reports onlyIBM Tivoli Storage Productivity Center
for Data functions.

Tape administrator Has full access to Tivoli Storage Productivity Center tape
functions.

Tape operator Has access to reports only for tape functions.

1. If a user has multiple roles, the authorization level is a combination of the levels for each of the roles.
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2. If a user is not a member of any of the roles listed, no access is granted to that user.

You can use many types of user roles. The commonly used roles for SSPC are the disk administrator and disk
operator.

Setting up the user ID at the operating-system level

To set up a new SSPC user role, the SSPC administrator needs to first grant the appropriate user permissions
on the operating system using the following steps:

1. From the SSPC desktop, click Server Manager > Configuration > Local Users and Groups > Users.
2. Create a new user ID. Click Action > New User. Specify a value for the following fields:

User ID and password.
If appropriate, select User must change password at next logon.

If you select this box, the user must change the password the first time that they log on.

If appropriate, select Password never expires.
Click Create to add the new user ID.

3. Add the new user ID to an existing group.
a. To add the user ID to an existing group, click Local Users and Groups > Groups. Click Groups.

Select a group in the right pane. Right-click on the group. Click Add to group to add a new group
or select an existing group. Select Add > Advanced > Find Now and select the user to be added
to the Group.

b. On the Administrators Properties window, click Add.
c. On the Select Users window, enter the user ID in the Enter the object names to select field.

Click OK.
d. Click OK to exit the Administrators Properties window.

To simplify user administration, use the same name for the Windows® user group and the user group roles in
Tivoli Storage Productivity Center. For example, create the Windows user group "Disk Administrator" and
assign this group to the Tivoli Storage Productivity Center role "Disk Administrator."

Setting up the user roles in Tivoli Storage Productivity Center

The group that is defined at the operating-system must be mapped to a role that is defined in Tivoli Storage
Productivity Center.
To do this, follow these steps:

1. Log on to Tivoli Storage Productivity Center with administrator permission and click Administrative
Services > Configuration > Role-to-Group Mappings.

2. On the right pane, click Edit for the role that you want to associate with the group that you have
created. The Edit Group window is displayed.

3. Enter the group that you want to associate with the Tivoli Storage Productivity Center role. For
DS8000® management, the roles to use are Disk Operator or Disk Administrator. After you define the
user role, the operator can access the Tivoli Storage Productivity Center GUI.

The authorization level in Tivoli Storage Productivity Center depends on the role assigned to a user
group.

4. Click File > Save to save the mappings.

For information about Tivoli Storage Productivity Center user roles, see User IDs, passwords, and user roles.

Accessing Tivoli Storage Productivity Center as a new user
96   IBM System Storage Productivity Center 1.4.0



To access the Tivoli Storage Productivity Center GUI, the operator opens a Web browser using the Tivoli
Storage Productivity Center user ID and password. The operator must also provide the SSPC IP address that
you provide. Follow these steps to log on to the Tivoli Storage Productivity Center GUI:

1. If you selected the field Change password at first login, the user must first log on to SSPC to change
the password. The user can log on at the SSPC server or by Remote Desktop.

2. Connect to the Web address http://SSPC_IP_address:9550/ITSRM/app/welcome.html.
3. Select TPC GUI and open the Java™ Web Start executable file. The first time you perform this task, a

Java Web start session is opened and the TSRMGUI.jar is downloaded to the workstation where the
browser was started.

4. Start the Tivoli Storage Productivity Center GUI. If localhost is displayed in the Server field of the
login window for Tivoli Storage Productivity Center, type the host name or the IP address of the SSPC
server in this field.

5. Enter the appropriate user ID and password.
6. Change the server field to SSPC_IP_address:9549 if there is no name server resolution between the

workstation and SSPC. SSPC_IP_address is the IP address of the SSPC server.

Parent topic: Additional configuration for System Storage Productivity Center

Support | Terms of use | Feedback
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Enabling a non-Administrator user ID to create a backup
image

You might need to assign properties to a non-Administrator user ID so that the user ID can use the Windows®
Server Backup feature to back up or recover the SSPC image.

To use the Windows Server Backup feature to back up or recover your SSPC system, you must be a member of
the Windows Backup Operators or Administrators Group, or you must have been delegated the appropriate
authority.

The Administrator user ID that is included with SSPC is a member of the Administrators Group and has
appropriate authority to perform a backup or recovery. However, if another SSPC user ID exists and you want
to use it, a member of the Windows Administrators Group can modify the properties of that user ID and
provide authority by adding it to the Backup Operators Group.

Tip: A user ID that is a member of the Backup Operators Group can perform backup and recovery operations,
but has no Administrator rights.

To enable a non-Administrator user ID to back up or recover the SSPC image by using the Windows Server
Backup feature, perform the following steps.

1. Determine the user ID that you want to use to recover the backup image.
2. From the Microsoft® Windows desktop, click Start > Server Manager.
3. From the navigation pane of the Windows Server Manager window, expand Configuration.
4. Expand Local Users and Groups.
5. Double-click the Users folder to display a list of SSPC user IDs.
6. Double-click the user ID that you want to use. The properties for the user ID are displayed.
7. Click the Member Of tab.
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8. Click Add and enter Backup Operators. Click OK and click Apply. The Backup Operators authority for
this user ID is displayed in the Member of window.

9. Click OK.

Parent topic: Additional configuration for System Storage Productivity Center
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Starting management commands for the DS CIM agent
Use this information to start the management commands for the DS CIM (DSCIMCLI) for IBM® System
Storage™ Productivity Center.

When you start the DSCIMCLI in the command prompt window, enter the following information:

Please enter the HMC IP Address: 
Please enter the User Name: 
Please enter the Password: 

After you enter this information, press Enter. The dscimcli lsdev -l and lsconfig commands automatically run.
An example of the output from the lsdev -l command is:

Type  IP   IP2   Username Storage Image Status  Code Level Min Codelevel 
   
DS    xxx   xxx     xxx        xxx        xxx     xxx        xxx   

An example of the information that is displayed from the lsconfig command is as follows:

Property       Current Value           After Restart 
 
insecureport   <port>                  <port> 
secureport     <port>                  <port> 
certificate    <certificate_location>  <certificate_location> 
enablesecure   <value>                 <value> 
enableinsecure <value>                 <value> 
loglevel       <value>                 <value> 
tracemask      <value>                 <value>   
tracecomponent <value>                 <value> 
jvmarg         <value>                 <value> 
dsdutycycle    <value>                 <value> 
slpregips      <value>                 <value>   
               

Any error messages are displayed in the command prompt window.
After the commands have finished running, you see the directory command prompt:

C:\Program Files\IBM\DSCIMCLI\Windows>

This command prompt window remains open so that you can enter more DSCIMCLI commands.
Parent topic: Additional configuration for System Storage Productivity Center
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Managing System Storage Productivity Center
System Storage™ Productivity Center uses Tivoli® Storage Productivity Center to add and manage element
managers for storage devices. Element managers are applications that are used to configure and manage a
storage device. You manage connections to the element managers that are provided with the storage device
or you can specify other element managers for a device.

The Element Manager tab in the Configuration Utility is used to add and manage element managers. The
Element Manager tab contains multiple sections. The Other Device Element Manager section shows element
managers that have been added using a discovery job or existing element managers that were added to Tivoli
Storage Productivity Center before release 4.1.

For more information about Element Managers, including how to create, delete, and configure them, see the
Tivoli Storage Productivity Center Information Center at
http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp.

Accessing the System Storage Productivity Center online help
IBM® System Storage Productivity Center uses IBM Tivoli Storage Productivity Center, which provides a
comprehensive online help system for accessing context-sensitive information about the functions
within the user interface. This section provides information on how to access the online help.
Element managers
Element managers are applications that are used to configure and manage a storage device. You can
add and manage connections to the element manager that is provided with IBM System Storage
DS8000®. You can specify other element managers for a device. Use the Configuration Utility in IBM
Tivoli Storage Productivity Center to add and manage element managers for the DS8000.
CIM object manager
A CIM object manager (CIMOM) is a program that is installed on storage subsystems so that
management application appliances, such as IBM System Storage Productivity Center, can perform
operations on that storage subsystem.
Single sign-on
Single sign-on is an authentication process by which you can enter one user ID and password to access
multiple applications. For example, you can access IBM Tivoli Integrated Portal and then access IBM
Tivoli Storage Productivity Center and IBM Tivoli Storage Productivity Center for Replication from Tivoli
Integrated Portal using a single user ID and password. Single sign-on integrates with the launch in
context feature so that you can move smoothly from one application to a functionally related location in
a second application.
Launch in context
The launch in context feature is available in two modes: inbound and outbound. With the inbound
launch in context feature, you can start IBM Tivoli Storage Productivity Center at a specified point in the
graphical user interface (GUI).
Configuring SSPC for Remote Desktop connection
Use this procedure to configure IBM System Storage Productivity Center (SSPC) for a Remote Desktop
connection. Remote Desktop is included with Windows 2008 and enables you to connect to your
computer across the internet from virtually any computer.
Configuring Tivoli Storage Productivity Center for DS8000 LDAP support
You must configure Tivoli Storage Productivity Center to use LDAP for single sign-on support for the
DS8000 R4.2 or later.
Verifying the IBM Tivoli Storage Productivity Center version
When you encounter a problem and need IBM customer support, one of the items you need to identify
is the version level of the product.
Verifying the IBM System Storage Productivity Center version
You can check the version of System Storage Productivity Center so that if you encounter a problem
and need IBM customer support you can identify the version level that you are using.
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Verifying the DS3000, DS4000, DS5000 Storage Manager GUI version
When you encounter a problem and need IBM customer support, one of the items you need to identify
is the version level of the product.
Backing up and recovering the SSPC system
The Windows® Server Backup feature provides a basic backup and recovery solution for computers
running the Windows Server 2008 operating system. SSPC provides a procedure that allows you to
recover your system in the event of a system failure.

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Accessing the System Storage Productivity Center online help
IBM® System Storage™ Productivity Center uses IBM Tivoli® Storage Productivity Center, which provides a
comprehensive online help system for accessing context-sensitive information about the functions within the
user interface. This section provides information on how to access the online help.

Use the online help system within Tivoli Storage Productivity Center to:

View information about the fields, buttons, text boxes, and other elements on the windows and panels
in the user interface.
Learn how to perform storage-management tasks using features and functions available within Tivoli
Storage Productivity Center.

Use the following methods for accessing online help from different locations within the user interface.

Component How to access the online help Description of the online help

Tivoli Storage
Productivity Center
main window

Press F1 or select an option from the Help
menu.

This online help opens in a separate
window and provides information
about how to use Tivoli Storage
Productivity Center.

IBM System Storage
DS8000® Storage
Manager windows

The DS8000 Storage
Manager user
interface opens when
you start an element
manager from the
Element Manager
page.

Click This online help opens within a Web
browser and provides information
about how to use the DS8000 Storage
Manager.

Parent topic: Managing System Storage Productivity Center
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Element managers
Element managers are applications that are used to configure and manage a storage device. You can add and
manage connections to the element manager that is provided with IBM® System Storage™ DS8000®. You can
specify other element managers for a device. Use the Configuration Utility in IBM Tivoli® Storage Productivity
Center to add and manage element managers for the DS8000.

In the Configuration Utility, you use the Element Manager tab to view and manage all of the element managers
that have been created for the DS8000 and other devices.

You can perform the following tasks in the Element Manager tab. Find more information about these
procedures in the IBM Tivoli Storage Productivity Center information center at
http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp.

Start the DS8000 Element Management Configuration page with a list of element managers that are
visible to Tivoli Storage Productivity Center.
Start the DS8000 GUI (for example, the DS8000 Storage Manager) to configure and administer the
storage subsystems associated with an element manager.
Add element managers that you want to manage.
Remove element managers.
Modify element managers that are on the page.
Test the connection between IBM Tivoli Storage Productivity Center and element managers.
Add CIM object manager (CIMOM) connections for element managers. For example, you can perform a
task to associate a CIMOM that is embedded on a DS8000 Hardware Management Console (HMC) with
a DS8000 element manager. You are not required to associate CIMOMs with element managers if you
only want to configure and administer DS8000 storage subsystems. However, doing so enables you to
use Tivoli Storage Productivity Center to monitor and collect storage metrics about the associated
DS8000 storage subsystem and discover other storage entities managed by the CIMOM.
Modify CIMOM connections for element managers.
Remove CIMOM connections from element managers.

The user name and password for the DS8000 GUI are stored with each Tivoli Storage Productivity Center user.
Therefore, before a Tivoli Storage Productivity Center user can access a DS8000 GUI, each user must have
stored their user credentials. The Element Manager tab lists all element managers that are known to the Tivoli
Storage Productivity Center, regardless of whether the user credentials are valid.

If the element manager has been added to Tivoli Storage Productivity Center using different credentials from
the ones you are using, or if you attempt to open the DS8000 GUI for the first time after the element manager
was added to Tivoli Storage Productivity Center by CIMOM discovery, you encounter the following message:

The element manager GUI cannot be accessed because the user name and password are
missing. Update the required fields in the next dialog. The GUI will be displayed
after the fields have been correctly completed and the dialog closed.

The DS8000 Element Manager section

The DS8000 Element Manager section of the Element Manager tab contains a table listing the element
managers that are visible to Tivoli Storage Productivity Center and a Select Action list. With this list you can
add an element manager to the section and to manage existing element managers. The menu items that are
shown in the Select Action list depend on whether you have selected an element manager in the table. This
table contains the following fields:

Element Manager
Shows the IP address of the element manager or the display name if a display name was defined.
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Connection Status
Shows the status of the element manager. The values in this field are:

Online
The element manager is accessible.

Offline
The element manager is not accessible.

Device
The name for the device as defined in Tivoli Storage Productivity Center.

UID/PWD
Shows whether a user ID and password have been defined for authentication to the element manager.
The values that appear in this field are:

Yes
A user ID and password have been defined.

No
A user ID and password have not been defined.

CIMOM
Shows whether a CIMOM is configured for the element manager. The values that appear in this field
are:

Yes
A CIMOM is configured.

No
A CIMOM is not configured.

LIC Enabled
Shows whether a launch descriptor file has been registered for the element manager. A launch
descriptor file is an XML file that describes the menus and the detailed uniform resource locators
(URLs) for applications. An launch descriptor file is required to enable the launch in context feature for
the device. Tivoli Storage Productivity Center provides a launch descriptor file for the element manager
that is provided with DS8000. The values that appear in this field are:

Yes
Launch in context is enabled.

No
Launch in context is not enabled.

Starting the DS8000 GUI from the element manager
You can open the DS8000 GUI from the element manager provided that you have the credentials.

Parent topic: Managing System Storage Productivity Center
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Starting the DS8000 GUI from the element manager
You can open the DS8000® GUI from the element manager provided that you have the credentials.
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Log on to the Tivoli® Storage Productivity Center user interface. Complete the following steps:

1. Expand IBM Tivoli Storage Productivity Center in the navigation tree.
2. Click Configuration Utility.
3. From the DS8000 Element Manager section, select the DS8000 that you want to start.

If there are no element managers listed on this page, you have not created any yet. You must add
element managers before they can be listed.

4. Click Select Action and select Launch Default Element Manager. If you are logged on to Tivoli Storage
Productivity Center as a user with credentials that are different than the GUI that you are trying to
access, an error will occur. You can fix this using one of the following options:

Add the credentials to the user ID you are logged on with.
a. Close the warning message. The Modify Element Manager window opens.
b. Add the credentials and click Save.

Important: Use this method with caution because anyone who knows the Tivoli Storage
Productivity Center credentials can access the DS8000 device.

Log on with the user ID that was used to add the element manager.
Navigate to the DS8000 element manager you want to start and select Launch Default Element
Manager from the Select Action list.

Parent topic: Element managers
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CIM object manager
A CIM object manager (CIMOM) is a program that is installed on storage subsystems so that management
application appliances, such as IBM® System Storage™ Productivity Center, can perform operations on that
storage subsystem.

You can create a CIMOM connection on IBM System Storage Productivity Center to interface with and manage
a storage subsystem. After creating the CIMOM connection on the System Storage Productivity Center, you
can run data collection jobs such as probes, subsystem performance monitors, and scans from your System
Storage Productivity Center against the subsystem.

A CIMOM is similar to an element manager because both a CIMOM and an element manager allow the
management applications to issue commands on it. However, when you create an element manager you are
creating an actual interface with the storage subsystem's GUI. Creating a CIMOM connection provides a direct
request and response relationship between the System Storage Productivity Center and the device. An
element manager can only be created for a DS8000®.

Some of the storage subsystems that support the CIMOM interface are:

IBM Tivoli® Storage
Tivoli Storage Enterprise Storage Server
Storage area network SAN Volume Controller
DS4000®, DS6000™, DS8000

IBM System Storage Productivity Center supports any SMI-S-certified CIMOM, and tape and switch CIMOMs.
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For more information about CIMOMs, including how to create, delete, and configure them, see the IBM Tivoli
Storage Productivity Center Information Center at
http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp.

Migrating SAN Volume Controller CIM agents
You can migrate from the external IBM System Storage SAN Volume Controller Common Interface
Model (CIM) agent to the embedded SAN Volume Controller CIM agent. Likewise, you can also migrate
from an embedded CIM agent to an external agent.

Parent topic: Managing System Storage Productivity Center
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Migrating SAN Volume Controller CIM agents
You can migrate from the external IBM® System Storage™ SAN Volume Controller Common Interface Model
(CIM) agent to the embedded SAN Volume Controller CIM agent. Likewise, you can also migrate from an
embedded CIM agent to an external agent.

Migrating from an external CIM agent to an embedded CIM agent

Before you complete this procedure, make sure that the following prerequisites have been met:

The cluster (either managed by an external or an embedded CIM agent) has been discovered and
probed successfully by IBM Tivoli® Storage Productivity Center.
You have installed Tivoli Storage Productivity Center version 4.1.0.109 or later. Errors can occur if you
use this migration procedure on earlier versions of Tivoli Storage Productivity Center.

Follow these steps:

1. Optional: Back up the Tivoli Storage Productivity Center database.
2. Stop any Tivoli Storage Productivity Center performance monitor jobs that are running on the specific

cluster that is managed by the external CIM agent.
3. Make sure that no discovery, probes, or performance collection jobs are running on the specific device

until the migration process is finished.
4. Expand Administrative Services > Data Sources > CIMOM Agents.
5. Click Add CIMOM to add the embedded CIM agent.
6. Both the embedded and external CIM agents are displayed in the CIMOM Agents table. Select the entry

that represents the external CIM agent and click Remove CIMOM.

Using both the embedded and external CIM agents to manage the device can result in failing jobs and
inconsistent data that persists in the database. Also, it is important that you remove the external CIM
agent after adding the embedded CIM agent.

7. Click OK in the confirmation window.
8. Run a CIM object manager (CIMOM) discovery job in Tivoli Storage Productivity Center as shown in the

following steps:
a. Expand Administrative Services > Discovery.
b. Right-click CIMOM and click Run Now.

9. Run a probe job that includes the SAN Volume Controller system that is managed by the embedded
CIM agent shown in the following steps. If you do not run a probe for the SAN Volume Controller
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system, you might see errors and inconsistent data in the database.
a. Expand IBM Tivoli Storage Productivity Center > Monitoring > Probes.
b. Right-click the probe job and click Run Now.

Migrating an embedded CIM agent to an external CIM agent

Before you complete this procedure, make sure that the following prerequisites have been met:

The cluster (either managed by an external or an embedded CIM agent) has been discovered and
probed successfully by Tivoli Storage Productivity Center.
You have installed Tivoli Storage Productivity Center version 4.1.0.109 or later. Errors can occur if you
use this migration procedure on earlier versions of Tivoli Storage Productivity Center

Follow these steps:

1. Back up the Tivoli Storage Productivity Center database (optional).
2. Stop any Tivoli Storage Productivity Center performance monitor jobs running on the specific cluster

that is managed by the embedded CIM agent.
3. Make sure that no discovery, probes, or performance collection jobs are running on the specific device

until the migration process is finished.
4. Expand Administrative Services > Data Sources > CIMOM Agents.
5. Click Add CIMOM to add the external CIM agent.
6. Both the embedded and external CIM agents are displayed in the CIMOM Agents table. Select the entry

that represents the embedded CIM agent and click Remove CIMOM.

Using both the embedded and external CIM agents to manage the device can result in failing jobs and
inconsistent data that persists in the database. Also, it is important that you remove the embedded CIM
agent after adding the external CIM agent.

7. Click OK in the confirmation window.
8. Run a CIM object manager (CIMOM) discovery job in Tivoli Storage Productivity Center as shown in the

following steps:
a. Expand Administrative Services > Discovery.
b. Right-click CIMOM and click Run Now.

9. Run a probe job that includes the SAN Volume Controller system that is managed by the external CIM
agent shown in the following steps. If you do not run a probe for the SAN Volume Controller system,
you might see errors and inconsistent data in the database.

a. Expand IBM Tivoli Storage Productivity Center > Monitoring > Probes.
b. Right-click the probe job and click Run Now.

Parent topic: CIM object manager
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Single sign-on
Single sign-on is an authentication process by which you can enter one user ID and password to access
multiple applications. For example, you can access IBM® Tivoli® Integrated Portal and then access IBM Tivoli
Storage Productivity Center and IBM Tivoli Storage Productivity Center for Replication from Tivoli Integrated

IBM System Storage Productivity Center 1.4.0 105

http://www.ibm.com/servers/storage/support/software/tpc/
http://www.ibm.com/legal/


Portal using a single user ID and password. Single sign-on integrates with the launch in context feature so that
you can move smoothly from one application to a functionally related location in a second application.

Single sign-on is not available for the following programs:

IBM XIV® Storage Manager
IBM System Storage™ SAN Volume Controller
IBM System Storage DS4000®

Selecting the user authentication method to use with single sign-on
With single sign-on, you can select the user authentication method that you want to use.
Changing the user authentication method
Changing the LTPA token expiration for single sign-on

Parent topic: Managing System Storage Productivity Center
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Selecting the user authentication method to use with single
sign-on

With single sign-on, you can select the user authentication method that you want to use.

The initial configuration of Tivoli® Storage Productivity Center on System Storage™ Productivity Center is set to
use the operating system (OS) users and groups on the server where Tivoli Storage Productivity Center is
installed for authentication and authorization. You can configure Tivoli Storage Productivity Center to use
LDAP as the authentication method.

OS Authentication
This method authenticates the user against the users defined for the local operating system (OS).

LDAP/Active Directory
This method authenticates the user against a Lightweight Directory Access Protocol (LDAP) or
Microsoft® Active Directory repository.

If you select OS authentication, the use of the single sign-on feature is limited. OS authentication does not
support single sign-on for element managers. LDAP or Microsoft Active Directory authentication supports
single sign-on for element managers regardless of where they are installed.

You can change the user authentication method using the Tivoli Integrated Portal graphical user interface
(GUI).

Parent topic: Single sign-on
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Changing the user authentication method
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The IBM® Tivoli® Storage Productivity Center installation program enables you to select a user authentication
method that is used by Tivoli Storage Productivity Center, IBM Tivoli Storage Productivity Center for
Replication, and IBM Tivoli Integrated Portal. You can choose to authenticate users against the users defined
for the local operating system or to authenticate users against the users defined in a Lightweight Directory
Access Protocol (LDAP) or Microsoft® Active Directory repository.

Changing the authentication method from LDAP to the local operating system
You can configure IBM Tivoli Storage Productivity Center to authenticate against the local operating
system. To change the authentication method from LDAP to local operating system, you must use Tivoli
Integrated Portal.
Changing the authentication method from local operating system to LDAP federated repositories
You can configure IBM Tivoli Storage Productivity Center to communicate with an external Lightweight
Directory Access Protocol (LDAP) repository such as IBM Tivoli Directory Server or Microsoft Active
Directory. To change the authentication method from local operating system to LDAP, you must use
IBM Tivoli Integrated Portal.

Parent topic: Single sign-on
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Changing the authentication method from LDAP to the local
operating system

You can configure IBM® Tivoli® Storage Productivity Center to authenticate against the local operating system.
To change the authentication method from LDAP to local operating system, you must use Tivoli Integrated
Portal.

The local operating system authentication does not permit single sign-on if Tivoli Storage Productivity Center
and Tivoli Integrated Portal are on separate computers. Operating system authentication also does not
support single sign-on for element managers, regardless of the location of the element manager application.
To change the user authentication method from LDAP to the local operating system, complete the following
steps:

1. Start an Internet Explorer or Firefox Web browser, and type the following information in the address
bar:

http://hostname:port

where hostname defines the server name or IP address that is running Tivoli Integrated Portal and port
defines the port number for Tivoli Integrated Portal. If you used the default port during the installation
of Tivoli Integrated Portal, the port number is 16310. Contact your Tivoli Storage Productivity Center
administrator if you need to verify the host name and port number.

2. On the Tivoli Integrated Portal logon page, log on using the appropriate user ID and password. Your
user ID must have administrator permissions.

3. From the Tivoli Integrated Portal navigation tree, click Security > Secure administration, applications,
and infrastructure.

4. On the "Secure administration, applications, and infrastructure" page, select Local operating system
from the Available Realm Definitions list.

5. On the "Local operating system" page, configure the following items:
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a. In the Primary administrative user name field, enter the name of a user ID that is defined in your
local operating system. This user ID is granted administrative privileges in the Tivoli Integrated
Portal server, the Tivoli Storage Productivity Center Device server, and the IBM Tivoli Storage
Productivity Center for Replication server.

b. Click Server identity that is stored in the repository.
c. In the Server user ID or administrative user on a Version 6.0.x node field, enter the same ID that

you entered in the Primary administrative user name field and enter the password for the user ID
in the Password field.

d. Click OK.
e. In the Messages pane on the "Secure administration, applications, and infrastructure" page,

click Save in Save to the master configuration.
6. Configure the following items on the "Secure administration, applications, and infrastructure" page:

a. In the Available realm definitions list, select Local operating system and click Set as current.
b. Click Apply and click the Save link in Save to the master configuration

7. Stop and restart the Tivoli Integrated Portal, IBM Tivoli Storage Productivity Center for Replication
servers and the IBM Tivoli Storage Productivity Center data and device servers.

For information about stopping and starting a server, go to the Tivoli Storage Productivity Center Information
Center and search for starting and stopping services.
Parent topic: Changing the user authentication method
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Changing the authentication method from local operating
system to LDAP federated repositories

You can configure IBM® Tivoli® Storage Productivity Center to communicate with an external Lightweight
Directory Access Protocol (LDAP) repository such as IBM Tivoli Directory Server or Microsoft Active Directory.
To change the authentication method from local operating system to LDAP, you must use IBM Tivoli
Integrated Portal.

System Storage™ Productivity Center has been installed with operating system authentication. To change the
user authentication method from local operating system to LDAP, complete the following steps. Contact your
LDAP server administrator for assistance.

Before changing the user authentication method, stop and restart only the Tivoli Storage Productivity Center
Device server before running this procedure.

1. Start an Internet Explorer or Firefox Web browser, and type the following information in the address
bar:

http://hostname:port

Where hostname defines the server that is running Tivoli Integrated Portal such as the server name or
IP address and port defines the port number for Tivoli Integrated Portal. If the default port was
accepted during the installation of Tivoli Integrated Portal, the port number is 16310. Contact your
Tivoli Storage Productivity Center administrator if you need to verify the host name and port number.

2. On the Tivoli Integrated Portal logon page, log on using the appropriate user ID and password. Your
user ID must have administrator permissions.
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3. In the Tivoli Integrated Portal navigation tree, click Security > Secure administration, applications, and
infrastructure.

4. On the Secure administration, applications, and infrastructure page, select Federated Repositories
from the Available Realm Definitions list.

5. Click Configure. The Federated repositories page is displayed.
6. Under Related Items, click Manage repositories.
7. On the Manage repositories page, add the LDAP repository that you want to use for authentication as

follows:
a. Click Add to add a new repository.
b. Enter the values for the following fields:

Repository identifier. A unique identifier for the LDAP repository. This identifier uniquely
identifies the repository within the cell, for example: LDAP1.
Directory type. The type of LDAP server to which you want to connect.
Primary host name. The host name of the primary LDAP server. This host name is either
an IP address or a domain name service (DNS) name.
Port. The LDAP server port. The default value is 389, which is not a Secure Sockets Layer
(SSL) connection. You can use port 636 for a Secure Sockets Layer (SSL) connection. For
some LDAP servers, you can specify a different port for a non-SSL or SSL connection. If
you do not know the port to use, contact your LDAP server administrator.
Bind distinguished name. The distinguished name (DN) for the application server to use
when binding to the LDAP repository. If no name is specified, the application server binds
anonymously. In most cases, bind DN and bind password are needed. However, when
anonymous bind can satisfy all the required functions, bind DN and bind password are not
needed.
Bind password. The password for the application server to use when binding to the LDAP
repository.

c. Click OK.
d. In the Messages box on the Manage repositories page, click the Save link in Save to the master

configuration.
8. On the Manage repositories page, click the identifier for the repository that you want to use in the

Repository identifier column.
9. On the configuration page for the repository, configure the following items:

a. Click LDAP entity types under Additional Properties. The LDAP entities page is displayed.
b. In the Entity type column, click the link for Group, OrgContainer, and PersonAccount and

complete the Search bases field. This field specifies the search bases that are used to search
this entity type. The search bases specified must be subtrees of the base entry in the repository.
The following are example search bases, where o=ibm,c=us is the base entry in the repository:

 o=ibm,c=us or cn=users,o=ibm,c=us or ou=austin,o=ibm,c=us  

Delimit multiple search bases with a semicolon (;). For example:

ou=austin,o=ibm,c=us;ou=raleigh,o=ibm,c=us

c. Click OK and then click the Save link in Save to the master configuration each time that you
update the Search bases field.

10. Return to the Federated repositories page and click Supported Entity Types under Additional
Properties.

11. On the Supported entity types page, configure the following items:
a. In the Entity type column, click the link for Group, OrgContainer, and PersonAccount and

complete the Base entry for the default parent and Relative Distinguished Name properties
fields.

In the Base entry for the default parent field, enter the same value that you entered in the
Search bases field in step 9.
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In the Relative Distinguished Name properties field, enter the appropriate LDAP attribute
name. In most cases, the values for this field are cn for Group, o;ou;dc;cn for
OrgContainer, and uid for PersonAccount.

b. Click OK and then click the Save link in Save to the master configuration each time that you
update the Base entry for the default parent field.

12. Return to the Federated repositories page and click Apply and then click the Save link in Save to the
master configuration.

13. Under Repositories in the realm, click Add base entry to Realm.
14. On the Repository reference page, configure the following items:

a. In the Repository list, select the repository that you created in step 7.
b. In the Distinguished name of a base entry that uniquely identifies this set of entries in the realm

field, enter the distinguished name of a base entry that uniquely identifies the repository in the
realm. In most instances, this value is the same value that you entered in the Search bases field
in step 9.

c. In the Distinguished name of a base entry in this repository field, enter the distinguished name
of the base entry within the repository. In most instances, this value is the same value that you
entered in the Distinguished name of a base entry that uniquely identifies this set of entries in
the realm field.

d. Click OK and then click the Save link in Save to the master configuration each time that you
update the Distinguished name of a base entry that uniquely identifies this set of entries in the
realm field.

15. On the Federated repositories page, there are now two repositories that are displayed under
Repositories in the realm: the repository that you have added and a default repository that shows File
in the Repository type column. Configure the following items:

a. Leave the value in the Realm name field as is or change the name of the realm name.
b. In the Primary administrative user name field, enter the name of a user in the repository that you

added. This user is granted administrative privileges in the Tivoli Integrated Portal server, the
Tivoli Storage Productivity Center Device server, and the IBM Tivoli Storage Productivity Center
for Replication server.

c. Click Server identity that is stored in the repository.
d. In the Server user ID or administrative user on a Version 6.0.x node field, enter the same ID that

you entered in the Primary administrative user name field and enter the password for the user ID
in the Password field.

e. Select the default file repository that shows File in the Repository type column and click
Remove.

f. Click OK and then click the Save link in Save to the master configuration.
16. Return to Secure administration, applications, and infrastructure page and configure the following

items:
a. In the Available realm definitions list, select Federated repositories and then click Set as

current.
b. Click Apply and then click the Save link in Save to the master configuration

17. Stop and restart the Tivoli Integrated Portal, IBM Tivoli Storage Productivity Center for Replication
servers and the IBM Tivoli Storage Productivity Center Data and Device servers.
Stop the servers in this order:

a. Tivoli Storage Productivity Center for Replication server
b. Tivoli Storage Productivity Center Data server
c. Tivoli Storage Productivity Center Device server
d. Tivoli Integrated Portal server

Start the servers in this order:
a. Tivoli Integrated Portal server
b. Tivoli Storage Productivity Center Device server
c. Tivoli Storage Productivity Center Data server
d. Tivoli Storage Productivity Center for Replication server
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For information regarding stopping and starting a server, go to the Tivoli Storage Productivity Center
Information Center and search for starting and stopping services. If the server is running on a Windows
operating system, the change to the user authentication method might not be implemented until you
restart the computer.

To verify that the federated repository is configured correctly, complete the following steps:

1. Log on to Tivoli Integrated Portal as the new super user ID (the administrative account is no longer the
OS credentials, but is now configured to use the LDAP server super user credentials).

2. In the Tivoli Integrated Portal navigation tree, click Users and Groups > Manage Users.
3. In the Search by list, select User ID.
4. Click Search to search for users in the federated repository. The list of users includes users from both

the LDAP and the local file registry.
5. After you have completed and verified the conversion of your Tivoli Storage Productivity Center

system's authentication mechanism from local operating system to LDAP federated repositories,
remove all Administrative Group Roles entries in the Tivoli Integrated Portal console that involve local
operating system groups:

a. In the Tivoli Integrated Portal navigation tree, click Users and Groups > Administrative Group
Roles.

b. In the Administrative Group Roles table, select all entries that involve local operating system
groups. Do not select entries that involve LDAP federated repository groups.

c. Click Remove.
d. In the Messages box on the Administrative Group Roles page, click Save link in "Save directly to

the master configuration."

Parent topic: Changing the user authentication method

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Changing the LTPA token expiration for single sign-on
For single sign-on, the user's authentication information is passed between applications using Lightweight
Third-Party Authentication (LTPA) tokens. By default, the tokens expire after 24 hours. You can change the
LTPA token expiration time using the Tivoli® Integrated Portal user interface. For instructions about how to
change the LTPA token expiration, see the Tivoli Storage Productivity Center Information center at
http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp.

Parent topic: Single sign-on

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Launch in context
The launch in context feature is available in two modes: inbound and outbound. With the inbound launch in
context feature, you can start IBM® Tivoli® Storage Productivity Center at a specified point in the graphical
user interface (GUI).
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With the outbound launch in context feature, you can use various points in the Tivoli Storage Productivity
Center GUI to start an application such as an element manager at a specified point in the manager.

Inbound launch in context feature
With the inbound launch in context feature you can start IBM Tivoli Storage Productivity Center at a
specified point in the graphical user interface (GUI).
Prerequisite: You must have View and Modify permissions to use the launch in context feature.
You can run the launch in context feature in the following ways:

Use Java™ Web Start from a Web browser.
Use the command line on Windows®, AIX®, Linux®, or UNIX®
Use the Windows Start menu.
Use the Tivoli Enterprise Portal GUI to define, edit, and launch commands.

Outbound launch in context feature
With the outbound launch in context feature you can start applications such as element managers from
various points in the IBM Tivoli Storage Productivity Center graphical user interface (GUI).
Launch in context is not available for the following programs:

IBM XIV® Storage Manager
IBM System Storage™ SAN Volume Controller
IBM System Storage DS4000®

When you right-click a storage device in the Topology Viewer graphic view, for example, you see a
launch in context menu for that device. The content of the launch in context menu varies. The launch in
context menu is displayed when you right-click various objects in the Tivoli Storage Productivity Center
GUI.

For information about the launch in context feature, see the Tivoli Storage Productivity Center Information
center at http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp.

Parent topic: Managing System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Configuring SSPC for Remote Desktop connection
Use this procedure to configure IBM® System Storage™ Productivity Center (SSPC) for a Remote Desktop
connection. Remote Desktop is included with Windows 2008 and enables you to connect to your computer
across the internet from virtually any computer.

Procedure

To configure SSPC for Remote Desktop connection, follow these steps:

1. Click Start > Administrative Tools > Server Manager.
2. The Server Manager window opens. Click Configure Remote Desktop.
3. The System Properties window opens. Click one of the following selections:

Allow connections from computers running any version of Remote Desktop (this option is
less secure)
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Allow connections only from computers running Remote Desktop with Network Level
Authentication (this option is more secure and connects to other systems running Windows
2008)

4. Click Apply.

Parent topic: Managing System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Configuring Tivoli Storage Productivity Center for DS8000
LDAP support

You must configure Tivoli® Storage Productivity Center to use LDAP for single sign-on support for the DS8000®
R4.2 or later.

Overview

Configuring Tivoli Storage Productivity Center and DS8000 for single sign-on involves these general steps:

For Tivoli Storage Productivity Center

1. Extract the certificate. This certificate is used for securing communication between the
Authentication Client on the HMC and the Authentication Service (server component) on Tivoli
Storage Productivity Center.

2. Create a truststore which includes the certificate from step 1.
3. You need to know the URL for the Authentication Service.

For DS8000

1. Create a Storage Authentication Service (SAS) policy with information collected from Tivoli
Storage Productivity Center and the LDAP server.

2. Test the Storage Authentication Service policy using a valid LDAP user mapped to a DS8000 user
role in the policy.

3. Activate the Storage Authentication Service policy using a valid LDAP user mapped to the
DS8000 administrative user role in the policy.

Configuring Tivoli Storage Productivity Center

This procedure assumes that Tivoli Storage Productivity Center is set up with the LDAP repository. Follow
these steps:

1. Obtain the URL for the Authentication Service.
Example:

https://TIP_server_host:16311/TokenService/services/Trust

The port for the Authentication Service (16311) is one plus the default Tivoli Integrated Portal port
(16310). If you change the default port, for example, 17522, then the port number to use for the
Authentication Service is one plus the Tivoli Integrated Portal port. In this example, the port number
would be:
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https://tpcserver1.storage.mycompany.com:17523/TokenService/services/Trust

2. Create the truststore file and import the certificate into the truststore file using the ikeyMan tool:
a. Launch the ikeyMan tool.

For example on Windows®:

c:\Program Files\IBM\tivoli\tip\bin\ikeyman.bat

b. Click Key Database File > New. In the New window, enter the following information and click
OK:

Key database type
Enter or leave the default JKS.

File Name
Enter a file name. For example, enter tpc_ess.jks.
Note: The default location is:

c:\Program Files\IBM\tivoli\tip\bin\

Location
Enter a location. For example, enter c:\tpc\. Click OK.

c. The next window prompts you to specify a password for this truststore. Specify a password that
you can remember. Click OK.

d. In the next window, click Add. The Add CA certificate opens. Click Browse and select the
certificate file that you created in step 2.b. Click Done, then click OK.

i. Look for the certificate file.
ii. Change the Files of Type to All files.

iii. Click Open.
e. From the prompt, specify a label. Provide any label. An example of a label is ESS_Cert. Click OK.

The ESS_Cert is now one of the certificates listed.
f. Exit the ikeyman tool and locate the truststore file (for example, tpc_ess.jks). You need this

truststore file and the password to configure the LDAP-based policy on DS8000.
3. Log on to IBM® Tivoli Integrated Portal. Start an Internet Explorer Web browser, and enter the following

information in the address bar:

https://hostname:port/ibm/console/logon.jsp

where hostname defines the name of the server that is running IBM Tivoli Integrated Portal and port
defines the port number for IBM Tivoli Integrated Portal. The default port is 16310. Contact your IBM
Tivoli Storage Productivity Center administrator if you need to verify the host name and port number.
On the IBM Tivoli Integrated Portal logon page, log on using the LDAP user ID and password.

4. Create the truststore in IBM Tivoli Integrated Portal.
a. When logged in to IBM Tivoli Integrated Portal, go to the Personal Certificates page for the

Default keystore. Click Security > SSL certificate and key management > Key stores and
certificates > NodeDefaultKeyStore > Personal Certificates. On this page, select the default
certificate and click Extract. On the resulting page, enter the following information:

Certificate file name
Enter a file name for the extracted certificate. This file automatically gets created in
TIP_install_directory/profiles/TIPProfile/etc/. For Windows, the default
directory is C:\TIP_install_directory\profiles\TIPProfile\etc\. Accept and
select the default data type. Click OK.

b. The truststore setup is complete.
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5. Find the user ID and password that is used in LDAP to use for the DS8000 Storage Authentication
Service policy configuration page.

This user ID is used for authenticating with the Authentication Service. It can be any user ID in LDAP, or
a user ID that is also used by Tivoli Storage Productivity Center. This user ID is used as the "Application
Client User ID" for a Storage Authentication Service policy on the DS8000.

6. Find the name of a group in LDAP with which you can log in to Tivoli Storage Productivity Center and the
DS8000. You would use this LDAP group on the DS8000 also, for mapping to DS8000 roles.

You can go to the Tivoli Storage Productivity Center Role-to-Group Mapping node to find out which
LDAP group is mapped to the role in Tivoli Storage Productivity Center.

To find the LDAP group name, open the Tivoli Storage Productivity Center GUI and click Tivoli Storage
Productivity Center > Configuration > Role-to-Group Mapping.

The information gathered in steps 1, 2, 4, 5, and 6 is used on the DS8000 Storage Authentication
Service policy creation page.

7. Configure DS8000 R4.2 or later.

Configuring DS8000 for LDAP authentication

Follow these steps:

1. Add the IP address of the DS8000 Hardware Management Console to the Internet Explorer list of
trusted sites using the following steps:

a. Open the Internet Explorer by clicking the Internet Explorer icon located on the Quick Launch
toolbar.

b. From the Internet Explorer toolbar, click Tools > Internet options.
c. Click the Security tab, click the Trusted sites icon and then click Sites.
d. In the Add this web site to the zone field, type the IP address of the DS8000 Hardware

Management Console (HMC). Click Add and the IP address is added to the Websites field.
e. Click Close and then click OK to exit the Internet Options window, and then close the Internet

Explorer.
2. To access the DS8000 GUI, expand Element Manager. Click DS8000. In the right pane, select the

DS8000 you want. From the Select Action drop-down list, click Launch Default Element Manager.
This action opens the DS8000 Storage Manager GUI so that you can administer the DS8000. Use the
administrative user ID and password. Enter the User Name and Password. Click OK.

3. On the DS8000 Storage Manager Welcome page, click Real-time manager > Monitor System > User
Administration.

4. On the User and Authentication Policy Administration Summary page, select a Complex Name. From
the Select action menu, select Create Storage Authentication Service Policy.

5. The Authentication Service Configuration page is displayed. Enter the following information:
Policy Name
Authentication Service URL (primary)
Authentication Service Client User ID
Authentication Service Client Password
Confirm Authentication Service Client Password

Click Next.
Note: An example of the authentication URL is:

https://TIP_server_host:16311/TokenService/services/Trust

Here is an example:
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https://tpcserver1.storage.mycompany.com:16311/TokenService/services/Trust

The port for the Authentication Service (16311) is one plus the default Tivoli Integrated Portal port
(16310). If you change the default port, for example, 17522, then the port number to use for the
Authentication Service is one plus the Tivoli Integrated Portal port. In this example, the port number
would be:

https://tpcserver1.storage.mycompany.com:17523/TokenService/services/Trust

6. The Truststore file Information page is displayed. Enter the following information:
Truststore File Location
Truststore File Password
Confirm Truststore File Password

Click Next.
7. The Map External Users and User Groups to DS8000 User Roles page is displayed. Enter the following

information:
External Entity Name
External Entity Type
DS8000 User Role

Click Add. The entry is entered in the table at the bottom of this page. Select the entry you created and
click Next.

8. The Verification page is displayed. Verify the information and click Next.
9. The Summary page is displayed. Click Activate the Policy if you want to activate the policy

immediately. If you want to test the policy before activating it, do not select Activate the Policy and
click Finish to create the policy. This scenario assumes that you want to test the policy before
activating it. You see a message dialog indicating whether the policy was successfully created or not. If
the policy was successfully created, close the message dialog.

10. The Manage Authorization Policy page is displayed. Select a policy. From the Select action menu, click
Test Authentication Policy.

11. The Test Storage Authentication Service Policy page is displayed. Enter the following information:
External User Name
External User Password

Provide an LDAP user ID and password for External User Name and External User Password. The user
ID must already be mapped to a valid DS8000 user role in the Storage Authentication Service policy.
This user ID does not have to be in the Administrator group. Click OK.

12. The Manage Authentication Policy page is displayed. Select the policy you want. From the Select action
menu, click Activate Authentication Policy.

13. The Activate Storage Authentication Service Policy page is displayed. Enter the following information:
External User Name
External User Password

Provide an LDAP user ID and password for External User Name and External User Password. The user
ID must already be mapped to a valid DS8000 user role in the Storage Authentication Service policy.
This user ID must be in the Administrator group. Click OK. The policy is now activated. Close the page.

Parent topic: Managing System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Verifying the IBM Tivoli Storage Productivity Center version
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When you encounter a problem and need IBM customer support, one of the items you need to identify is the
version level of the product.

To verify the version of IBM® Tivoli® Storage Productivity Center that is installed, go to the following directory:

Windows: C:\Program Files\IBM\TPC

This directory contains the version.txt file which displays the version of Tivoli Storage Productivity Center that
is installed.
This is an example of the information in version.txt:

TPC V4.1.1 Build TPC_4.1.1.0.56 20090921

Parent topic: Managing System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Verifying the IBM System Storage Productivity Center version
You can check the version of System Storage™ Productivity Center so that if you encounter a problem and
need IBM customer support you can identify the version level that you are using.

To verify the version of IBM® System Storage Productivity Center that is installed, go to the following directory:

C:\sspc

This directory contains the version.txt file which displays the version of System Storage Productivity Center
that is installed.
This is an example of the information in version.txt:

SSPC V1.4 Build 20091023

Parent topic: Managing System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Verifying the DS3000, DS4000, DS5000 Storage Manager GUI
version

When you encounter a problem and need IBM customer support, one of the items you need to identify is the
version level of the product.

To verify the version of DS3000, DS4000®, or DS5000 Storage Manager GUI that is installed, go to the
following directory:

C:\Program Files\IBM\TPC\device\apps\was\profiles\deviceServer\ 
installedApps\DefaultNode\DeviceServer.ear\DeviceServer.war\app\ 
product\app
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Where product can be DS3000, DS4000, or DS5000. This directory contains the version.txt file which
displays the version of the Storage Manager GUI that is installed.
Parent topic: Managing System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Backing up and recovering the SSPC system
The Windows® Server Backup feature provides a basic backup and recovery solution for computers running
the Windows Server 2008 operating system. SSPC provides a procedure that allows you to recover your
system in the event of a system failure.

Backing up the SSPC system
You can use the Windows Server Backup feature to protect your operating system, volumes, files, and
application data. Backups can be saved to shared folders on a network drive or to DVDs. They can be
scheduled to run automatically or manually.
Recovering the SSPC system
The method of recovering the SSPC system varies, depending on the number of hard disk drives that
failed and whether you backed up each drive.
Backing up the IBM Tivoli Storage Productivity Center database
Backing up and recovering Tivoli Storage Productivity Center for Replication
There are two methods for backing up IBM® Tivoli Storage Productivity Center for Replication.

Parent topic: Managing System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Backing up the SSPC system
You can use the Windows® Server Backup feature to protect your operating system, volumes, files, and
application data. Backups can be saved to shared folders on a network drive or to DVDs. They can be
scheduled to run automatically or manually.

You can create a backup using the Backup Schedule Wizard to enable backups to run on a regular schedule or
you can use the Backup Once Wizard to run a one-time backup. You can access both of these wizards from the
Windows Server Backup Microsoft® Management Console (MMC). You can also create regular or one-time
backups using the Wbadmin command.

When backing up your system, use the Full server (all volumes) option. Do not use the Critical volumes or
Noncritical volumes option. The Full server option backs up all volumes, including all files, data, applications,
and the system state.

To use Windows Server Backup, you must be a member of the Windows Backup Operators or Administrators
group, or you must have been delegated the appropriate authority. (The Administrator user ID that is included
with SSPC is a member of the Administrators group and has the appropriate authority to perform backups.) If
you want to use an SSPC user ID other than the Administrator user ID to create and recover a backup image,
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see the instructions in Enabling a non-Administrator user ID to create a backup image. Changing the
properties of a non-Administrator user ID so that it is authorized to recover a backup image is a task that can
be performed only by a member of the Windows Administrators group. For complete information, see
Windows 2008 Help and Support by clicking Start > Help and Support. Search add a user account to a group.

Tip: Record the password that you use to backup SSPC. If you must recover SSPC image you must use the
password that you recorded at the time that you backed up the SSPC image. Otherwise, you will not be able to
log on to Windows, or access IBM® Tivoli® Storage Productivity Center or IBM DB2.

For complete information about backing up your SSPC system, go to http://technet.microsoft.com/en-
us/library/cc753528.aspx. This Web site includes information about the following tasks:

Configuring automatic backups
Modifying an automatic backup schedule
Performing a manual backup
Using multiple disks to store backups
Creating a backup of the system state using a command line

Parent topic: Backing up and recovering the SSPC system

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Recovering the SSPC system
The method of recovering the SSPC system varies, depending on the number of hard disk drives that failed
and whether you backed up each drive.

If both of the hard disk drives in the SSPC server failed, you must use the LSI Configuration Utility Program to
recover files. The LSI Configuration Utility Program is firmware that is preinstalled on the SSPC server that can
create redundancy for the files on the 2805-MC4 hard disk drives. You are not required to manually set up the
LSI Configuration Utility Program if only one hard drive fails. If one drive fails, the LSI Configuration Utility
Program automatically identifies the new hard drive and copies the files from the failed drive to the redundant
drive. The copying begins when Microsoft® Windows® 2008 Enterprise Editions starts, and runs in the
background until the copy operation is complete.

You must manually set up the LSI Configuration Utility Program if one of the following conditions exists:

Both hard drives have been completely formatted
Both hard drives have been replaced
The LSI Configuration Utility Program was removed from the SSPC server

To recover the SSPC system:

1. Determine whether you must manually set up the LSI Configuration Utility Program:
If you must set up the program, perform the steps in Manually setting up the LSI Configuration
Utility Program and go to step 2.
If you do not have to set up the program, go to step 2.

2. Select and perform one of the following recovery procedures:
If you backed up your SSPC system and want to recover it from a shared folder on a network
drive, see Recovering the backup image from a shared folder on a network drive.
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If you backed up your SSPC system and want to recover it from DVDs, see Recovering the
backup image from DVDs.
If you did not back up your SSPC system, see Recovering the SSPC image if you did not back it
up.

Manually setting up the LSI Configuration Utility Program
If both of the hard drives in the SSPC 2805-MC4 have been completely formatted or replaced, or if the
LSI Configuration Utility Program was removed from the SSPC server, you must manually set up the LSI
Configuration Utility Program.
Recovering the SSPC system if you backed it up
This topic explains methods of recovering your backed up SSPC image.
Recovering the SSPC image if you did not back it up
You might need to recover the SSPC system if you did not back it up with the Windows Server Backup
feature.

Parent topic: Backing up and recovering the SSPC system
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Manually setting up the LSI Configuration Utility Program
If both of the hard drives in the SSPC 2805-MC4 have been completely formatted or replaced, or if the LSI
Configuration Utility Program was removed from the SSPC server, you must manually set up the LSI
Configuration Utility Program.

The LSI Configuration Utility Program supports the SSPC server's redundant array of independent disks
(RAID). By using the LSI Configuration Utility Program, the server can create redundancy for the files on its
2805-MC4 hard disk drives so that if one disk drive fails, the data can be read or regenerated from the other
disk drive in the array.

To manually set up the LSI Configuration Utility Program, perform the following steps:

1. Ensure that a keyboard, video, and mouse (KVM) unit is securely connected to the SSPC server.
2. Restart the server using the following steps:

a. From the SSPC desktop, click Start.
b. Click the right arrow icon and from the list click Restart. The Shut Down Windows® window is

displayed.
c. In the Shutdown Event tracker box, from Options select Operation system: Reconfiguration

(Planned) and click OK. The IBM® System x® Server Firmware window is displayed while
Windows restarts.

d. If the server does not respond (for example, if the mouse cursor does not move), press the
power-control button to turn off the server. Wait two minutes and push the power-control button
again to restart the server.

3. Press Ctrl + H to start the LSI Configuration Utility Program. The Adapter Selection window is
displayed.

4. Click Start. The MegaRAID BIOS Config Utility Virtual Configuration window is displayed.
5. In the left navigation panel, click Configuration Wizard.
6. Click New Configuration and click Next. The following message is displayed:

This is a Destructive Operation! 
Original configuration and data will be lost 
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Select YES, if desired so.

7. Click Yes.
8. From the Select Configuration Method window, perform the following steps:

a. Click Automatic Configuration.
b. In the Redundancy field, click Redundancy when possible from the list.
c. Click Next.

9. In the Configuration Preview window. click Accept. The following message is displayed: Save this
Configuration?

10. Click Yes. The following message is displayed:

All data on the new Virtual Drives will be lost. 
Want to Initialize?

11. Click Yes. The window quickly loads twice.
12. Click Slow Initialize, and click Go. The following message is displayed:

All data on the new Virtual Drives will be lost. 
Want to Proceed with Initialization?

13. Click Yes. A progress window displays the percentage of the initialization.
14. When the initialization is complete, click Back. The setup of the LSI Configuration Utility Program is

successful if the text in the Drives pane is similar to the following:

Backplane: (252), Slot:0, SAS, HDD, 135.972 GB, Online 
Backplane: (252), Slot:1, SAS, HDD, 135.972 GB, Online

15. Click Exit.
16. At Exit Application, click Yes.
17. After you perform step 16, the interface does not present an interactive screen. Perform the following

steps:
a. Press Ctrl + Alt + Delete on the keyboard to restart the server.
b. When the IBM System x Server Firmware window is displayed (and as the server restarts),

insert the Windows 2008 Recovery CD (the 32-bit version) into the DVD drive of the SSPC server.
Windows loads files. After approximately 5 minutes, the System Recovery Options window opens.

18. Continue by performing one of the following types of recovery:
If you previously backed up your system and you want to recover the image from a shared folder
on a network drive, go to step 3 in Recovering the backup image from a shared folder on a
network drive.
If you previously backed up your system and you want to recover the image from DVDs, go to
step 3 in Recovering the backup image from DVDs.
If you did not back up your system and you want to recover the image, go to step 3 in Recovering
the SSPC image if you did not back it up.

Parent topic: Recovering the SSPC system
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Recovering the SSPC system if you backed it up
This topic explains methods of recovering your backed up SSPC image.
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If your SSPC system does not start and you previously backed it up by using the Windows® Server Backup
feature, you can use the Windows 2008 Recovery CD (that comes with the SSPC) and your backup DVDs to
recover the image. You can also recover the backup image from a shared folder on a network drive. The
backup image that you created with Windows Server Backup can restore the operating system state, volumes,
application data, backup catalog, and local files and folders. To recover the SSPC image, you must have
backed it up previously by using the Full server (all volumes) option, rather than the Critical volumes or
Noncritical volumes option.
Requirement: To recover data using Windows Server Backup, you must be a member of the Windows Backup
Operators or Administrators group, or you must have been delegated with the appropriate authority. The SSPC
Administrator user ID is a member of the Administrators group and has the appropriate authority to perform
recoveries. If you have created an additional SSPC user ID and you want to perform the recovery by using this
ID, see Enabling a non-Administrator user ID to create a backup image.

To obtain complete information about recovering the system, go to http://technet.microsoft.com/en-
us/library/cc753920.aspx. This Web site includes additional information about recovering your server image
by using specific tools.

The topics that follow describe how to recover the backup image from a shared folder on a network drive and
from DVDs.

Recovering the backup image from a shared folder on a network drive
You might need to recover the backed up SSPC system image from a shared folder on a network drive.
Recovering the backup image from DVDs
You might need to recover the backed up SSPC system image from DVDs.

Parent topic: Recovering the SSPC system
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Recovering the backup image from a shared folder on a
network drive

You might need to recover the backed up SSPC system image from a shared folder on a network drive.

To restore your SSPC system image from a shared folder on a network drive, use the procedure in this section.
Before you start, assemble the following materials and ensure that the SSPC server is connected to a
keyboard, video, and mouse (KVM) unit:

The password that you used when you backed up the SSPC image. To recover the image, you must use
this password. Otherwise, you will not be able to log on to Windows®, or access IBM® Tivoli® Storage
Productivity Center or IBM DB2®.
Windows 2008 Recovery CD (use the 32-bit version that comes with your SSPC server)
Administrator user ID and password for the device on which the shared folder resides
IP and DNS addresses for the device on which the shared folder resides
Directory location of the shared folder

Perform the following steps:

1. Turn on the SSPC server.
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2. When the IBM System x Server Firmware window is displayed, insert the Windows 2008 Recovery CD
(the 32-bit version) into the DVD drive of the SSPC server.

Windows loads files. After approximately 5 minutes, the System Recovery Options window opens.

3. Select a language and a keyboard layout, and click Next.
4. Select the operating system to repair. Click Next.
5. At Choose a recovery tool, perform one of the following steps:

If the SSPC server is in a Dynamic Host Configuration Protocol (DHCP) environment,
Windows connects to your network drive. Go to step 8.
If the SSPC server is not in a DHCP environment, perform the following steps to connect to
your network drive:

a. Click Command Prompt.
b. Change the directory by typing cd \sources\recovery\tools and press Enter.
c. To determine whether the SSPC is connected to the network, type wpeinit and press

Enter.
d. To initialize the network, type ipconfig and press Enter.
e. To set the static IP address, type: setipconfig network port 1|2ip addrsubnet
maskgatewayDNS server (where the values are the network port, IP address, subnet
mask address, gateway address and DNS server address of the network drive) and press
Enter. Wait for the Ethernet adapter Local Area Connection information to display.

f. Click the X in the top right to close the command prompt window. The SSPC server
connects to the network drive and returns to the Choose a recovery tool window.

6. Click Windows Complete PC Restore.
7. Click Cancel when you see the following message: A valid backup location could not be
found. Windows cannot find a backup on this computer. Attach the backup hard
disk or insert the final DVD from a backup set and click Retry, click Cancel.

8. At Restore your entire computer from a backup, click Restore a different backup and click Next.
9. At Select the location of the backup, click Advanced.

10. Click Search for a backup on the network.
11. At the message Are you sure you want to connect to the network?, click Yes. The server

connects to the network.
12. In the Network Folder field, type the location of the shared folder on the network drive and click OK.

Refer to the example on the window for the correct format. Type only the root directory (and not any
subdirectories) of the network-attached drive.

13. Type the Administrator user ID and password, and click OK.
14. At Select the location of the backup, click the backup that you want to recover and click Next.
15. Click the backup that has the date and time that you want, and click Next.
16. At Choose how to restore the backup, click Next.
17. Click Finish. Windows presents the message Windows Complete PC Restore will format the

disks you chose to restore, which will erase all existing data.
18. Select the check box I confirm that I want to format the disks and restore the backup, and click OK.

Windows begins restoring the image from the shared folder. The process takes several minutes. When
the image is fully restored, the SSPC server automatically restarts and briefly displays a message that
confirms the recovery.

Parent topic: Recovering the SSPC system if you backed it up
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Recovering the backup image from DVDs
You might need to recover the backed up SSPC system image from DVDs.

To restore the SSPC system image from DVDs, use the following procedure. Before you start, assemble the
following materials and ensure that the SSPC server is connected to a keyboard, video, and mouse (KVM) unit:

The password that you used when you backed up the SSPC image. To recover the image, you must use
this password. Otherwise, you will not be able to log on to Windows®, or access IBM® Tivoli® Storage
Productivity Center or IBM DB2®.
Windows 2008 Recovery CD (use the 32-bit version that comes with your SSPC server)
DVDs that contain your backup image
A completed planning work sheet (see Planning work sheet)

Perform the following steps:

1. Turn on the SSPC server.
2. When the IBM System x Server Firmware window is displayed, insert the Windows 2008 Recovery CD

(the 32-bit version) into the DVD drive of the SSPC server.

Windows loads files. After approximately 5 minutes, the System Recovery Options window opens.

3. Select a language and a keyboard layout, and click Next.
4. Select the operating system to repair. Click Next.
5. At Choose a recovery tool, click Windows Complete PC Restore. Windows presents the message: A
valid backup location could not be found. Windows cannot find a backup on this
computer. Attach the backup hard disk or insert the final DVD from a backup
set and click Retry.

6. Insert the last DVD from your backup group into the external drive and click Retry. Windows scans for
backup disks.

7. At Restore your entire computer from a backup, click Use the latest available backup
(recommended) and click Next.

8. At Choose how to restore the backup, click Next.
9. Click Finish. Windows presents the message: Windows Complete PC Restore will erase all
data on the disks you chose to restore.

10. Select the check box I confirm that I want to erase all existing data and restore the backup, and
click OK. The message The disk is not the requested disk displays, along with the name of a
disk.

11. Remove the disk that is currently in the external drive and insert the disk that is named in the message.
Click OK. Windows continues the recovery.

12. If prompted, insert any remaining disks from your backup group. When the image is fully restored, the
SSPC server automatically restarts and briefly displays a message that confirms the recovery.

Parent topic: Recovering the SSPC system if you backed it up
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Recovering the SSPC image if you did not back it up

124   IBM System Storage Productivity Center 1.4.0

http://www.ibm.com/servers/storage/support/software/tpc/
http://www.ibm.com/legal/


You might need to recover the SSPC system if you did not back it up with the Windows® Server Backup
feature.

If you need to recover the SSPC system but you did not back it up, use the Windows 2008 Recovery CD and
the SSPC Recovery Image DVD to restore the SSPC to its factory image. The recovery CD and the image DVD
come with the SSPC server. Perform the following steps:

Perform the following steps:

1. Turn on or restart the SSPC server.
2. When the IBM System x Server Firmware window is displayed, insert the Windows 2008 Recovery CD

(the 32-bit version) into the DVD drive of the SSPC server.

Windows loads files. After approximately 5 minutes, the System Recovery Options window opens.

3. Select a language and a keyboard layout. Click Next.
4. Click Next.
5. At Choose a recovery tool, click Command Prompt to open a command prompt window.
6. Change the directory by typing cd \sources\recovery\tools and press Enter.
7. At the prompt, type Restoresspc and press Enter. This command is not case-sensitive.
8. When prompted with All data on non-removable disk will be lost. Proceed with
Restore (Y/N)?, type Y and press Enter.

9. When prompted, remove the Windows 2008 Recovery CD from the SSPC server and insert the SSPC
Recovery Image DVD into the server.

10. At the prompt Please insert the SSPC recovery DVD and enter the location of
recovery DVD <d:>?, press Enter.

11. Press any key to continue. The process of restoring the image begins.
12. When the image is fully restored, press any key to continue.
13. Click the X at the top right to close the window.
14. At Choose a recovery tool, remove the SSPC Recovery Image DVD from the SSPC server and perform

one of the following actions:
If you want to restart the server, click Restart. The IBM® System x® Server Firmware window is
displayed while the server restarts. The process takes approximately 10 minutes and the server
automatically restarts again.

The following messages are displayed:

Boot Fail. CD/DVD Rom 
Boot Fail. Floppy Drive

Ignore these messages; they are displayed whenever the server starts or restarts and no disk is
in the CD/DVD drive. The server continues to start. When the Initial Configuration Tasks
window is displayed, configure the computer and network settings by using the instructions in
For the IBM service representative: completing the initial configuration tasks.

Tip: When you configure the computer and network settings, for some SSPC servers the
Password Tool window opens in the foreground and the Initial Configuration Tasks window
opens in the background. The order in which you complete the tasks in these two windows does
not matter.
If you want to shut down the server, click Shut Down. When you start the server again, go to For
the IBM service representative: configuring the operating system and complete all remaining
steps for setting up the SSPC server.

Parent topic: Recovering the SSPC system
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Backing up the IBM Tivoli Storage Productivity Center
database

IBM® Tivoli® Storage Productivity Center uses circular logs for the DB2 database. Therefore, only an offline
database backup is supported. When an offline database backup is performed, the database connections are
terminated. Therefore, the Tivoli Storage Productivity Center servers need to be stopped and then restarted.

1. Close the IBM Tivoli Storage Productivity Center GUI.
2. Stop the IBM Tivoli Storage Productivity Center servers. Click Start > Control Panel > Administrative

Tools > Services. On the Services panel, stop these services:

IBM WebSphere Application Server V6.1 - DeviceServer 
IBM Tivoli Storage Productivity Center Data Server

3. Back up your database.
a. Open the DB2 Control Center. Click Start > All Programs > IBM DB2 > DB2COPY1 > General

Administration Tools > Control Center.
b. The Control Center View panel is displayed. Select Basic and click OK.
c. In the Control Center navigation tree, click All Databases.
d. Expand the All Databases node to see TPCDB. This is the IBM Tivoli Storage Productivity Center

database. Highlight TPCDB and right-click on it. Click Backup.
e. The Confirm the details of your database panel is displayed. Click Next.
f. The Specify where to store your backup image panel is displayed. For Media Type, enter File

System. If you want to add a new folder, click Add.
g. On the Path Browser - LOCALHOST panel, click the Create New Folder icon. Enter the name of

your new folder (for example, TPCbackup1). Click OK.
h. On the Specify where to store your backup image panel, you will see your new folder listed

(TPCbackup1). Click Finish. The database backup will run.
i. When the database backup is completed, you will see a DB2 Message window indicating that the

database backup completed successfully.
j. Close the DB2 Message window.

4. Restart the IBM Tivoli Storage Productivity Center servers. Click Start > Control Panel >
Administrative Tools > Services. On the Services panel, start these services:

IBM WebSphere Application Server V6.1 - DeviceServer 
IBM Tivoli Storage Productivity Center Data Server

Parent topic: Backing up and recovering the SSPC system
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Backing up and recovering Tivoli Storage Productivity Center
for Replication

There are two methods for backing up IBM® Tivoli® Storage Productivity Center for Replication.
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Use the import and export functions of Tivoli Storage Productivity Center for Replication to save the
configuration of each Tivoli Storage Productivity Center for Replication session. Perform the following
steps.

1. Export a Tivoli Storage Productivity Center for Replication session to a comma separated values
(CSV) file.

2. Use the CSV file to recover the Tivoli Storage Productivity Center for Replication session.
Use the High Availability function of Tivoli Storage Productivity Center for Replication. This option
allows Tivoli Storage Productivity Center for Replication to have a real-time backup server that can take
control in the event of a disaster.

For information about these backup options, go to the following links:

http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp?
topic=/com.ibm.rm.doc_4.1.1/frg_c_highavail.html
http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp?
topic=/com.ibm.rm.doc_4.1.1/frg_c_export_copyset.html
http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp?
topic=/com.ibm.rm.doc_4.1.1/frg_c_import_copyset.html

Parent topic: Backing up and recovering the SSPC system
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Upgrading the features of IBM System Storage Productivity
Center

This section provides information on how to upgrade the hardware and licenses for IBM® System Storage™
Productivity Center.

You can upgrade the features of the following components:

Add a IBM Tivoli® Storage Productivity Center license key. See Adding an installation license.
Upgrade the Tivoli Storage Productivity Center. See Upgrading Tivoli Storage Productivity Center.
Upgrade SAN Volume Controller Console. See Upgrading the SAN Volume Controller Console.
Upgrade IBM Tivoli Storage Productivity Center for Replication. See Upgrading Tivoli Storage
Productivity Center for Replication.
Upgrade DSCIMCLI. See Upgrading the DSCIMCLI.

Adding an installation license
If you have installed a package on your system, for example, IBM Tivoli Storage Productivity Center
Basic Edition, and want to add another package to your system (for example, IBM Tivoli Storage
Productivity Center Standard Edition), all you have to do is add the installation license on your system.
This topic provides information on how to add the installation license.
Upgrading Tivoli Storage Productivity Center
This section provides information about how to upgrade IBM Tivoli Storage Productivity Center.
Upgrading the DS8000 GUI
An IBM service representative is responsible for upgrading the IBM System Storage DS8000® graphical
user interface (GUI).
Upgrading the SAN Volume Controller Console
This section provides information about how to upgrade the IBM System Storage SAN Volume
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Controller Console.
Upgrading Tivoli Storage Productivity Center for Replication
When you upgrade IBM Tivoli Storage Productivity Center Version 4.0 or later, IBM Tivoli Storage
Productivity Center for Replication also is upgraded automatically.
Upgrading the DSCIMCLI
If you have an older version of SSPC, you can upgrade the DSCIMCLI to the current level.
Upgrading the DS Storage Manager
Use this information to locate information about how to upgrade the DS Storage Manager.

Support | Terms of use | Feedback
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Adding an installation license
If you have installed a package on your system, for example, IBM® Tivoli® Storage Productivity Center Basic
Edition, and want to add another package to your system (for example, IBM Tivoli Storage Productivity Center
Standard Edition), all you have to do is add the installation license on your system. This topic provides
information on how to add the installation license.

To check the type of license you have, look for .SYS2 files in the installation directory:

TPCBE0401.SYS2
Indicates you have a Tivoli Storage Productivity Center Basic Edition license.

TPCSE0401.SYS2
Indicates you have a IBM Tivoli Storage Productivity Center Standard Edition license.

TPCDATA0401.SYS2
Indicates you have a IBM Tivoli Storage Productivity Center for Data license.

TPCDISK0401.SYS2
Indicates you have a IBM Tivoli Storage Productivity Center for Disk license.

For example, if you want to add the IBM Tivoli Storage Productivity Center Standard Edition package to your
system, complete the following steps:

1. Start the Tivoli Storage Productivity Center installation program from the DVD or image for the license
you want to add.

2. The Select a language panel is displayed. Select a language from the list box and click OK. This is the
language used to install the license.

3. The Software License Agreement panel is displayed. Read the terms of the license agreement. If you
agree with the terms of the license agreement, select I accept the terms of the license agreement.
Click Next.

4. The Select the type of installation panel is displayed. Select Installation Licenses. Click Next.
5. The Database administrator information panel is displayed. Enter the database administrator user ID

and password. Click Next.
6. The Existing database schema information panel is displayed. Enter the information for where the

database is located. Click Next.
7. The successfully installed panel is displayed. Click Finish.
8. Stop the Tivoli Storage Productivity Center GUI.
9. Stop the Device server and Data Server.

10. Start the Data Server and the Device server.
11. Start the Tivoli Storage Productivity Center GUI.
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Upgrading Tivoli Storage Productivity Center
This section provides information about how to upgrade IBM® Tivoli® Storage Productivity Center.

When you upgrade IBM Tivoli Storage Productivity Center Version 4.0 or later, IBM Tivoli Storage Productivity
Center for Replication also is upgraded automatically.

To upgrade Tivoli Storage Productivity Center, follow these general steps.

Important: When you upgrade Tivoli Storage Productivity Center 4.1.1 to a release or patch, the DS Storage
Manager code is removed from the C:\Program
Files\IBM\TPC\device\apps\was\profiles\deviceserver\InstalledApps\DefaultNode\SMLiCJNLPGen.ear
directory. After you upgrade Tivoli Storage Productivity Center, reinstall DS Storage Manager so that the
launch-in-context feature of IBM System Storage™ DS4000® can function properly. To reinstall the
application, use the DS Storage Manager CDs that were provided with SSPC.

1. Download the latest Tivoli Storage Productivity Center 4.1.1 interim fix. Go to
http://www.ibm.com/systems/support/storage/software/tpc/. Click IBM Tivoli Storage Productivity
Center for Data. Click Download. Click Downloadable files.

2. Before continuing this procedure, perform the following steps to change the configuration of the Tivoli
Integrated Portal so that it has the SSPC computer name that you want and not the SSPC computer
name that was assigned by IBM Manufacturing.

a. Open a command prompt window and change the directory to C:\Program
Files\IBM\tivoli\tip\bin.

b. Type wsadmin -lang jython -c AdminControl.stopServer('server1') and press
Enter.

c. Type tipChangeHostName -h hostname and press Enter.
d. Verify that the Tivoli Integrated Portal has stopped by opening C:\Program

Files\IBM\tivoli\tip\profiles\TIPProfile\logs\server1\server1.pid. If Tivoli Integrated Portal is
stopped, the file does not exist. If the file exists, it contains the process ID of Tivoli Integrated
Portal which you can use in the Task Manager to stop Tivoli Integrated Portal.

e. Restart the SSPC server.
3. Start the Tivoli Storage Productivity Center installation program.
4. Select Typical installation.
5. Clear the check boxes for Agents and Register with the agent manager.
6. The "User ID and password, and server and agent information" panel is displayed. Accept the defaults

and click Next. If you changed the DB2® administrative password, you must enter the changed
password here.

7. The "Summary Information" panel is displayed. Review the summary information panel and click
Install.

8. The program will upgrade Tivoli Storage Productivity Center.

For more information about upgrading Tivoli Storage Productivity Center, go to
http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp. Click on Tivoli Storage Productivity Center
> Upgrading.
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Parent topic: Upgrading the features of IBM System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Upgrading the DS8000 GUI
An IBM® service representative is responsible for upgrading the IBM System Storage™ DS8000® graphical
user interface (GUI).

For information about upgrading DS8000 interfaces, go to
http://publib.boulder.ibm.com/infocenter/dsichelp/ds8000ic/index.jsp. Search for Upgrading the interfaces.

Parent topic: Upgrading the features of IBM System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Upgrading the SAN Volume Controller Console
This section provides information about how to upgrade the IBM® System Storage™ SAN Volume Controller
Console.

To upgrade the SAN Volume Controller Console, go to the SAN Volume Controller Information Center at
http://publib.boulder.ibm.com/infocenter/svcic/v3r1m0/index.jsp. Search for Upgrading the master console
software.

Parent topic: Upgrading the features of IBM System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Upgrading Tivoli Storage Productivity Center for Replication
When you upgrade IBM® Tivoli® Storage Productivity Center Version 4.0 or later, IBM Tivoli Storage
Productivity Center for Replication also is upgraded automatically.

To upgrade Tivoli Storage Productivity Center for Replication, see Upgrading Tivoli Storage Productivity
Center.

Parent topic: Upgrading the features of IBM System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
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This information center is powered by Eclipse technology. (http://www.eclipse.org)

Upgrading the DSCIMCLI
If you have an older version of SSPC, you can upgrade the DSCIMCLI to the current level.

Important: In releases of IBM® System Storage® DS8000® Version 8.0 and later, the DS8000 CIM Agent was
disabled. While the hardware for IBM System Storage Productivity Center is still supported, you cannot use it
to monitor DS8000 storage systems where the CIM agent is disabled. To monitor versions 8.0 and later of
DS8000, consider upgrading all the software that it requires, which includes:

Upgrading IBM DB2®.
Purchasing IBM Spectrum Control (formerly known as IBM Tivoli® Storage Productivity Center) to
replace IBM System Storage Productivity Center.

To learn more about upgrading and purchasing software, contact an IBM Sales Specialist at
https://www.ibm.com/systems/storage/spectrum/control/index.html.

Upgrading the DS Storage Manager
Use this information to locate information about how to upgrade the DS Storage Manager.

Follow these steps:

1. From the SSPC desktop, click SSPC Support Links IBM® Tivoli® Storage Productivity Center.
2. Select the Product family: Disk systems.
3. Select the Product: DS3000, DS4000®, or DS5000
4. Under Support & Downloads, scroll down and click Storage Manager.
5. Select the code to download.

Parent topic: Upgrading the features of IBM System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Troubleshooting System Storage Productivity Center
This section provides troubleshooting information for the IBM® System Storage™ Productivity Center.

For servicing or technical support, you will find a wide variety of sources available from IBM to assist you. This
section contains information about where to go for additional information IBM and IBM products, what to do if
you experience a problem with your system, and whom to call for service, if necessary.

There are several icons on your desktop to provide a quick link to the support Web sites for the following:

System Storage Productivity Center
IBM Tivoli® Storage Productivity Center
IBM Tivoli Storage Productivity Center for Replication
SAN Volume Controller
DS8000®
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For specific System Storage Productivity Center troubleshooting topics, see Troubleshooting topics.

Support Web sites
This section provides information for the IBM System Storage Productivity Center.
Documentation
This section provides links to documentation for IBM System Storage Productivity Center.
Before you call
Before you contact customer support, review the problem determination checklist and refer to online
support.
Getting help and information from the World Wide Web
On the World Wide Web, the following IBM Web sites have up-to-date information about IBM systems,
optional devices, services, and support.
Things to know about customer support for SSPC
The IBM System Storage Productivity Center (SSPC) combines an IBM Machine Type 2805 server with
preinstalled storage software that represents a point of centralized management for storage devices.
Contacting customer support
Contact IBM customer support for information and assistance with System Storage Productivity Center.
IBM Taiwan product service
This section provides information about where to call in Taiwan for product service.
Troubleshooting Tivoli Storage Productivity Center problems
This section provides troubleshooting information for IBM Tivoli Storage Productivity Center.

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Support Web sites
This section provides information for the IBM® System Storage™ Productivity Center.

If you encounter a problem, IBM has the following support Web sites to help you determine whether this is a
new problem or an existing problem. These Web sites also have information about flashes, technical notes,
troubleshooting tips, planning and installation information, and download pages for code updates.

IBM DB2®
For information about DB2, go to http://www-306.ibm.com/software/data/db2/support/db2_9/.

IBM System Storage Productivity Center
For information about System Storage Productivity Center, go to
http://www.ibm.com/systems/support/storage/software/sspc.

IBM System x® and xSeries®
Check the following for hardware-related problems:

All cables to ensure they are connected.
The power switches to ensure that the system and all optional devices are turned on.
IBM System x3550 M2 Type 7946 Problem Determination and Service Guide. This guide is
available on the IBM System Storage Productivity Center Documentation CD that comes with your
system. It provides information about the diagnostic tools on the system.

For more information, see http://www.ibm.com/systems/x/.
IBM Tivoli® Storage Productivity Center
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For information about Tivoli Storage Productivity Center, go to
http://www.ibm.com/systems/support/storage/software/tpc/.

IBM Tivoli Storage Productivity Center for Replication
For information about IBM Tivoli Storage Productivity Center for Replication, go to
http://www.ibm.com/systems/support/storage/software/tpc/.

IBM System Storage SAN Volume Controller
For information about SAN Volume Controller, go to http://www.ibm.com/storage/support/2145.

IBM System Storage DS8000® series
For System Storage DS8100, see http://www.ibm.com/servers/storage/support/disk/ds8100/.

For System Storage DS8300, see http://www.ibm.com/servers/storage/support/disk/ds8300/.

IBM System Storage DS3000, DS4000®, or DS5000
For information about DS3000, DS4000, or DS5000, go to
http://www.ibm.com/systems/support/storage/disk.

Engenio SMI-S Provider from LSI
For information about the Engenio SMI-S Provider from LSI, see
http://www.lsi.com/storage_home/products_home/external_raid/management_software/smis_provid
er/index.html.

DS CIM agent
For information about the DS CIM agent, see
http://www.ibm.com/servers/storage/support/software/cimdsoapi/.

Parent topic: Troubleshooting System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Documentation
This section provides links to documentation for IBM® System Storage™ Productivity Center.

For information about links to documentation for System Storage Productivity Center, see the following:

IBM DB2®
Go to http://publib.boulder.ibm.com/infocenter/db2luw/v9/index.jsp. Click Troubleshooting and
support.

IBM Tivoli® Storage Productivity Center
Go to http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp. Click on Tivoli Storage
Productivity Center > Troubleshooting.

IBM Tivoli Storage Productivity Center for Replication
Go to http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp. Click on Tivoli Storage
Productivity Center for Replication > Troubleshooting and Problem Determination.

IBM System Storage SAN Volume Controller
For information about SAN Volume Controller, go to
http://publib.boulder.ibm.com/infocenter/svcic/v3r1m0/index.jsp. Click Troubleshooting.

IBM System Storage DS8000®

For information about the DS8000, go to
http://publib.boulder.ibm.com/infocenter/dsichelp/ds8000ic/index.jsp. Click on Troubleshooting.

From a browser, you can check the following:
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Version
You can confirm that the DS8000 Element Manager is available by entering:

http://ip:port/DS8000/TokenManager?user=getVersion

You will see the following:

R3.0 - will return with the correct version string.
R2.4 - will return with a "NULL" string (this feature is not supported in pre-release 3
versions).
If nothing is returned, the element manager is not accessible.

Login
You can verify that the element manager is running and you are able to login to the element
manager. Enter this:

http://ip:port/DS8000/TokenManager?user=user_name 
&amp;passwd=password

A successful login results in a unique Java™ UID string being returned. This is true for R3 and
R2.4. A "NULL" login means that the login failed. If nothing is returned, the element manager is
unavailable.

DS8000 Element Manager servlets
The DS8000 Element Manager servlets run within the Device server web container. To access
the log file, go to this directory:

TPC_install_dir\device\log\msgTPCDeviceServer.log

DS8000 Element Manager Java Server Page
To access the log file for the DS8000 Element Manager Java Server Page, go to this directory:

TPC_install_dir\device\apps\was\profiles\deviceServer\ 
installedApps\DefaultNode\DeviceServer.ear\DeviceServer.war

There also is a debugging console available. To access the debugging console, a flag needs to be
passed to Java when launching the GUI. This flag is:

var dfConfig = {isDebug: true, "dojoDebugMasterConsole"};

This will cause Tivoli Storage Productivity Center to provide debug information to stdout.
Note: If Tivoli Storage Productivity Center is launched using javaw.exe (as used by the default
in the Windows® shortcut), you will not see any output because javaw.exe hides the console
window. In this case, you need to change the shortcut to use java.exe.

IBM System Storage DS3000, DS4000®, or DS5000
Go to http://www.ibm.com/systems/support/storage/disk.

Parent topic: Troubleshooting System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Before you call
Before you contact customer support, review the problem determination checklist and refer to online support.
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Before you call, ensure that you have taken these steps:

Check all cables to ensure they are connected.
Check the power switches to ensure that the system and all optional devices are turned on.
Check whether connection to the hardware management console (HMC), graphical user interface (GUI),
and CIM agent has been properly established. For example, to determine whether the problem is
connectivity to the DS8000® CIM agent, start by checking the version of the DS8000. Depending on the
version, the DS8000 CIM agent might be embedded in the DS8000 HMC or installed in other external
hardware. If embedded, it might or might not be enabled or started by default. Continue by verifying
that the CIM agent on the DS8000 is running (review the steps in the topics about configuring the SSPC
to specific devices, such as the DS8000; to access these topics, see the online help on the SSPC
desktop or the
Refer to the following troubleshooting information:

IBM System x3550 M2 Type 7946 Problem Determination and Service Guide. This guide is
available on the IBM System Storage Productivity Center Documentation CDthat comes with your
system. It provides instructions about using the diagnostic tools on the system. The
troubleshooting information or the diagnostic tools might tell you that you need additional or
updated device drivers or other software. IBM® maintains pages on the World Wide Web where
you can get the latest technical information and download device drivers and updates. To access
these pages, go to http://www.ibm.com/servers/eserver/support/xseries/index.html and follow
the instructions for System x3550 M2 Type 7946 Model PAS.
contains information about problem determination for System Storage™ Productivity Center,
IBM Tivoli® Storage Productivity Center for Replication, DS8000, DS4000®, DS5000, DS3000,
SAN Volume Controller, and DB2®.

For explanations of error messages for SSPC, IBM Tivoli Storage Productivity Center, or IBM Tivoli
Storage Productivity Center for Replication, visit the IBM System Storage Productivity Center
Information Center at http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp and search on
the error message.
Try to determine whether the problem is related to software or hardware. For example, for hardware,
look for obvious signs of a hardware fault. Error lights on the front panel might indicate a failing
hardware part. Error logs might indicate whether a hardware failure has occurred. If you suspect a
software problem, see the documentation for the operating system or the software product.
If the problem is a software-related problem, you should have these items ready:

Version, release, modification, and service level number or the product that is causing a
problem.
The communication protocol (for example, TCP/IP), version, and release number you are using.
The activity you were doing when the problem occurred, listing the steps you followed before
the problem occurred.
The exact text of any error messages.
Collect relevant log files.

Check for technical information, hints and tips, or submit a request for information by going to the SSPC
Technical Support Web site at http://www.ibm.com/systems/support/storage/software/sspc.

You can also review the IBM Software Support Handbook, a guide to support services that is available at
http://techsupport.services.ibm.com/guides/handbook.html.

Parent topic: Troubleshooting System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)
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Getting help and information from the World Wide Web
On the World Wide Web, the following IBM® Web sites have up-to-date information about IBM systems,
optional devices, services, and support.

The support Web sites offer extensive information, including frequently asked questions (FAQs) and
documentation for all IBM software products, such as Release Notes, Redbooks®, and white papers. The
documentation for some product releases is available in both PDF and HTML formats. Translated documents
are also available for some product releases.

This section includes Web sites that you can access to obtain assistance.

Note: Changes are made periodically to the IBM Web sites. Procedures for locating firmware and
documentation might vary slightly.

For IBM System Storage™ Productivity Center
http://www.ibm.com/systems/support/storage/software/sspc

For IBM System x®
http://www.ibm.com/systems/x/

For IBM Tivoli® Storage Productivity Center
http://www.ibm.com/systems/support/storage/software/tpc/

For IBM Tivoli Storage Productivity Center for Replication
http://www.ibm.com/systems/support/storage/software/tpc/

For IBM System Storage DS8000® series
For System Storage DS8100, see http://www.ibm.com/servers/storage/support/disk/ds8100/.

For System Storage DS8300, see http://www.ibm.com/servers/storage/support/disk/ds8300/.

For IBM System Storage DS3000, DS4000®, and DS5000 series
http://www.ibm.com/servers/storage/support/disk. In the Product field, click the specific product that
you want. Click Go.

For IBM System Storage SAN Volume Controller
http://www.ibm.com/storage/support/2145

For DS CIM Agent
http://www.ibm.com/servers/storage/support/software/cimdsoapi/

You can find service information for IBM systems and optional devices at
http://www.ibm.com/servers/eserver/support/xseries/index.html.

Parent topic: Troubleshooting System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Things to know about customer support for SSPC
The IBM® System Storage™ Productivity Center (SSPC) combines an IBM Machine Type 2805 server with
preinstalled storage software that represents a point of centralized management for storage devices.

Remote support services are available for the individual products that are preinstalled with SSPC. Warranty
and maintenance support for Machine Type 2805 is provided with the sale of the server. Hardware warranty
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terms are 1-year, 7x24 IBM On-Site Service. For IBM Tivoli® Storage Productivity Center, and SAN Volume
Controller (for one year at the initial purchase), further software maintenance is provided with an entitled
software support contract.

Optionally, IBM provides remote technical support for the Linux® or Microsoft® Windows® Server operating
system software through the Windows/Linux Support Line service. This service is not sold with SSPC, but
customers can purchase it through a business partner or IBM sales representative.

Included with the sale of an IBM storage device (for example, the DS Storage Manager and CIM Agent for
DS8000®) is licensed hardware-management software. Defect support for both the storage device and
management software is included under the product warranty for those devices. Non-defect-related support
issues require the purchase of Storage Support Line service. This optional offering provides assistance with
using, configuring, and determining problems associated with the managed storage device. Storage Support
Line service is recommended for the storage devices at the customer location. It is not sold with SSPC, and
the customer may purchase it through a business partner or IBM sales representative.

No single support entry point exists for the SSPC bundle of products. If the issue requires software support
assistance, an IBM customer number for Tivoli Storage Productivity Center, SAN Volume Controller, Support
Line for Windows Operating Systems, or Support Line for Storage is required.

Parent topic: Troubleshooting System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Contacting customer support
Contact IBM® customer support for information and assistance with System Storage™ Productivity Center.

When you contact customer support, be prepared to provide the following information:

Unless you are sure that you have a hardware-specific issue, reference the IBM Tivoli® Storage
Productivity Center. Provide your Tivoli Storage Productivity Center product ID (PID) and customer ID
to receive warranty or Maintenance Agreement support. If the problem is not related to System Storage
Productivity Center hardware or the Tivoli Storage Productivity Center, but is related to another product
(for example, the DS4000® system or the SAN Volume Controller), contact the support center for that
product.
For hardware-specific issues only, reference Machine Type 2805 and the machine's serial number.

Be prepared to provide identification information about your company so that support personnel can readily
assist you. Company identification information may also be needed to access online services available on the
Web site.

For support for IBM System Storage Productivity Center, contact IBM customer support in one of the following
ways:

Go to the System Storage Productivity Center technical support Web site at
http://www.ibm.com/systems/support/storage/software/sspc.

To receive future support notifications, go to the right and from the Stay informed pane, click My
Notifications. Enter your IBM ID and password. Once authenticated, you can configure your
subscription for System Storage Productivity Center technical support Web site updates.
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For customers in the United States, call 1-800-IBM-SERV (1-800-426-7378).
For customers outside the United States, call the support number for your country, available at
http://www.ibm.com/planetwide.

Parent topic: Troubleshooting System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

IBM Taiwan product service
This section provides information about where to call in Taiwan for product service.

IBM® Taiwan product service contact information:

IBM Taiwan Corporation
3F, No 7, Song Ren Rd.
Taipei, Taiwan
Telephone: 0800-016-888

Parent topic: Troubleshooting System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Troubleshooting Tivoli Storage Productivity Center problems
This section provides troubleshooting information for IBM® Tivoli® Storage Productivity Center.

Tivoli Storage Productivity Center provides the following tools to help you diagnose problems with Tivoli
Storage Productivity Center:

Service tool
Repocopy tool

The service tool helps collect information for all installed Tivoli Storage Productivity Center components (for
example, Data server, Device server, and GUI) from a centralized location. This tool detects the configuration
of the system it is running on and collects the appropriate information. The information is placed in a .zip file.
This file is placed in the same directory where the service tool is located. You can send this file to IBM
Support Center to help you resolve problems.
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The service tool does not collect information from the repository database. To collect information from the
repository database, use repocopy.

For information about the service tool, go to the Information Center at
http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp. Click Tivoli Storage Productivity Center >
Administering > Tivoli Storage Productivity Center > Exporting repository tables > Collecting information
for IBM support

The repocopy tool enables you to export all the tables in the Tivoli Storage Productivity Center database
repository, if told to do so by IBM. You can send the output to the IBM Support Center.

For information about the repocopy tool, go to the Information Center at
http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp. Click Tivoli Storage Productivity Center >
Administering > Tivoli Storage Productivity Center > Exporting repository tables > Exporting repository
data.

Parent topic: Troubleshooting System Storage Productivity Center

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Reference
This topic provides reference information for the IBM® System Storage™ Productivity Center.

Reference information
This reference information describes topics that might be helpful when using IBM System Storage
Productivity Center.
Troubleshooting topics
Use these troubleshooting topics to identify a specific problem you are having while running SSPC.
Some topics provide additional information for working around the problem.
Installing System Storage Productivity Center components
You can design a device that is functionally equivalent to System Storage Productivity Center (SSPC) by
installing specific software on a supported server.
Uninstalling IBM System Storage Productivity Center components
This section provides information on how to uninstall the components for IBM System Storage
Productivity Center.
Accessing reports about storage resources
IBM System Storage Productivity Center uses the functionality of IBM Tivoli® Storage Productivity
Center to provide reports about storage resources. These reports are organized into different types and
categories to provide both summary and detailed information about the storage resources in your
environment.
Notices
This information was developed for products and services offered in the U.S.A.
Accessibility features for IBM Tivoli Storage Productivity Center
Accessibility features help users who have a disability, such as restricted mobility or limited vision, to
use information technology products successfully.
Glossary
This glossary includes terms and definitions for the IBM System Storage Productivity Center.
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Support | Terms of use | Feedback
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Reference information
This reference information describes topics that might be helpful when using IBM® System Storage™
Productivity Center.

TCP/IP ports used by System Storage Productivity Center
This topic lists the default ports that should be opened through the firewall when you use IBM System
Storage Productivity Center.
Understanding Internet Protocol Version 6 support
IBM Tivoli® Storage Productivity Center supports Internet Protocol Version 6 (IPv6) for communication
between its components. The key IPv6 enhancement is the expansion of IP address spaces from 32
bits (up to 15 characters in length) to 128 bits (up to 45 characters in length).
Inventory of the System Storage Productivity Center shipment
Use this list to verify that all contents were received with the IBM System Storage Productivity Center
server. Check off each item by the part number.

Parent topic: Reference
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TCP/IP ports used by System Storage Productivity Center
This topic lists the default ports that should be opened through the firewall when you use IBM® System
Storage™ Productivity Center.

Table 1 shows the TCP/IP ports used by System Storage Productivity Center.

For a list of TCP/IP ports used by the IBM Tivoli® Storage Productivity Center family, go to the Information
Center at http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp and search on TCP/IP ports used
by the IBM Tivoli Storage Productivity Center family.

Table 1. TCP/IP ports used by System Storage Productivity Center
Component Default Notes

DB2® 50000  
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Component Default Notes

WebSphere® (Disk
Manager and Replication
Manager also use these
default ports)

81
2810
5567
5568
5569
7874
8009
8881
9044
9086
9091
9444

 

SAN Volume Controller
PuTTY ports for telnet and
ssh

22
23

 

Agent Manager and
common agents

80 (Agent Manager-agent 
recovery service)
9510 (common agent)
9511 (Agent Manager)
9512 (Agent Manager)
9513 (Agent Manager 
public port)
9514 (common agent)
9515 (common agent)

 

Fabric Manager 9550–9572  

Remote console 9560–9582  

Data Manager 2078
9510 (agent listening port)

 

CIM agent for IBM
TotalStorage Enterprise
Storage Server (ESS)

5989  

CIM agent for DS8000® 6989 (for embedded CIM agent, 
cannot be changed)
5989 or 5988 (proxy CIM agent, 
can be changed)

 

IBM Tivoli Storage
Productivity Center
communication with
DS8000 GUI

8451
8452
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Component Default Notes

IBM Tivoli Storage
Productivity Center for
Replication

Incoming communication:

3080
3443
5110
5120

Outgoing communication with ESS, DS, and
SAN Volume Controller:

2433 
5989
6120

SAN Volume Controller CIM agent:

5988
5989

Tip: If you changed the port configuration
of your storage controller, the ports would
be different.

A Web browser typically
communicates with Tivoli Storage
Productivity Center for Replication
GUI using HTTP ports 3080 and
3443. These ports are
configurable from the Tivoli
Storage Productivity Center for
Replication installation program.

The Tivoli Storage Productivity
Center for Replication command
line and GUI typically
communicate with the Tivoli
Storage Productivity Center for
Replication server using port
5110.

Tivoli Storage Productivity Center
for Replication uses port 5120 to
communicate with other Tivoli
Storage Productivity Center for
Replication servers for high-
availability purposes.

Tivoli Storage Productivity
Center and Tivoli Storage
Productivity Center for
Replication

162 (default SNMP listening port) Tivoli Storage Productivity Center
and Tivoli Storage Productivity
Center for Replication share this
port.

Remote console login to
SSPC server

3389  

Tivoli Integrated Portal
server

Inbound

16310, 16311,
16312, 16313,
16315, 16316,
16318, 16320,
16322, 16323

 

Tivoli Integrated Portal to
LDAP authentication

Outbound

389
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Understanding Internet Protocol Version 6 support
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IBM® Tivoli® Storage Productivity Center supports Internet Protocol Version 6 (IPv6) for communication
between its components. The key IPv6 enhancement is the expansion of IP address spaces from 32 bits (up
to 15 characters in length) to 128 bits (up to 45 characters in length).

Overview

You can run Tivoli Storage Productivity Center on computers that are enabled for IPv4, IPv6, or dual stack.
Dual stack indicates that a machine has both the IPv4 and IPv6 stacks enabled and both addresses
configured. The following table shows the internal components of Tivoli Storage Productivity Center that can
communicate with each other using IPv6.

Table 1. IPv6 communication for internal Tivoli Storage Productivity Center components
Components in this column can communicate
over IPv6 with the components in the second
column Tivoli Storage Productivity Center components

User interface Data server

Data server Device server

database repository

Device server database repository

tpctool (command-line tool)

SRMCP

database repository Data server

Device server

Repocopy tool

Tivoli Storage Productivity Center universal agent

tpctool (command-line tool) Device server

SRMCP Device server

Repocopy tool database repository

Tivoli Storage Productivity Center universal
agent

database repository

Tivoli Storage Productivity Center can communicate with the following external components over IPv6:

SMI-S CIM agents
SLP directory agents
Out of band SNMP agents
Storage devices (for example, the DS8000® element manager)
SMTP server

Note: These external components must be IPv6 enabled to communicate with Tivoli Storage Productivity
Center using the IPv6 protocol.

Not all components and their related functions of Tivoli Storage Productivity Center are enabled for IPv6. Any
functions that are not enabled for IPv6 will be unavailable through the user interface when Tivoli Storage
Productivity Center is installed on an IPv6-only system. See for information about the functions that are
currently not supported under IPv6 communication.
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Using IPv6 addresses in the user interface

Support for IPv6 enables you to enter IPv6 addresses anywhere in the interface that supports the entering of
IP addresses. For example, you can enter and display 128-bit IP address spaces on the following panels in
the user interface:

Enter the host name (or IPv6 address) and port number of an Tivoli Storage Productivity Center server
to which you want to connect.

Administrative Services > Data Sources >
Specify IPv4 or IPv6 addresses for the CIMOMs that are located on an IPv6 or dual stack machine.

Administrative Services > Discovery >
Specify IPv6 addresses when you run a discovery with SLP DA running on an IPv6-only or dual stack
machine.

Administrative Services > Data Sources >
Specify IPv6 addresses for the Out of Band Fabric agents that are located on an IPv6 or dual stack
machine.

Administrative Services > Data Sources >
Specify the names or IPv6 addresses of other Tivoli Storage Productivity Center servers that you want
to add as subordinate servers for rollup probes and reports.

Administrative Services > Discovery >
Specify a range of IPv6 addresses for an SNMP discovery on an IPv6-only or dual stack machine
against IPv6-enabled target machines.

Administrative Services > Configuration >
If the Tivoli Storage Productivity Center servers are running on an IPv6-only or dual stack machine
enter the following information:

Specify an IPv6 address for the target machine of SNMP traps that are generated as a result of
triggered alerts.
Specify an IPv6 address for a mail server that will receive emails notifications that are generated
as a result of triggered alerts.

Tivoli Storage Productivity Center > Configuration Utility > Element Manager >
Use an IPv4 or IPv6 address when you specify the URL for an external tool that you want to launch
from Tivoli Storage Productivity Center.

IPv6 considerations in Tivoli Storage Productivity Center
IBM Tivoli Storage Productivity Center provides limited support of some functions when using IPv6
communication.

Parent topic: Reference information
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IPv6 considerations in Tivoli Storage Productivity Center
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IBM® Tivoli® Storage Productivity Center provides limited support of some functions when using IPv6
communication.

Keep in mind the following considerations when using the product on machines configured for IPv6 only:

Starting an element manager into a Web browser
You must use Internet Explorer 7 when you start an element manager into a Web browser. Internet
Explorer 6 does not support URLs that contain literal IPv6 host addresses. You can start element
managers from a number of panels within the user interface:

Click Disk Manager > Storage Subsystems.
Click Disk Manager > Storage Subsystems > details.
Click IBM Tivoli Storage Productivity Center > Configuration Utility > Element Manager tab.

Staring the Tivoli Storage Productivity Center user interface using Java™ Web Start
You cannot use Java Web Start to start the Tivoli Storage Productivity Center user interface on a
Windows® system if both of the following conditions are true:

An IPv6 address or a hostname that resolves to an IPv6 address is specified as the target host in
the Java Web Start URL.
Java Runtime Environment (JRE) 1.4.2 is installed on the same system as the Tivoli Storage
Productivity Center user interface.

Using the Brocade API when adding an out of band fabric agent
You cannot use the advanced Brocade API functions with switches because it does not support IPv6.
Use a CIM agent for managing a switch or enable the IPv4 protocol on the switch. On an IPv6-only
machine, the Enable Advanced Brocade Discovery check box on the panel is disabled.

Using IPv6 communication between master and subordinate servers (for Rollup reporting)
If the master server is located on an IPv6-only computer, it can communicate with existing subordinate
servers under the following conditions: the subordinate servers are upgraded to IBM TotalStorage®
Productivity Center v3.3.2 or higher and the IPv6 protocol is enabled on the computers where they are
located.

Defining Tivoli Enterprise Console® events as triggered actions
You cannot use Tivoli Enterprise Console (TEC) events as triggered actions when defining alerts for
Tivoli Storage Productivity Center jobs.

Selecting files for archive and backup
You cannot select files for Tivoli Storage Manager archive and delete jobs. For example, you cannot use
the alerting function of a constraint to automatically invoke a Tivoli Storage Manager archive or backup
job to run against the files that violate that constraint.

Using Data agents and Fabric agents to collect information about the storage in your environment
Data and Fabric agents cannot communicate with Data and Device servers that have been enabled for
IPv6 and are installed on IPv6-only machines. However, Data and Fabric agents that are located on
IPv4 machines can communicate with Data and Device servers that are installed on machines that have
both IPv4 and IPv6 stacks (dual stack) enabled.
Because of this limitation, the following functions are not available in an IPv6-only environment:

The Agent Manager is disabled under IPv6 communication. Agent Manager and agent
communication can use IPv4 only. The Agent Manager is a network service that provides
authentication and authorization. It also processes queries about its registry of configuration
information about the agents and management applications, and provides an agent recovery
service which is a network service for error logging for agents that cannot communicate with
other Agent Manager services.
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You cannot use Data Manager for Chargeback to charge for storage information. The agents that
collect charge back information do not communicate over IPv6.
You cannot use Data Manager for Databases to monitor relational databases. The agents that
collect relational database information do not communicate over IPv6.
You cannot monitor NetWare and NetApp devices. The agents that collect information about
these devices do not communicate over IPv6.
You cannot monitor VMware ESX servers and Virtual Centers (hypervisors) because they are not
IPv6 enabled.
You cannot monitor HACMP™ and MSCS clusters.

In IPv6-only environments, Tivoli Storage Productivity Center will gather data about devices managed
by:

SMI-S CIM (Common Information Model ) agents (for example, Brocade CIM agents, DS8000K
CIM agents, SVC CIM agents)
Out of Band Fabric SNMP agents
SLP (Service Location Protocol ) directory agents
IPv6-enabled Tivoli Storage Productivity Center servers for rollup probes and reporting

Note: These management components must be IPv6 enabled to communicate with Tivoli Storage
Productivity Center using the IPv6 protocol.

Parent topic: Understanding Internet Protocol Version 6 support
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Inventory of the System Storage Productivity Center shipment
Use this list to verify that all contents were received with the IBM® System Storage™ Productivity Center
server. Check off each item by the part number.

Purpose

Table 1. Shipping list
✓ Part

number
Description

  49Y3575 SSPC Server (System x3550 Server, SSPC Machine Type 2805 Model MC4)

  39Y5533 Line cord (PDU connector)

  P43X323
8

Cardboard shipping bracket

  43V6983 Cable-management arm box

  46C4162 Cable basket

  46C4163 Cable-management arm support arm

  46C4164 Support/stop bracket assembly

  46C4165 Cable-management arm mount clip
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✓ Part
number

Description

  49Y5314 Cable ties, 8.0 inches

  49Y5423 Cable ties, 8.0 inches

  49Y4827 Slide kit

  46C4160 Left slide assembly

  46C4161 Right assembly

  12J5289 M6 hex head screw

  49Y5312 10 32 Shoulder screw

  49Y8842 Windows® software and documentation

  49Y8691 IBM Product CD Microsoft® Windows Server 2008 Enterprise Edition DVD (32–bit)

  49Y8692 IBM Product CD Microsoft Windows Server 2008 Enterprise Edition DVD (64–bit)

  X13-
25990

Windows Server 2008 Getting Started Guide

  X13-
25991

Microsoft Software License Terms

  65G6851 Plastic bag

  59Y7020 IBM Important Notices

  44R5225 IBM Rack installation instructions

  59Y7448 IBM System x3550 M2 Type 7946 Documentation 1.00, Multilingual (CD)

  49Y8635 IBM Director for x86 - Base v6.1.0 DVD

  40M3819 IBM ServeRAID 10.0 Support CD

  45W5651 Read This First: Installing the IBM System Storage Productivity Center for Version 1
Release 4

  45W5652 IBM System Storage Productivity Center Documentation CD Version 1 Release 4

  45W5653 IBM Warranty Information flyer

  X14-
02139

License Windows Server Enterprise Edition 2008

  45W2036 DB2® 9.5 fix pack 3

  45W6798 IBM DB2

  45W6799 IBM Tivoli® Storage Productivity Center Basic Edition for Windows Version 4.1.1

  45W6800 IBM System Storage SAN Volume Controller Version 5.1.0

  45W6801 IBM DS Storage Manager 10.60.35 and IBM System Storage DS® Open Application
Programming Interface (DSCIMCLI) 5.4.3 for SSPC 1.4

  45W6802 Windows 2008 Recovery CD Version 1.4

  45W6803 SSPC Recovery Image DVD Version 1.4
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Troubleshooting topics
Use these troubleshooting topics to identify a specific problem you are having while running SSPC. Some
topics provide additional information for working around the problem.

Error message: A duplicate name exists on the network
This error message is displayed when you have duplicate node names on the network.
Element managers on the same HMC also appear in the element manager table
IBM DS8000® element managers that exist on the same Hardware Management Console (HMC) might
appear in the element manager table at the same time.
Error message: GUI8333E Failed to log in to DS8000 Element manager
You can encounter this message when you attempt to open a DS8000 GUI from the Element Manager
node of Tivoli® Storage Productivity Center and the user credentials are not set for the element
manager. This message also is displayed the first time that you start a DS8000 element manager after
changing the type of user authentication from local operating system (OS) to Lightweight Directory
Access Protocol (LDAP) or Microsoft® Active Directory repository authentication.
Duplicate entries in element manager table
You see duplicate entries in the element manager table for the same element manager.
Cannot save audit logs to System Storage Productivity Center
This error occurs when you are saving the audit logs to IBM System Storage Productivity Center.
Error message: SQL1046N The authorization ID is not valid
You receive this error message when you change the server's host name. DB2® extended security has
been turned on.
Installing the DS Storage Manager GUI fails using the Firefox browser
This problem occurs when you try to install the DS Storage Manager GUI on AIX® using the Firefox
browser.
Tivoli Productivity Center for Replication Add storage subsystem button is disabled
When you are adding a storage subsystem to IBM Tivoli Storage Productivity Center for Replication, the
Add Storage Subsystem button does not function and therefore cannot add a storage subsystem.
Multiple warning windows when accessing Java Web Start
This problem occurs when you access the Java™ Web Start program.
Prompt to download a .jnlp file
This problem occurs when you start the IBM Tivoli Storage Productivity Center graphical user interface
(GUI) from IBM Tivoli Integrated Portal.
Prompt to download and not run a .jnlp file
This problem occurs when you start the IBM Tivoli Storage Productivity Center graphical user interface
(GUI) for the first time from the Windows® Explorer browser.

Parent topic: Reference
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Error message: A duplicate name exists on the network
This error message is displayed when you have duplicate node names on the network.

Problem

When you complete the Windows® setup wizard and the system reboots, the following error message is
displayed:

A duplicate name exists on the network.

Action

Change the node name for the new system. For information about changing the node name, see Changing the
server host name when DB2 extended security is off.

If the problem persists, follow the instructions in Contacting customer support. Before you contact customer
support, read these instructions to familiarize yourself with the information that you must provide.

Parent topic: Troubleshooting topics

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Element managers on the same HMC also appear in the
element manager table

IBM DS8000® element managers that exist on the same Hardware Management Console (HMC) might appear
in the element manager table at the same time.

Problem

This problem occurs if:

1. You manually add an element manager to the Element Manager page and indicate HTTP or HTTPs for
its connection protocol.

2. You add a CIMOM (DS CIM Agent) connection to that element manager.
a. IBM® Tivoli® Storage Productivity Center automatically starts a CIMOM discovery job.
b. Element managers that are managing the same storage subsystems as the CIMOM are

automatically added to the element manager table upon a successful CIMOM discovery job.
3. The CIMOM discovery process in Tivoli Storage Productivity Center might be configured to report IBM

DS8000 element managers that use an IP protocol other than the protocol you defined when adding
the element manager. For example, if you define HTTP for an element manager's protocol, and the
CIMOM discovery job reports another element manager on the same HMC that uses HTTPS, then both
element managers from that HMC will appear on the Element Manager page.

Each CIMOM in your environment has configurable values in a properties files that determine which protocol
(HTTP or HTTPS) to return when reporting upon a registered IBM DS8000's Element Manager URL. By default,

IBM System Storage Productivity Center 1.4.0 149

http://www.ibm.com/servers/storage/support/software/tpc/
http://www.ibm.com/legal/


the CIMOM will return the HTTPS version of the element manager during a successful CIMOM discovery job in
Tivoli Storage Productivity Center.

In this default setup, the HTTPS version of the element manager is automatically added to the element
manager table after a CIMOM discovery, thus resulting in two element managers from the same machine
appearing on the table: the HTTP version of the element manager that was manually added and the HTTPS
version that was automatically added through the CIMOM discovery process.

Action

Edit the values of the properties in the DS CIM Agents /config/provider.configuration file that
determine which element managers are reported during a CIMOM discovery job in Tivoli Storage Productivity
Center. The properties and default values in the provider.configuration file are:

DS_StorageManager_HTTPEnabled = true 
DS_StorageManager_HTTPSEnabled = true

Set a property to false if you want to prevent the CIMOM from reporting an element manager on that protocol.
For example:

1. Set DS_StorageManager_HTTPSEnabled = false.
2. Use the Element Manager page to add an element manager and define HTTP for its protocol.
3. Add a CIMOM connection to the element manager. The CIMOM discovery job in Tivoli Storage

Productivity Center runs and does not report the HTTPS element manager that might be on the same
machine. The element manager on HTTP appears in the Element Manager page only.

If the problem persists, follow the instructions in Contacting customer support. Before you contact customer
support, read these instructions to familiarize yourself with the information that you must provide.

Parent topic: Troubleshooting topics

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
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Error message: GUI8333E Failed to log in to DS8000 Element
manager

You can encounter this message when you attempt to open a DS8000® GUI from the Element Manager node
of Tivoli® Storage Productivity Center and the user credentials are not set for the element manager. This
message also is displayed the first time that you start a DS8000 element manager after changing the type of
user authentication from local operating system (OS) to Lightweight Directory Access Protocol (LDAP) or
Microsoft® Active Directory repository authentication.

Problem

You receive this error message:

GUI8333E Failed to log in to DS8000 Element manager.  Enter valid Username  
and password.

Note: An element manager might be added to the Element Manager table in the course of a CIMOM discovery,
and the discovered element manager will not have user credentials set. The user must add credentials to the
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element manager before they can start the element manager. The CIM agents must also have credentials set
for the CIMOM discovery to be successful. The CIM agent credentials are different from the element manager
credentials. The CIM agent credentials allow Tivoli Storage Productivity Center to communicate with the CIM
agent and collect information during CIMOM discovery. The element manager credentials allow a user to start
the element manager for the particular storage device from the Element Manager page.

The Element Manager page keeps different sets of credentials for each user logged into Tivoli Storage
Productivity Center. To grant a user the right to open a DS8000 Storage Manager, you must log in to Tivoli
Storage Productivity Center as that user and add credentials to the element manager. For example, if you set
the credentials for the element manager as user db2admin, then another user logs in as userx, userx must
set the credentials for that element manager.

This message can occur in these situations:

You have CIM agents 5.2.x, 5.3.x, and 5.4.x that are registered in Tivoli Storage Productivity Center with
the same DS8000. Tivoli Storage Productivity Center performs a CIMOM discovery. This will cause the
duplicate entries in the database table.
You have a CIM agent 5.3.x that is registered in Tivoli Storage Productivity Center with the DS8000.
Tivoli Storage Productivity Center performs a CIMOM discovery. You manually add the element
manager. This will cause duplicate entries in the database table.
You can encounter this message when you attempt to open a DS8000 GUI from the Element Manager
page of Tivoli Storage Productivity Center while logged into Tivoli Storage Productivity Center with a
different user ID from the user ID who added the element manager.
Tivoli Storage Productivity Center finds the element manager in the course of a CIMOM discovery.
When you log into Tivoli Storage Productivity Center, add a CIM agent with CIMOM credentials
(optional, see note below), and then run a CIMOM discovery, the CIM agent will provide the element
manager path, which Tivoli Storage Productivity Center adds to the Element Manager table. The first
time you open the DS8000 GUI, you will see this message.
Note: You do not need to manually add the CIM agent, it can be found on the same subnet if you have
"scan local subnet" selected in CIMOM discovery options, which is the default. If you discover the CIM
agents on the local subnet you will have to modify the DS CIM agent details to add CIM agent
credentials. CIM agent credentials are different from element manager credentials.
The first time after you changed the user authentication method from OS to LDAP and tried to start a
DS8000 element manager. Though you created the truststore certification and activated the LDAP
policy, message GUI8333E is displayed.

Action

To work around this problem, follow these steps:

1. At the error message, click OK. The Modify Element Manager panel is displayed.
2. Enter the correct credentials (username and password). If you changed the authentication method

from OS to LDAP, enter the LDAP credentials.
3. Enter the password again to confirm it.
4. Enter an optional display name.
5. Click Save. The DS8000 element manager that you want automatically starts.

If the problem persists, follow the instructions in Contacting customer support. Before you contact customer
support, read these instructions to familiarize yourself with the information that you must provide.

Parent topic: Troubleshooting topics
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Duplicate entries in element manager table
You see duplicate entries in the element manager table for the same element manager.

Problem

You receive this message:

EMSG_0009E The element manager already exists.

This message can occur in these situations:

You have CIM agents 5.3.x and 5.4.x that are registered with the DS8000®. Tivoli® Storage Productivity
Center performs a CIMOM discovery. You manually add the Element Manager using HTTPS protocol.
This will cause duplicate entries in the element manager table. If you did not specify a Display Name
when manually adding the element manager, the table entries will have the same name:
https://<IP_address_of_element_manager>.
You have a CIM agent (either 5.4.x, 5.3.x, or pre-5.3) which has a DS8000 registered. Tivoli Storage
Productivity Center performs a CIMOM discovery. You manually add the Element Manager using HTTP
protocol. This will cause duplicate entries in the table. If you did not specify a Display Name when
manually adding the element manager, the display names will be nearly the same, differing only in their
protocol. For example http://<IP_address_of_element_manager> for the manually added
element manager, and https://<IP_address_of_element_manager> for the discovered element
manager.

Action

To work around this problem, follow these steps:

1. At the error message, click OK. The Modify Element Manager panel is displayed.
2. Enter the correct credentials (username and password).
3. Enter the password again to confirm it.
4. Enter an optional display name.
5. Click Save. The DS8000 element manager that you want automatically launches.

If the problem persists, follow the instructions in Contacting customer support. Before you contact customer
support, read these instructions to familiarize yourself with the information that you must provide.

Parent topic: Troubleshooting topics

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
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Cannot save audit logs to System Storage Productivity Center
This error occurs when you are saving the audit logs to IBM® System Storage™ Productivity Center.
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Problem

You receive this error message when you try to save the audit logs to System Storage Productivity Center:

Your current security settings do not allow this 
file to be downloaded. 

The security settings and alert is a function of Internet Explorer and not IBM Tivoli® Storage Productivity
Center or the DS8000® GUI. The cause could be because the Internet Explorer security settings are set too
high to allow the download of files.

Action

To change the security settings, follow these steps:

1. In Internet Explorer, click Tools > Internet Options . Click on the Security tab.
2. Select Internet. Click Custom Level.
3. Scroll down to Downloads. Change Automatic prompting for file downloads to Enable. Change File

download to Enable. Click OK.

If the problem persists, follow the instructions in Contacting customer support. Before you contact customer
support, read these instructions to familiarize yourself with the information that you must provide.

Parent topic: Troubleshooting topics

Support | Terms of use | Feedback
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Error message: SQL1046N The authorization ID is not valid
You receive this error message when you change the server's host name. DB2® extended security has been
turned on.

Problem

When changing the server's host name and you run this command:

db2extsec /u db2users /a db2admns

You receive this error message:

SQL1046N  The authorization ID is not valid.

When changing the server's host name, the new host name cannot begin with the following:

SYS
sys
IBM®
ibm
SQL
sql
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Action

Select another host name that meets the requirements above and begin the host rename process again.

If the problem persists, follow the instructions in Contacting customer support. Before you contact customer
support, read these instructions to familiarize yourself with the information that you must provide.

Parent topic: Troubleshooting topics
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(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Installing the DS Storage Manager GUI fails using the Firefox
browser

This problem occurs when you try to install the DS Storage Manager GUI on AIX® using the Firefox browser.

Problem

You try to download or install the DS Storage Manager GUI on AIX using the Firefox browser.

Action

Follow these steps:

1. Open the Firefox browser.
2. Click on the toolbar Tools > Options.
3. Select the Content tab on the Options dialog box.
4. Click on Manage in the box File Types.
5. In the Download Actions dialog box, select .jnlp from the list box.
6. Click on Change Action.
7. Select the radio button Open them with this application. This opens the file selector dialog box.
8. Navigate to the directory <Java_home>/jre/javaws.
9. Select the javaws file from the file list.

Note: For Windows®, select javaws.exe.
10. Click Open.
11. Close the Download Actions dialog box.
12. Close the Options dialog box.

If the problem persists, follow the instructions in Contacting customer support. Before you contact customer
support, read these instructions to familiarize yourself with the information that you must provide.

Parent topic: Troubleshooting topics

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)
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Tivoli Productivity Center for Replication Add storage
subsystem button is disabled

When you are adding a storage subsystem to IBM® Tivoli® Storage Productivity Center for Replication, the Add
Storage Subsystem button does not function and therefore cannot add a storage subsystem.

Problem

This problem occurs when you perform the following steps:

1. You log on to IBM System Storage™ Productivity Center and start IBM Tivoli Storage Productivity Center
for Replication by double-clicking the TPC for Replication icon on the desktop.

2. From the Tivoli Storage Productivity Center navigation navigation, you clicked Storage Systems.
3. When you click Add Storage System, the button seems disabled and it does not open the Add storage

subsystem window.

Action

1. From the Storage Subsystem panel with the Add Storage System button, double-click the message on
the browser that reads Certificate Error.

2. Complete the wizard to import the security certificate that was missing.
3. Return to the Storage Systems panel and click Add Storage System to open Add Subsystem Wizard.

If the problem persists, follow the instructions in Contacting customer support. Before you contact customer
support, read these instructions to familiarize yourself with the information that you must provide.

Parent topic: Troubleshooting topics
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Multiple warning windows when accessing Java Web Start
This problem occurs when you access the Java™ Web Start program.

Problem

When accessing the Java Web Start program so that you can start IBM® Tivoli® Storage Productivity Center,
you repeatedly receive windows that are titled Warning - Hostname Mismatch. This problem occurs whether
you use the Microsoft® Internet Explorer or Mozilla Firefox Web browser.

Action

In each Warning-Hostname Mismatch window, click Run. Continue to click Run in each Warning-Hostname
Mismatch window until they no longer display and you see the IBM Tivoli Storage Productivity Center login
window. Type the required information in the login window to access IBM Tivoli Storage Productivity Center.
Parent topic: Troubleshooting topics

IBM System Storage Productivity Center 1.4.0 155

http://www.ibm.com/servers/storage/support/software/tpc/
http://www.ibm.com/legal/


Support | Terms of use | Feedback
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Prompt to download a .jnlp file
This problem occurs when you start the IBM® Tivoli® Storage Productivity Center graphical user interface
(GUI) from IBM Tivoli Integrated Portal.

Problem

When you start the Tivoli Storage Productivity Center GUI for the first time from the Tivoli Integrated Portal,
you might be prompted to download a .jnlp file.

Action

If you see this prompt, save the file. Then manually install the Java™ Runtime Environment. To install the Java
Runtime Environment, go to http://SSPCServer:9550/ITSRM/app/en_US/index.html, where
SSPCServer is the computer name of the SSPC server. Choose the appropriate operating system and follow the
steps to perform the installation. After you install Java Runtime Environment, start the Tivoli Storage
Productivity Center GUI.

Parent topic: Troubleshooting topics
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Prompt to download and not run a .jnlp file
This problem occurs when you start the IBM® Tivoli® Storage Productivity Center graphical user interface
(GUI) for the first time from the Windows® Explorer browser.

Problem

When you start the Tivoli Storage Productivity Center GUI, you receive a prompt asking whether to download,
save, and not run a .jnlp file. Two reasons are possible:

IBM Java™, which is preinstalled on the IBM System Storage™ Productivity Center server, was
uninstalled.
The default start program for .jnlp changed from javaws.exe to another program.

Action

If you see this prompt, perform the following steps to change the program that opens the .jnlp file to
javaws.exe (from Microsoft® Notepad or any other program):

1. Click Cancel to remove the prompt.
2. From Microsoft Internet Explorer, click Tools > Internet Options > Programs. The Internet Options

window is displayed.
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3. From Internet programs, click Set programs. The Default Programs window is displayed.
4. Click Associate a file type or protocol with a program. The Set Associations window is displayed.
5. Scroll to .jnlp, and in the Current Default column, verify that the file type of .jnlp is opened by the Java

WebStart Executable program, and not by Notepad or Microsoft Windows Wordpad.
6. Click Change program. The Open With window is displayed.
7. Click to select Java WebStart Executable IBM as the program that you want to open the .jnlp file, and

click OK.
8. Close the Internet Options window, return to where you first attempted to run the .jnlp file, and run the

file again.

Parent topic: Troubleshooting topics
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Installing System Storage Productivity Center components
You can design a device that is functionally equivalent to System Storage™ Productivity Center (SSPC) by
installing specific software on a supported server.

If you choose to create a functionally equivalent device, you must install the following software in this order:

1. IBM® DB2® V9.5 with Fix Pack 3
2. IBM Tivoli® Storage Productivity Center Basic Edition 4.1.1
3. IBM Tivoli Storage Productivity Center for Replication 4.1.1
4. SAN Volume Controller Console version 5.1.0
5. DS CIM agent management commands (DSCIMCLI) 5.4.3

Installing System Storage Productivity Center
This topic provides information about installing IBM System Storage Productivity Center equivalent
components.
Installing the SAN Volume Controller Console
This section provides information about installing the SAN Volume Controller Console. The SAN Volume
Controller Console installation includes the SAN Volume Controller CIM agent.
Installing the agents and Agent Manager
You can install the agents and Agent Manager to collect additional information from the machines or
storage systems.

Parent topic: Reference
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Installing System Storage Productivity Center
This topic provides information about installing IBM® System Storage™ Productivity Center equivalent
components.
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To install System Storage Productivity Center, follow these general steps:

1. Install DB2® d. For information about installing, see the IBM Tivoli® Storage Productivity Center
Information Center at this Web site: http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp.
Click IBM Tivoli Storage Productivity Center V4.1.1 > Installing > DB2.

2. Install Tivoli Storage Productivity Center 4.1.1. Do not install the Agent Manager or agents. For
information about installing the product, see the IBM Tivoli Storage Productivity Center Information
Center at this Web site: http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp. Click IBM
Tivoli Storage Productivity Center V4.1.1 > Installing > IBM Tivoli Storage Productivity Center >
Using typical installation.

3. If you are using the SAN Volume Controller. Follow these steps:
a. Install PuTTY (for SAN Volume Controller).
b. Install the SAN Volume Controller Console 5.1.0.
c. Configure the SAN Volume Controller Console. See Configuring SSPC for SAN Volume Controller.

4. Install the DS3000, DS4000®, or DS5000 Storage Manager GUI. See Configuring SSPC for DS3000,
DS4000, and DS5000.

Parent topic: Installing System Storage Productivity Center components
Related information
<_a><_div>
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Installing the SAN Volume Controller Console
This section provides information about installing the SAN Volume Controller Console. The SAN Volume
Controller Console installation includes the SAN Volume Controller CIM agent.

To install the SAN Volume Controller Console and CIM agent, follow these steps:

1. Install PuTTY (for SAN Volume Controller).
2. Install the SAN Volume Controller Console 5.1.0. For information about installing the SAN Volume

Controller Console, SAN Volume Controller Information Center at
http://publib.boulder.ibm.com/infocenter/svcic/v3r1m0/index.jsp. Search for Upgrading the SAN
Volume Controller Console.

3. After you install the SAN Volume Controller Console, there are configuration steps to follow. See
Configuring SSPC for SAN Volume Controller.

Parent topic: Installing System Storage Productivity Center components
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(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Installing the agents and Agent Manager

158   IBM System Storage Productivity Center 1.4.0

http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp
http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp
http://publib.boulder.ibm.com/infocenter/svcic/v3r1m0/index.jsp
http://www.ibm.com/servers/storage/support/software/tpc/
http://www.ibm.com/legal/
http://publib.boulder.ibm.com/infocenter/svcic/v3r1m0/index.jsp
http://www.ibm.com/servers/storage/support/software/tpc/
http://www.ibm.com/legal/


You can install the agents and Agent Manager to collect additional information from the machines or storage
systems.

The Agent Manager server is a network service that provides authentication and authorization services and
maintains a registry of configuration information about the managed systems in your environment. The Agent
Manager is required only if you plan on installing the agents.

The Data agents collect information from the machine or host on which they are installed. The agents collect
asset information, file and filesystem attributes, and any other information needed from the computer system.
Data agents can also gather information on database managers installed on the server, Novell NDS tree
information, and NAS device information.

Fabric agents use scanners to collect information. The Fabric agents are installed on the computer systems
that have fiber optic connectivity (through HBAs) into the SAN fabrics that you want to manage and monitor.
The agents collect fabric topology information, port state information, and zoning information. The Fabric
agents can identify other SAN-attached devices (if they are in the same zone).

If you have an Agent Manager already installed in your environment, you do not have to install another Agent
Manager.

The agents and Agent Manager are shipped with IBM® Tivoli® Storage Productivity Center.

Before you install the agents and Agent Manager

If you are installing the agents and have changed your host name on the SSPC server, you must change the
InstallVariable.properties file with the new host name. Follow these steps:

1. Go to the following directory:

C:\Program Files\IBM\TPC\config\

2. Change the parameters in the InstallVariable.properties file:

varDataSrvName=localhost 
varDevSrvName=localhost

To your fully qualified host name on the SSPC server:

varDataSrvName=tron.storage.usca.ibm.com 
varDevSrvName=tron.storage.usca.ibm.com

3. Save the file.
4. Restart the Device server and Data server.

If you are going to deploy the agent, follow these steps before deploying the agent:

1. Modify the setup.properties file. Go to the following directory:

C:\Program Files\TPC\device\conf\

2. In the setup.properties file, modify the following parameters to the fully-qualified host name:

manager.loc=fully_qualified_host_name  
agent.deployer=fully_qualified_host_name

3. Save the file.
4. Restart the Device server.
5. Run the agent deployment.
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Procedure

There are several steps involved with installing and activating theAgent Manager and agents. These steps
assume that Tivoli Storage Productivity Center is already installed:

1. If you are installing the Agent Manager on a machine that does not have DB2® installed, install DB2
V9.5 with Fix Pack 3. To install DB2, see the Tivoli Storage Productivity Center Information Center at
http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp. Click IBM Tivoli Storage
Productivity Center V4.1.1> Installing > DB2.

2. Install the Agent Manager. For information about installing the Agent Manager, see the IBM Tivoli
Storage Productivity Center Information Center. Click IBM Tivoli Storage Productivity Center V4.1.1 >
Installing > IBM Tivoli Storage Productivity Center > Agent Manager.

3. Register the Device server and Data server with the Agent Manager. For information about registering
the servers with the Agent Manager, see the IBM Tivoli Storage Productivity Center Information Center
and search for Agent Manager Registration.

4. Install the agents (Data agent and Fabric agent). For information about installing the agents, see the
IBM Tivoli Storage Productivity Center Information Center. Click IBM Tivoli Storage Productivity
Center V4.1 > Installing the IBM Tivoli Storage Productivity Center family > IBM Tivoli Storage
Productivity Center > Installing the agents.
Note: Before installing any agents, restart the Data server and Device server on the SSPC server. To
start the servers on Windows, go to Start > Settings > Control Panel > Administrative Tools >
Services. On the Services Window, right-click on each of the following services and click Stop and then
Start:

IBM WebSphere Application Server V6 - DeviceServer 
IBM Tivoli Storage Productivity Center - Data Server

Parent topic: Installing System Storage Productivity Center components
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Uninstalling IBM System Storage Productivity Center
components

This section provides information on how to uninstall the components for IBM® System Storage™ Productivity
Center.

To uninstall the System Storage Productivity Center, you must uninstall the components in a specific order.
Uninstall the components and related software in this order:

1. Uninstall IBM Tivoli® Storage Productivity Center and related software.
Uninstall the components in this order:

a. Data server, Device server, GUI, and CLI.
b. Database schema (this can be local or remote).

All of these components can be uninstalled at the same time.

For information about uninstalling Tivoli Storage Productivity Center and IBM Tivoli Storage
Productivity Center for Replication, go to
http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp. Click IBM Tivoli Storage
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Productivity Center V4.1.1 > Uninstalling > Uninstalling the IBM Tivoli Storage Productivity Center
family using the uninstallation program.

2. Uninstall DB2. For information about uninstalling DB2, go to
http://publib.boulder.ibm.com/infocenter/db2luw/v9/index.jsp?. Search for Uninstalling your DB2
product.

3. Uninstall the SAN Volume Controller Console. For information about uninstalling the SAN Volume
Controller Console, see http://publib.boulder.ibm.com/infocenter/svcic/v3r1m0/index.jsp. Search for
Uninstalling master console software.

4. Uninstall the DS CIM agent management commands (DSCIMCLI). Go to the directory where the DS CIM
agent management commands were unzipped. Delete all files in the DSCIMCLI folder. The default
directory and folder are:

C:\Program Files\IBM\DSCIMCLI

5. If you installed the DS4000® Storage Manager GUI using the Java Web Start application, you can
uninstall the application. See Uninstalling the DS3000, DS4000, or DS5000 Storage Manager GUI.

Uninstalling the DS3000, DS4000, or DS5000 Storage Manager GUI
To uninstall the DS3000, DS4000, or DS5000 Storage Manager GUI, follow this procedure.

Parent topic: Reference
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Uninstalling the DS3000, DS4000, or DS5000 Storage Manager
GUI

To uninstall the DS3000, DS4000®, or DS5000 Storage Manager GUI, follow this procedure.

To uninstall the DS3000, DS4000, or DS5000 Storage Manager GUI, you must have administrative authority.
Follow these steps.

On Windows
Follow these steps:

1. Click Start > Settings > Control Panel.
2. Double-click Add/Remove Program.
3. Find IBM System Storage product–FAStT Storage Manager 10 - Java Web Start where
product is DS3000, DS4000, or DS5000.

4. Click Remove.
5. You will receive a message asking if you want to remove the program. Click OK if you want to

remove the program.

If the preceding procedure does not uninstall the GUI, follow these steps:

1. Launch Java Web Start from the path C:\Program
Files\Java\jre1.5.XX\bin\javaws.exe.

2. The Java Web Start Application Manager window is displayed. Select DS4000 from the Java Web
Start Application Manager window.

3. Remove the application by clicking Application > Remove Application.
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On UNIX or Linux
Follow these steps:

1. Go to the following directory:

usr/name_of_file/bin

2. Run javaws.
3. The Java Web Start Application window is displayed. Select DS4000 from the Java Web Start

Application Manager window.
4. Remove the application by clicking Application > Remove Application.

Parent topic: Uninstalling IBM System Storage Productivity Center components
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Accessing reports about storage resources
IBM® System Storage™ Productivity Center uses the functionality of IBM Tivoli® Storage Productivity Center to
provide reports about storage resources. These reports are organized into different types and categories to
provide both summary and detailed information about the storage resources in your environment.

Data that appears in reports is based on statistical information accumulated by data collection jobs and
stored in the database repository. You can select the specific systems, storage subsystems, switches,
clusters, disks, and file systems upon which you want to report.

Reports are organized into report types and categories, which can be expanded in the navigation tree to reveal
additional sub-categories of reporting. Some reports are also accessible through the topology viewer.

Reporting types: system reports, user ID reports, user-defined online reports
Report categories: asset, Tivoli Storage Productivity Center-wide storage space (capacity), monitored
computer storage space, storage subsystem, tape library, data source

For an example of the reports you can generate see Table 1. Use this table to determine which reports are
most useful to you and which data collection jobs to run for those reports.

For more information about the categories of reports that are available to the IBM System Storage
Productivity Center, go to the IBM Tivoli Storage Productivity Center Information Center at
http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp and search for Reporting.

Table 1. Reports available for IBM Tivoli Storage Productivity Center Basic Edition
Report Category Description What data collection job

should I run for this report?
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Report Category Description What data collection job
should I run for this report?

Asset reports View itemized statistics about your storage
resources in a hierarchy that lets you see the
resources in greater detail.

Location: These reports are available in the
following locations on the navigation tree:

IBM Tivoli Storage Productivity Center >
Reporting > My Reports (if you save the
definition of an online report it appears
in this location)
Data Manager > Reporting > Asset

Probes, Discovery

TPC-wide storage space Identify how much storage space is used and
unused on the disks and file systems in your
environment.

Location: These reports are available in the
following locations on the navigation tree:

IBM Tivoli Storage Productivity Center >
Reporting > My Reports (if you save the
definition of an online report it appears
in this location)
Data Manager > Reporting > TPC-wide
Storage Space

Example: Identify how much storage space is
being used on the file systems within your
environment, and how much unused storage
space is available.

Probes

Monitored computer
storage space

Use these host-based reports to view the data
that is collected by probes for computers,
network-attached storage, and hypervisors.
These reports contain detailed information
about the consumption of file system space and
enable you to relate that space back to external
or internal storage without counting shared
space multiple times.

Location: These reports are available in the
following locations on the navigation tree:

IBM Tivoli Storage Productivity Center >
Reporting > My Reports (if you save the
definition of an online report it appears
in this location)
Data Manager > Reporting > Monitored
Computer Storage Space

Probes
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Report Category Description What data collection job
should I run for this report?

Storage subsystem
reports

View storage capacity for a computer, file
system, storage subsystem, volume, array site,
rank, and disk. These reports also enable you to
view the relationships among the components
of a storage subsystem.

Location:

Disk Manager > Reporting > Storage
Subsystems
IBM Tivoli Storage Productivity Center >
Reporting > My Reports (if you save the
definition of an online report it appears
in this location)

Example: View the relationships among the
components of a storage subsystem and the
storage capacity for a computer, file system,
storage subsystem, volume, array site, rank,
and disk.

Probes

Data source reports Use data source reports to view detailed
information about the agents from which Tivoli
Storage Productivity Center collects
information about storage resources. Data
sources include CIMOM agents, Data agents,
Fabric agents, VMWare, and subordinate Tivoli
Storage Productivity Center servers.

Location: IBM Tivoli Storage Productivity
Center > Reporting > Data Source Reports

Example: View detailed information about the
CIM Agents that have been added to Tivoli
Storage Productivity Center as data sources.

These reports are available
for data sources that have
been associated with Tivoli
Storage Productivity Center.

Parent topic:  Tivoli Storage Productivity Center Basic Edition
Parent topic: Reference
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Notices
This information was developed for products and services offered in the U.S.A.

IBM® may not offer the products, services, or features discussed in this document in other countries. Consult
your local IBM representative for information on the products and services currently available in your area.
Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product, program, or service that does
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not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to
evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document.
The furnishing of this document does not grant you any license to these patents. You can send license
inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual
Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
3-2-12, Roppongi, Minato-ku
Tokyo 106-8711 Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of
express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made
to the information herein; these changes will be incorporated in new editions of the publication. IBM may
make improvements and/or changes in the product(s) and/or the program(s) described in this publication at
any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any
manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the
materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange
of information between independently created programs and other programs (including this one) and (ii) the
mutual use of the information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road 
Austin, TX 78758
U.S.A

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM
under terms of the IBM Customer Agreement, IBM International Program License Agreement or any
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equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results
obtained in other operating environments may vary significantly. Some measurements may have been made
on development-level systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published
announcements or other publicly available sources. IBM has not tested those products and cannot confirm
the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the
capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them
as completely as possible, the examples include the names of individuals, companies, brands, and products.
All of these names are fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

Trademarks
Important notes
Safety and environmental notices
Be sure to read all caution and danger statements in this document before using this product. Read any
additional safety information that comes with the server or optional device before you install the
device. The environmental notices that apply to this product are provided in the IBM Environmental
Notices and User Guide, Z125-5823. This guide is located on the IBM System Storage Productivity
Center Documentation CD.
Electronic emission notices
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Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines
Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of
IBM or other companies. A current list of IBM trademarks is available on the Web at "Copyright and trademark
information" at http://www.ibm.com/legal/copytrade.shtml.

Adobe is a registered trademark of Adobe Systems Incorporated in the United States, and/or other countries.

Itanium is a trademark or registered trademark of Intel Corporation or its subsidiaries in the United States and
other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.
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Parent topic: Notices

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Important notes
Processor speeds indicate the internal clock speed of the microprocessor; other factors also affect
application performance.
CD or DVD drive speed is the variable read rate. Actual speeds vary and are often less than the possible
maximum.
When referring to processor storage, real and virtual storage, or channel volume, KB stands for 1024
bytes, MB stands for approximately 1 048 576 bytes, and GB stands for approximately 1 073 741 824
bytes.
When referring to hard disk drive capacity or communications volume, MB stands for 1 000 000 bytes,
and GB stands for 1 000 000 000 bytes. Total user-accessible capacity can vary depending on
operating environments.
Maximum internal hard disk drive capacities assume the replacement of any standard hard disk drives
and population of all hard disk drive bays with the largest currently supported drives that are available
from IBM®.
Maximum memory may require replacement of the standard memory with an optional memory module.
IBM makes no representation or warranties regarding non-IBM products and services that are
ServerProven®, including but not limited to the implied warranties of merchantability and fitness for a
particular purpose. These products are offered and warranted solely by third parties.
IBM makes no representations or warranties with respect to non-IBM products. Support (if any) for the
non-IBM products is provided by the third party, not IBM.
Some software might differ from its retail version (if available), and might not include user manuals or
all program functionality.

Parent topic: Notices

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Safety and environmental notices
Be sure to read all caution and danger statements in this document before using this product. Read any
additional safety information that comes with the server or optional device before you install the device. The
environmental notices that apply to this product are provided in the IBM Environmental Notices and User
Guide, Z125-5823. This guide is located on the IBM System Storage Productivity Center Documentation CD.

Safety information
Before installing this product, read the Safety Information.
Notices and statements in this document
You can locate the translated version of any safety notice or statement in this document.
Safety notices
United Kingdom telecommunications safety requirement
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Other safety information
IBM® System Storage™ Productivity Center has specific requirements for voltage, usage with visual-
display workplace devices, and usage of a telecommunication line cord.
Particulate Contamination
This topic identifies contamination information.

Parent topic: Notices

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Safety information
Before installing this product, read the Safety Information.

Antes de instalar este produto, leia as Informações de Segurança.

Læs sikkerhedsforskrifterne, før du installerer dette produkt.

Lees voordat u dit product installeert eerst de veiligheidsvoorschriften.

Ennen kuin asennat tämän tuotteen, lue turvaohjeet kohdasta Safety Information.

Avant d'installer ce produit, lisez les consignes de sécurité.

Vor der Installation dieses Produkts die Sicherheitshinweise lesen.

Prima di installare questo prodotto, leggere le Informazioni sulla Sicurezza.

Les sikkerhetsinformasjonen (Safety Information) før du installerer dette produktet.

Antes de instalar este produto, leia as Informações sobre Segurança.

Antes de instalar este producto, lea la información de seguridad.
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Läs säkerhetsinformationen innan du installerar den här produkten.

Parent topic: Safety and environmental notices

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Notices and statements in this document
You can locate the translated version of any safety notice or statement in this document.

Important:

Each caution and danger statement in this document is labeled with a number. This number is used to cross
reference an English-language caution or danger statement with translated versions of the caution or danger
statement in the multilingual IBM® Safety Information document which is located on the documentation CD
that came with the product.

For example, if a caution statement is labeled "Statement 1," translations for that caution statement are in the
IBM Safety Information document under "Statement 1."

Be sure to read all caution and danger statements in this document before you perform the procedures. Read
any additional safety information that comes with the server or optional device before you install the device.

The following notices and statements may be used in this document:

Attention: These notices indicate potential damage to programs, devices, or data. An attention notice
is placed just before the instruction or situation in which damage could occur.
Caution: These statements indicate situations that can be potentially hazardous to you. A caution
statement is placed just before the description of a potentially hazardous procedure step or situation.
Danger: These statements indicate situations that can be potentially lethal or extremely hazardous to
you. A danger statement is placed just before the description of a potentially lethal or extremely
hazardous procedure step or situation.

Parent topic: Safety and environmental notices

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Safety notices

Statement 1

DANGER

Electrical current from power, telephone, and communication cables is hazardous.
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To avoid a shock hazard:

Do not connect or disconnect any cables or perform installation, maintenance, or reconfiguration of this
product during an electrical storm.
Connect all power cords to a properly wired and grounded electrical outlet.
Connect to properly wired outlets any equipment that will be attached to this product.
When possible, use one hand only to connect or disconnect signal cables.
Never turn on any equipment when there is evidence of fire, water, or structural damage.
Disconnect the attached power cords, telecommunications systems, networks, and modems before
you open the device covers, unless instructed otherwise in the installation and configuration
procedures.
Connect and disconnect cables as described in the following table when installing, moving, or opening
covers on this product or attached devices.

To Connect: To Disconnect:

1. Turn everything OFF.
2. First, attach all cables to devices.
3. Attach signal cables to connectors.
4. Attach power cords to outlet.
5. Turn device ON.

1. Turn everything OFF.
2. First, remove power cords from outlet.
3. Remove signal cables from connectors.
4. Remove all cables from devices.

Statement 2

CAUTION:
When replacing the lithium battery, use only IBM® Part Number 33F8354 or an equivalent type battery
recommended by the manufacturer. If your system has a module containing a lithium battery, replace it only
with the same module type made by the same manufacturer. The battery contains lithium and can explode if
not properly used, handled, or disposed of.
Do not:

Throw or immerse into water
Heat to more than 100°C (212°F)
Repair or disassemble

Dispose of the battery as required by local ordinances or regulations.

Statement 3

CAUTION:
When laser products (such as CD-ROMs, DVD drives, fiber optic devices, or transmitters) are installed, note
the following:

Do not remove the covers. Removing the covers of the laser product could result in exposure to
hazardous laser radiation. There are no serviceable parts inside the device.
Use of controls or adjustments or performance of procedures other than those specified herein might
result in hazardous radiation exposure.
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DANGER
Some laser products contain an embedded Class 3A or Class 3B laser diode. Note the following.

Laser radiation when open. Do not stare into the beam, do not view directly with optical instruments, and
avoid direct exposure to the beam.

Statement 4

≥ 18 kg (39.7 lb) ≥ 32 kg (70.5 lb) ≥ 55 kg (121.2 lb)

CAUTION:
Use safe practices when lifting.

Statement 5

CAUTION:
The power control button on the device and the power switch on the power supply do not turn off the
electrical current supplied to the device. The device also might have more than one power cord. To remove all
electrical current from the device, ensure that all power cords are disconnected from the power source.

Statement 6

CAUTION:
Do not place any objects on top of a rack-mounted device unless that rack-mounted device is intended for use
as a shelf.

IBM System Storage Productivity Center 1.4.0 171



Statement 8

CAUTION:
Never remove the cover on a power supply or any part that has the following label attached.

Hazardous voltage, current, and energy levels are present inside any component that has this label attached.
There are no serviceable parts inside these components. If you suspect a problem with one of these parts,
contact a service technician.

Statement 12

CAUTION:
The following label indicates a hot surface nearby.

Statement 26

CAUTION:
Do not place any object on top of rack-mounted devices.

Parent topic: Safety and environmental notices

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

United Kingdom telecommunications safety requirement
Notice to customers
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This apparatus is approved under approval number NS/G/1234/J/100003 for indirect connection to public
communications systems in the United Kingdom.

Parent topic: Safety and environmental notices

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Other safety information
IBM® System Storage™ Productivity Center has specific requirements for voltage, usage with visual-display
workplace devices, and usage of a telecommunication line cord.

The System Storage Productivity Center server is suitable for use on an information technology power-
distribution system whose maximum phase-to-phase voltage is 240 V under any distribution fault condition.

Restriction: This product is not suitable for use with visual-display workplace devices according to Clause 2 of
the German Ordinance for Work with Visual Display Units.
Attention: Use a telecommunication line cord that is size No. 26 American wire gauge (AWG) or larger, and is
listed by Underwriters Laboratories (UL) or certified by the Canadian Standards Association (CSA).
Attention: Use a telecommunication line cord that has a size of American wire gauge (AWG) 26 or larger, and is
listed by Underwriters Laboratories (UL) or certified by the Canadian Standards Association (CSA).
Parent topic: Safety and environmental notices

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Particulate Contamination
This topic identifies contamination information.

Attention: Airborne particulates (including metal flakes or particles) and reactive gases acting alone or in
combination with other environmental factors such as humidity or temperature might pose a risk to the server
that is described in this document. Risks that are posed by the presence of excessive particulate levels or
concentrations of harmful gases include damage that might cause the server to malfunction or cease
functioning altogether. This specification sets forth limits for particulates and gases that are intended to avoid
such damage. The limits must not be viewed or used as definitive limits, because numerous other factors,
such as temperature or moisture content of the air, can influence the impact of particulates or environmental
corrosives and gaseous contaminant transfer. In the absence of specific limits that are set forth in this
document, you must implement practices that maintain particulate and gas levels that are consistent with the
protection of human health and safety. If IBM determines that the levels of particulates or gases in your
environment have caused damage to the server, IBM may condition provision of repair or replacement of
servers or parts on implementation of appropriate remedial measures to mitigate such environmental
contamination. Implementation of such remedial measures is a customer responsibility.

Table 1. Limits for particulates and gases
Conta
minant Limits
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Conta
minant Limits

Particul
ate

The room air must be continuously filtered with 40% atmospheric dust spot efficiency
(MERV 9) according to ASHRAE Standard 52.21.
Air that enters a data center must be filtered to 99.97% efficiency or greater, using high-
efficiency particulate air (HEPA) filters that meet MIL-STD-282.
The deliquescent relative humidity of the particulate contamination must be more than
60%2.
The room must be free of conductive contamination such as zinc whiskers.

Gaseou
s

Copper: Class G1 as per ANSI/ISA 71.04-19853.
Silver: Corrosion rate of less than 300 Å in 30 days.

Notes:

1 ASHRAE 52.2-2008 - Method of Testing General Ventilation Air-Cleaning Devices for Removal
Efficiency by Particle Size. Atlanta: American Society of Heating, Refrigerating and Air-Conditioning
Engineers, Inc.
2 The deliquescent relative humidity of particulate contamination is the relative humidity at which the
dust absorbs enough water to become wet and promote ionic conduction.
3 ANSI/ISA-71.04-1985. Environmental conditions for process measurement and control systems:
Airborne contaminants. Instrument Society of America, Research Triangle Park, North Carolina, U.S.A.

Parent topic: Safety and environmental notices

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Electronic emission notices
Federal Communications Commission (FCC) statement
Industry Canada Class A emission compliance statement
Australia and New Zealand Class A statement
European Union EMC Directive conformance statement
Germany Class A warning statement
Korea Class A Electronic Emission statement
Taiwan Class A warning statement
People's Republic of China Class A warning statement
Japan Voluntary Control Council for Interference (VCCI) statement

Parent topic: Notices

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)
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Federal Communications Commission (FCC) statement
Note: This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Operation of this equipment in
a residential area is likely to cause harmful interference, in which case the user will be required to correct the
interference at his own expense.

Properly shielded and grounded cables and connectors must be used in order to meet FCC emission limits.
IBM® is not responsible for any radio or television interference caused by using other than recommended
cables and connectors or by unauthorized changes or modifications to this equipment. Unauthorized changes
or modifications could void the user's authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1)
this device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

Parent topic: Electronic emission notices

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Industry Canada Class A emission compliance statement
This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

Parent topic: Electronic emission notices

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Australia and New Zealand Class A statement
Attention: This is a Class A product. In a domestic environment this product may cause radio interference in
which case the user may be required to take adequate measures.
Parent topic: Electronic emission notices

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)
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European Union EMC Directive conformance statement
This product is in conformity with the protection requirements of EU Council Directive 2004/108/EC on the
approximation of the laws of the Member States relating to electromagnetic compatibility. IBM® cannot
accept responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product, including the fitting of non-IBM option cards.

This product has been tested and found to comply with the limits for Class A Information Technology
Equipment according to European Standard EN 55022. The limits for Class A equipment were derived for
commercial and industrial environments to provide reasonable protection against interference with licensed
communication equipment.

Attention: This is a Class A product. In a domestic environment this product may cause radio interference in
which case the user may be required to take adequate measures.

Properly shielded and grounded cables and connectors must be used in order to reduce the potential for
causing interference to radio and TV communications and to other electrical or electronic equipment. Such
cables and connectors are available from IBM authorized dealers. IBM cannot accept responsibility for any
interference caused by using other than recommended cables and connectors.

European Community contact: 
IBM Technical Regulations 
Pascalstr. 100, Stuttgart, Germany 70569 
Tele: 0049 (0)711 7851176 
Fax: 0049 (0)711 785 1283 
e-mail: tjahn@de.ibm.com

Parent topic: Electronic emission notices

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Germany Class A warning statement
Dieses Produkt entspricht den Schutzanforderungen der EU-Richtlinie 2004/108/EG zur Angleichung der
Rechtsvorschriften über die elektromagnetische Verträglichkeit in den EU-Mitgliedsstaaten und hält die
Grenzwerte der EN 55022 Klasse A ein.

Um dieses sicherzustellen, sind die Geräte wie in den Handbüchern beschrieben zu installieren und zu
betreiben. Des Weiteren dürfen auch nur von der IBM® empfohlene Kabel angeschlossen werden. IBM
übernimmt keine Verantwortung für die Einhaltung der Schutzanforderungen, wenn das Produkt ohne
Zustimmung der IBM verändert bzw. wenn Erweiterungskomponenten von Fremdherstellern ohne
Empfehlung der IBM gesteckt/eingebaut werden.

EN 55022 Klasse A Geräte müssen mit folgendem Warnhinweis versehen werden: “Warnung: Dieses ist eine
Einrichtung der Klasse A. Diese Einrichtung kann im Wohnbereich Funk-Störungen verursachen; in diesem Fall
kann vom Betreiber verlangt werden, angemessene Maßnahmen zu ergreifen und dafür aufzukommen.“

Deutschland: Einhaltung des Gesetzes über die elektromagnetische
Verträglichkeit von Geräten
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Dieses Produkt entspricht dem “Gesetz über die elektromagnetische Verträglichkeit von Geräten (EMVG)“.
Dies ist die Umsetzung der EU-Richtlinie 2004/108/EG in der Bundesrepublik Deutschland.

Zulassungsbescheinigung laut dem Deutschen Gesetz über die
elektromagnetische Verträglichkeit von Geräten (EMVG) (bzw. der EMC EG
Richtlinie 2004/108/EG) für Geräte der Klasse A

Dieses Gerät ist berechtigt, in Übereinstimmung mit dem Deutschen EMVG das EG-Konformitätszeichen - CE -
zu führen. Verantwortlich für die Konformitätserklärung des EMVG ist die IBM Deutschland GmbH, 70548
Stuttgart. Generelle Informationen:

Das Gerät erfüllt die Schutzanforderungen nach EN 55024 und EN 55022 Klasse A.

Parent topic: Electronic emission notices

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Korea Class A Electronic Emission statement

Parent topic: Electronic emission notices

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Taiwan Class A warning statement

Parent topic: Electronic emission notices
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Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

People's Republic of China Class A warning statement

Parent topic: Electronic emission notices

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Japan Voluntary Control Council for Interference (VCCI)
statement

Parent topic: Electronic emission notices

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Accessibility features for IBM Tivoli Storage Productivity
Center

Accessibility features help users who have a disability, such as restricted mobility or limited vision, to use
information technology products successfully.

Accessibility features

The following list includes the major accessibility features in IBM® Tivoli® Storage Productivity Center:

IBM Tivoli Storage Productivity Center functions are available using the keyboard for navigation instead
of the mouse. You can use keys or key combinations to perform operations that can also be done using
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a mouse. However, you must use the mouse to navigate the Topology Viewer and report graphs.
Standard operating system keystrokes are used for standard operating system operations.
You can use screen readers to read the user interface.
The user interface communicates all information independently of color.
The IBM Tivoli Storage Productivity Center Information Center, and its related publications are
accessibility-enabled and include the following accessibility features:

The information center is provided in XHTML 1.0 format, which is viewable in most Web
browsers. XHTML allows you to view documentation according to the display preferences set in
your browser. It also allows you to use screen readers and other assistive technologies.
All documentation is available in PDF format.
All images are provided with alternative text, so that users with vision impairments can
understand the contents of the images.

Keyboard navigation

This product uses standard Microsoft Windows navigation keys.

Interface information

Use the options available in the Preferences > Look and Feel menu to select how to display the IBM Tivoli
Storage Productivity Center user interface. To do this, complete the following steps:

1. Start the IBM Tivoli Storage Productivity Center user interface.
2. Select one of the following options from the Preferences > Look and Feel menu to change the visual

appearance of the user interface to best suit your visual needs:
Windows Classic
Windows
CDE/Motif
Metal

Related accessibility information

You can view the publications for IBM Tivoli Storage Productivity Center in Adobe Portable Document Format
(PDF) using the Adobe Acrobat Reader. You can access the PDFs from the Printable PDFs topic in the
information center at http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp.

IBM and accessibility

See the IBM Human Ability and Accessibility Center website for more information about the commitment that
IBM has to accessibility.

Parent topic: Reference

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
This information center is powered by Eclipse technology. (http://www.eclipse.org)

Glossary
This glossary includes terms and definitions for the IBM® System Storage™ Productivity Center.
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The following cross-references are used in this glossary:

See refers the reader from a term to a preferred synonym, or from an acronym or abbreviation to the
defined full form.
See also refers the reader to a related or contrasting term.

To view glossaries for other IBM products, go to http://www.ibm.com/software/globalization/terminology/.

1U
A unit of measurement that equals 1.75 inches in height and is one unit of space between shelves on a
rack.

agent
An entity that represents one or more managed objects by sending notifications regarding the objects
and by handling requests from servers for management operations to modify or query the objects.

authentication
The security service that provides proof that a user of a computer system is genuinely who that person
claims to be. Common mechanisms for implementing this service are passwords and digital signatures.
Authentication is distinct from authorization; authentication is not concerned with granting or denying
access to system resources. See also authorization.

authorization
The process of granting a user, system, or process either complete or restricted access to an object,
resource, or function.

CIM
See Common Information Model.

CIM agent
The code that consists of common building blocks that can be used instead of proprietary software or
device-specific programming interfaces to manage devices that are compliant with the Common
Information Model (CIM).

CIMOM
See CIM object manager.

CIM object manager (CIMOM)
The common conceptual framework for data management that receives, validates, and authenticates
the CIM requests from the client application. It then directs the requests to the appropriate component
or service provider.

cluster
Up to four pairs of IBM System Storage SAN Volume Controller nodes that provide a single
configuration and service interface.
A partition capable of performing all DS8000® series functions.

Common Information Model (CIM)
An implementation-neutral, object-oriented schema for describing network management information.
The Distributed Management Task Force (DMTF) develops and maintains CIM specifications.

Configuration Utility
A utility in the Tivoli® Storage Productivity Center that enables a user to configure and administer the
IBM System Storage DS8000 and other storage subsystems by adding and managing element
managers.

console
A user interface to a server, for example, the interface provided on a personal computer.

data collection
The process of obtaining performance and availability monitoring data and providing that data to a
metric evaluator. Examples of data collectors include DNS probes, Web page analyzers, or database
analyzers. See also discovery.

discovery
The process of finding resources within an enterprise, including finding the new location of monitored
resources that were moved. Discovery includes the detection of changes in network topology, such as
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new and deleted nodes, or new and deleted interfaces.
domain name

In Internet communications, a name of a host system. A domain name consists of a sequence of
subnames that are separated by a delimiter character, for example, www.ibm.com. See also Domain
Name System.

domain name server
In Internet communications, a server program that supplies name-to-address conversion by mapping
domain names to IP addresses.

Domain Name System (DNS)
The distributed database system used to map domain names to IP addresses. See also domain name.

DNS
See Domain Name System.

EIA unit
A unit of measure, established by the Electronic Industries Association, equal to 4.45 millimeters
(0.175 inches).

EIA
See Electrical Industries Association.

Electronic Industries Association
An organization of electronics manufacturers that advances the technological growth of the industry,
represents the views of its members, and develops industry standards.

element
A component of a storage infrastructure. For example, an element can be a storage system, a switch, or
a virtualization appliance.

element manager
An application that is used for remotely configuring and managing a specific component of a storage
infrastructure. See also element.

enclosure
A free-standing structure or frame that can hold multiple servers and expansion units.

Enterprise Systems Connection (ESCON)
A set of IBM products and services that provides a dynamically connected environment using optical
cables as a transmission medium.

ESCON
See Enterprise Systems Connection.

Ethernet
A packet-based networking technology for local area networks (LANs) that supports multiple access
and handles contention by using Carrier Sense Multiple Access with Collision Detection (CSMA/CD) as
the access method. Ethernet is standardized in the IEEE 802.3 specification.

event
An occurrence of significance to a task or system. Events can include completion or failure of an
operation, a user action, or the change in state of a process.

fabric
A complex network of hubs, switches, adapter endpoints, and connecting cables that support a
communication protocol between devices. For example, fibre channel uses a fabric to connect devices.

fibre channel
A technology for transmitting data between computer devices. It is especially suited for attaching
computer servers to shared storage devices and for interconnecting storage controllers and drives.

FICON
See fibre channel connection.

fibre channel connection
A fibre-channel communication protocol designed for IBM mainframe computers and peripherals.

FlashCopy®
An optional feature of the Storage System DS family that can make an instant copy of data, that is, a
point-in-time copy of a volume.
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fuzzy copy
A backup version or archived copy of a file that might not accurately reflect the original contents of the
file, because it was backed up or archived when the file was being modified.

Global Copy
An optional capability of the DS8000 remote mirror and copy feature that maintains a fuzzy copy of a
logical volume on the same DS8000 storage unit or on another DS8000 storage unit. In other words, all
modifications that any attached host performs on the primary logical volume are also performed on the
secondary logical volume at a later point in time. The original order of update is not strictly maintained.
See also remote mirror and copy and Metro Mirror.

Global Mirror
An optional capability of the remote mirror and copy feature that provides a two-site extended-
distance remote copy. Data that is written by the host to the storage unit at the local site is
automatically maintained at the remote site. See also Metro Mirror, remote mirror and copy, and Global
Copy.

GUI
See graphical user interface.

Globally Unique Identifier (GUID)
An algorithmically determined number that uniquely identifies an entity within a system.

graphical user interface (GUI)
A type of computer interface that presents a visual metaphor of a real-world scene, often of a desktop,
by combining high-resolution graphics, pointing devices, menu bars and other menus, overlapping
windows, icons and object-action relationship.

GUI
Graphical user interface.

GUID
See Globally Unique Identifier.

Hardware Management Console (HMC)
A system that controls managed systems, including the management of logical partitions. Using service
applications, the HMC communicates with managed systems to detect, consolidate, and send
information to IBM for analysis.

HMC
See Hardware Management Console.

host
A computer that is connected to a network and that provides an access point to that network. The host
can be a client, a server, or both a client and server simultaneously.

host name
In Internet communication, the name given to a computer. The host name might be a fully qualified
domain name such as mycomputer.city.company.com, or it might be a specific subname such as
mycomputer. See also host system.

host system
A computer, either mainframe (S/390 or zSeries) or open-system, that is connected to the ESS. S/390
or zSeries hosts are connected to the ESS through ESCON or FICON interfaces. Open-systems hosts are
connected to the ESS by the Small Computer System Interface (SCSI) or the fibre-channel interface.

hub
A fibre channel device that connects nodes into a logical loop by using a physical star topology.

in-band
Pertaining to signals that are carried within the telephony voice channel.

Internet Protocol (IP)
A protocol that routes data through a network or interconnected networks. This protocol acts as an
intermediary between the higher protocol layers and the physical network. See also Transmission
Control Protocol/Internet Protocol.

IP
See Internet Protocol.
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IP address
A unique address for a device or logical unit on a network that uses the Internet Protocol standard.

launch descriptor file
An XML file that describes the menus and the detailed uniform resource locators (URLs) for
applications. A launch descriptor file is required to enable the launch in context feature for the device.

launch in context
A feature that enables a user to access external applications from the Tivoli Storage Productivity Center
GUI.

LDAP
See Lightweight Directory Access Protocol.

Lightweight Directory Access Protocol (LDAP)
An open protocol that uses TCP/IP to provide access to directories that support an X.500 model and
that does not incur the resource requirements of the more complex X.500 Directory Access Protocol
(DAP). For example, LDAP can be used to locate people, organizations, and other resources in an
Internet or intranet directory.

Lightweight Third Party Authentication (LTPA)
An authentication framework that allows single sign-on across a set of Web servers that fall within an
Internet domain.

LTPA
See Lightweight Third Party Authentication.

managed host
A host that is managed by Tivoli Storage Productivity Center and one or more active in-band fabric
agents.

Management Information Base (MIB)
In the Simple Network Management Protocol (SNMP), a database of objects that can be queried or set
by a network management system.

Metro Mirror
A function of the remote mirror and copy feature that constantly updates a secondary copy of a volume
to match changes made to a source volume. See also remote mirror and copy and Global Copy.

Metro Global Mirror
A three-site, high availability, disaster recovery solution. Metro Global Mirror uses synchronous
replication to mirror data between a local site and an intermediate site, and asynchronous replication
to mirror data from an intermediate site to a remote site.

MIB
See Management Information Base.

navigation tree
A hierarchical structure that is used to access information.

password tool
A software application that manages the Administrator password and the host authentication password
so that they can be changed as one.
A software application that manages the DB2 user password, DB2 service password, and WebSphere
user password so that they can changed as one.

pool
A named set of storage volumes that is the destination for storing client data.

rack
See enclosure.

RAID
See Redundant Array of Independent Disks.

Redundant Array of Independent Disks (RAID)
A collection of two or more disk physical drives that present to the host an image of one or more logical
disk drives. In the event of a single physical device failure, the data can be read or regenerated from the
other disk drives in the array due to data redundancy.

remote console
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A display device that qualifies as a system console but is not directly attached to a system.
remote mirror and copy

A feature of a storage server that constantly updates a secondary copy of a logical volume to match
changes made to a primary logical volume. The primary and secondary volumes can be on the same
storage server or on separate storage servers. See also Global Mirror, Metro Mirror, and Global Copy.

SAN
See storage area network.

SCSI
See Small Computer System Interface.

Simple Network Management Protocol (SNMP)
A set of protocols for monitoring systems and devices in complex networks. Information about
managed devices is defined and stored in a Management Information Base (MIB).

single sign-on
An authentication process in which a user can access more than one system or application by entering
a single user ID and password.

Small Computer System Interface (SCSI)
A standard used by computer manufacturers for attaching peripheral devices (such as tape drives, hard
disks, CD-ROM drives, printers, and scanners) to computers (servers).

SMI-S
See Storage Management Initiative Specification.

SNMP
See Simple Network Management Protocol.

storage area network (SAN)
A dedicated storage network tailored to a specific environment, combining servers, storage products,
networking products, software, and services.

Storage Management Initiative Specification (SMI-S)
A design specification developed by the Storage Networking Industry Association (SNIA) that specifies
a secure and reliable interface with which storage management systems (SMSs) can identify, classify,
monitor, and control physical and logical resources in a storage area network (SAN). The interface
integrates the various devices to be managed in a storage area network (SAN) and the tools used to
manage them.

Storage Networking Industry Association (SNIA)
An alliance of computer vendors and universities that focus on developing and promoting industry
standards for storage networks.

storage pool
An aggregation of storage resources on a SAN that have been set aside for a particular purpose.

subsystem
A secondary or subordinate system, usually capable of operating independently of, or asynchronously
with, a controlling system.

switch
A network infrastructure component to which multiple nodes attach. Unlike hubs, switches typically
have internal bandwidth that is a multiple of link bandwidth, and the ability to rapidly switch node
connections from one to another. A typical switch can accommodate several simultaneous full link
bandwidth transmissions between different pairs of nodes. Contrast with hub.

system
A functional unit, consisting of one or more computers and associated software, that uses common
storage for all or part of a program and also for all or part of the data necessary for the execution of the
program. A computer system can be a stand-alone unit, or it can consist of multiple connected units.

token
The basic syntactic unit of a computing language. A token consists of one or more characters, excluding
the blank character and excluding characters within a string constant or delimited identifier.

topology
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The physical or logical mapping of the location of networking components or nodes within a network.
Common network topologies include bus, ring, star, and tree.

virtualization
In the storage industry, a concept in which a pool of storage is created that contains several disk
subsystems. The subsystems can be from various vendors. The pool can be split into virtual disks that
are visible to the host systems that use them.

volume
A discrete unit of storage on disk, tape or other data recording medium that supports some form of
identifier and parameter list, such as a volume label or input/output control. See also storage pool.

zone
A segment of a SAN fabric composed of selected storage device nodes and server nodes. Only the
members of a zone have access to one another.
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Publications
This section lists publications in the IBM® Tivoli® Storage Productivity Center library and other related
publications. It also describes how to access publications online, how to order publications, and how to
submit comments on publications.

The publications are available from the IBM publications center at
http://www.ibm.com/shop/publications/order.

IBM System Storage Productivity Center publications
Use these publications for information about how to install, configure, and use IBM System Storage™
Productivity Center.
Tivoli Storage Productivity Center publications
Use these publications for information about how to install, configure, and use IBM Tivoli Storage
Productivity Center.
Tivoli Storage Productivity Center for Replication publications
Use these publications for information about how to install, configure, and use IBM Tivoli Storage
Productivity Center for Replication.
System Storage DS3000 publications
Use these publications for information about how to install, configure, and use the IBM System Storage
DS3000.
System Storage DS4000 and DS5000 publications
Use these publications for information about how to install, configure, and use the IBM System Storage
DS4000® and IBM DS5000.
System Storage DS8000 publications
Use these publications for information about how to install, configure, and use the IBM System Storage
DS8000® system.
IBM System Storage DS Open Application Programming Interface publications
Use these publications for information about how to install, configure, and use the DS CIM agent.
System Storage SAN Volume Controller publications
Use these publications for information about how to install, configure, and use IBM System Storage
SAN Volume Controller.
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XIV Storage System publications
Use the publications for information about how to install, configure, and use IBM XIV System Storage.
These publications are available in the Information Center at
http://publib.boulder.ibm.com/infocenter/ibmxiv/r2/index.jsp.
DB2 Database for Linux, UNIX, and Windows publications
Use these publications for information about how to install, configure, and use IBM DB2®.
IBM Redbooks
The IBM Redbooks® are books on specialized topics.
Translated publications
Translated publications are available from the information center which is available in certain
translated languages. It is displayed in the language that is appropriate for the browser locale setting.

Support | Terms of use | Feedback
(C) Copyright IBM Corporation 2002, 2009. All Rights Reserved.
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IBM System Storage Productivity Center publications
Use these publications for information about how to install, configure, and use IBM® System Storage™
Productivity Center.

These publications are available in the Information Center at
http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp.

Click System Storage Productivity Center.

For PDF documents, click System Storage Productivity Center > Printable documentation.

Publication title Order number

IBM System Storage Productivity Center Introduction and Planning Guide SC23-8824

IBM System Storage Productivity Center Documentation CD SCD7-1477

Read This First: Installing the IBM System Storage Productivity Center GI11-8938

IBM System Storage Productivity Center User's Guide SC27-2336

Parent topic: Publications
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Tivoli Storage Productivity Center publications
Use these publications for information about how to install, configure, and use IBM® Tivoli® Storage
Productivity Center.

The Tivoli Storage Productivity Center publications are available from the IBM Tivoli Storage Productivity
Center Information Center at http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp. In the left
navigation pane, click Tivoli Storage Productivity Center.
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For PDF documents, in the left navigation pane, click IBM Tivoli Storage Productivity Center > Printable
documentation.

Publication title Order number

IBM Tivoli Storage Productivity Center and IBM Tivoli Storage Productivity Center
for Replication Installation and Configuration Guide

SC27-2337

IBM Tivoli Storage Productivity Center User's Guide SC27-2338

IBM Tivoli Storage Productivity Center Messages SC27-2340

IBM Tivoli Storage Productivity Center Command-Line Interface Reference SC27-2339

IBM Tivoli Storage Productivity Center Problem Determination Guide GC27-2342

IBM Tivoli Storage Productivity Center Workflow User's Guide SC27-2341

Parent topic: Publications
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Tivoli Storage Productivity Center for Replication publications
Use these publications for information about how to install, configure, and use IBM® Tivoli® Storage
Productivity Center for Replication.

The following table lists the IBM Tivoli Storage Productivity Center for Replication publications. These
publications are available in the Information Center at
http://publib.boulder.ibm.com/infocenter/tivihelp/v4r1/index.jsp.

In the left navigation pane, click Tivoli Storage Productivity Center for Replication > Reference >
Publications.

Information for installing, upgrading, and uninstalling Tivoli Storage Productivity Center for Replication is
documented in the IBM Tivoli Storage Productivity Center and IBM Tivoli Storage Productivity Center for
Replication Installation and Configuration Guide.

Publication title Order number

IBM Tivoli Storage Productivity Center for Replication for System z v4.1 Installation
and Configuration Guide

SC27-2321-00

IBM Tivoli Storage Productivity Center for Replication V4.1 Command-Line Interface
User's Guide

SC27-2323-00

IBM Tivoli Storage Productivity Center for Replication V4.1 Problem Determination
Guide

GC27-2320-00

IBM Tivoli Storage Productivity Center for Replication V4.1 User's Guide SC27-2322-00

Parent topic: Publications
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This information center is powered by Eclipse technology. (http://www.eclipse.org)

System Storage DS3000 publications
Use these publications for information about how to install, configure, and use the IBM System Storage
DS3000.

To see the DS3000 publications, follow these steps:

1. Go to http://www.ibm.com/servers/storage/support/.
2. In the Product Family field, select Disk systems.
3. In the Product field, select DS3200, DS3300, or DS3400.
4. Click Go.
5. In the Support & downloads pane, click Documentation.
6. Under Documentation, click on a document title.

Publication title Part or order number

IBM System Storage DS3000 Storage Manager Version 10 Installation and Support
Guide for Windows, Linux, NetWare, and VMware, Tenth Edition

46M1395

IBM System Storage DS3000 Storage Manager Version 10 Installation and Support
Guide for AIX, Linux on POWER, and Sun Solaris, Fifth Edition

46M1396

IBM System Storage DS3200 Storage Subsystem Installation, Maintenance, and
User's Guide, Sixth Edition

46M1392

IBM System Storage DS3300 Storage Subsystem Installation, Maintenance, and
User's Guide, Fourth Edition

46M1393

IBM System Storage DS3400 Storage Subsystem Installation, Maintenance, and
User's Guide, Fifth Edition

46M1394

Parent topic: Publications
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System Storage DS4000 and DS5000 publications
Use these publications for information about how to install, configure, and use the IBM System Storage
DS4000® and IBM DS5000.

To see the IBM DS4000 or IBM DS5000 publications, follow these steps:

1. Go to http://www.ibm.com/systems/support/storage/disk.
2. In the Product Family field, click Disk systems.
3. In the Product field, click the appropriate storage system.
4. Click Go.
5. Click Documentation.
6. Click a document.

Publication title Order number
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Publication title Order number

IBM® System Storage™ DS4000 Concepts Guide GC26-7734

IBM System Storage DS4000/DS5000 Fibre Channel and Serial ATA Intermix
Premium Feature Installation Overview

GC53-1137

IBM System Storage DS® Storage Manager Version 10 IBM System Storage DS
Storage Manager Installation and Host Support Guide

GC53-1135

IBM System Storage DS Storage Manager Version 10.50 Copy Services User's Guide GC53-1136

IBM System Storage DS4800 Storage Subsystem Quick Start Guide GC27-2148

DS5100, DS5300 and EXP5000 Quick Start Guide GC53-1134

IBM System Storage DS4800 Storage Subsystem Installation, User's, and
Maintenance Guide

GC26-7845

IBM System Storage DS5100 and DS5300 Storage Subsystems Installation, User's,
and Maintenance Guide

GC53-1140

IBM System Storage DS4000/DS5000 Hard Drive and Storage Expansion Enclosure
Installation and Migration Guide

GC53-1139

IBM System Storage DS5000 EXP5000 Storage Expansion Enclosure Installation,
User's, and Maintenance Guide

GC53-1141

IBM System Storage DS3000, DS4000, and DS5000 Command Line Interface and
Script Commands Programming Guide

GC52-1275

IBM System Storage DS4000/DS5000EXP810 Storage Expansion Enclosure
Installation, User's and Maintenance Guide

GC26-7798
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System Storage DS8000 publications
Use these publications for information about how to install, configure, and use the IBM® System Storage™
DS8000® system.

These publications are available from the DS8000 Information Center at
http://publib.boulder.ibm.com/infocenter/dsichelp/ds8000ic/index.jsp.

Publication title Order number

IBM System Storage DS8000: Host Systems Attachment Guide SC26-7917

IBM System Storage DS8000: Introduction and Planning Guide GC35-0515

IBM System Storage DS Command-Line Interface User's Guide for the DS6000™
series and DS8000 series

GC53-1127

IBM System Storage DS8000: Architecture and Implementation SG24-6786

Parent topic: Publications
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IBM System Storage DS Open Application Programming
Interface publications

Use these publications for information about how to install, configure, and use the DS CIM agent.

Publications for the IBM® System Storage DS® Open Application Programming Interface are available at
http://www.ibm.com/servers/storage/support/software/cimdsoapi/. Under Support & downloads, click Install
> Documentation. Select the document that applies to the version of the CIM agent.
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System Storage SAN Volume Controller publications
Use these publications for information about how to install, configure, and use IBM® System Storage™ SAN
Volume Controller.

The following table lists the SAN Volume Controller publications. These publications are available in the SAN
Volume Controller Information Center at http://publib.boulder.ibm.com/infocenter/svcic/v3r1m0/index.jsp.

Publication Title Order Number

IBM System Storage SAN Volume Controller CIM Agent Developer's Guide SC26-7904

IBM System Storage SAN Volume Controller Command-Line Interface User's Guide SC26-7903

IBM System Storage SAN Volume Controller Software Installation and Configuration
Guide

SC23-6628

IBM System Storage SAN Volume Controller Host Attachment Guide SC26-7905

IBM System Storage SAN Volume Controller Planning Guide GA32-0551

IBM System Storage SAN Volume Controller Troubleshooting Guide GC27-2227

IBM System Storage SAN Volume Controller Hardware Maintenance Guide GC27-2226

IBM System Storage SAN Volume Controller Model 2145-8G4 Hardware Installation
Guide

GC27-2220

IBM System Storage SAN Volume Controller Model 2145-8A4 Hardware Installation
Guide

GC27-2219

IBM System Storage SAN Volume Controller Model 2145-4F2 Hardware Installation
Guide

GC27-2222
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Publication Title Order Number

IBM System Storage SAN Volume Controller Models 2145-8F2 and 8F4 Hardware
Installation Guide

GC27-2221

IBM System Storage SAN Volume Controller Model 2145-CF8 Hardware Installation
Guide

GC52-1356
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XIV Storage System publications
Use the publications for information about how to install, configure, and use IBM XIV System Storage. These
publications are available in the Information Center at
http://publib.boulder.ibm.com/infocenter/ibmxiv/r2/index.jsp.
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DB2 Database for Linux, UNIX, and Windows publications
Use these publications for information about how to install, configure, and use IBM DB2®.

The following table lists some of the DB2 Database for Linux®, UNIX®, and Microsoft Windows® product
publications for Version 9.5.

For a complete list of DB2 publications, go to
http://publib.boulder.ibm.com/infocenter/db2luw/v9r5/index.jsp.

Publication title Order number

IBM® DB2 Version 9.5 for Linux, UNIX, and Windows, Getting started with DB2
installation and administration on Linux and Windows

GC23–5857

IBM DB2 Version 9.5 for Linux, UNIX, and Windows, Command Reference SC23–5846

IBM DB2 Version 9.5 for Linux, UNIX, and Windows, Message Reference Volume 1 GI11–7855

IBM DB2 Version 9.5 for Linux, UNIX, and Windows, Message Reference Volume 2 GI11–7856

IBM DB2 Version 9.5 for Linux, UNIX, and Windows, Migration Guide GC23–5859

IBM DB2 Version 9.5 for Linux, UNIX, and Windows, Troubleshooting Guide GI11–7857

Parent topic: Publications
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IBM Redbooks
The IBM® Redbooks® are books on specialized topics.

You can order publications through your IBM representative or the IBM branch office serving your locality. You
can also search for and order books of interest to you by visiting the IBM Redbooks home page at
http://www.redbooks.ibm.com/redbooks.

For information about IBM Tivoli® Storage Productivity Center, see IBM Tivoli Storage Productivity Center V4.1
Release Guide. Search for SG24-7725.
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Translated publications
Translated publications are available from the information center which is available in certain translated
languages. It is displayed in the language that is appropriate for the browser locale setting.

When a locale does not have a translated version, the Information Center is displayed in English, which is the
default language. Translations of the PDFs are available when the Information Center is translated.

Contact your service representative for more information about the translated publications and whether
translations are available in your language.
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